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A. EQUIPMENT

A.l Survey Vessels

The survey was conducted employing two vessels. Much of the relatively deep reaches of
the study area were surveyed using the R/V Ocean Explorer (Figure 1). A smaller vessel, the
R/V Osprey (Figure 2), surveyed relatively shallow reaches of the study area as well as
certain “deep” water areas. For the sake of clarity, especially as concerns the field data file
naming convention, two distinct abbreviations were employed. Specifically, files generated
on the R/V Ocean Explorer include “OE” in the name and files generated on the R/V Osprey
include “SB” which is meant to indicate “small boat” files.

A.l.1 R/V Ocean Explorer —““OE™

R/V Ocean Explorer, O.N. 905425, is an 18-meter aluminum vessel, with a 5.1-meter beam
and nominally 2-meter draft. R/V Ocean Explorer is powered by two 1,000 HP Iveco diesel
engines.

Figure 1. R/V Ocean Explorer configured for hydrographic survey operations.

The R/V Ocean Explorer was modified to support hydrographic survey operations by Ocean
Surveys, Inc., hereinafter referred to as OSI. The following summarizes the major
adaptations and/or custom survey support hardware installed on the R/V Ocean Explorer:

1. Survey system control modules (processors) and computer systems were installed at
purpose-built work stations in the main cabin of the vessel.
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2. A measured and indexed Inertial Measurement Unit (IMU) mounting plate was
installed on the vessel’s fore-aft (roll) centerline at the approximate pitch center of
rotation. The POS MV IMU was installed on this plate which resides approximately
0.5 meters below the plane of the vessel waterline.

3. A retractable multibeam transducer pole, constructed of thick-wall aluminum pipe,
was attached to the starboard side of the vessel at the approximate pitch centerline.
The pole was attached at two points: a substantial, positive locking swivel near the
deck of the vessel and a “receiver plate” at the chine of the vessel. The transducer
pole is forced, by means of a block and tackle system using non-stretch rope and a
hand-crank winch, into the V-notch receiver plate, thereby eliminating pole
movement. The transducer pole was fitted with fairings on the trailing edge to
minimize cavitation. The bottom of the transducer pole was fitted with a termination
flange configured with a small copper orifice. This configuration allowed the
transducer pole to be used as a stilling well.

4. To support “fixed mount” side scan sonar (SSS) operations a substantial, custom
fabricated, SSS mounting bracket was affixed to the forward side of the multibeam
transducer pole (described above). The fixed mount SSS bracket was installed
approximately 0.4 meters above the multibeam transducer which was at the bottom of
the transducer pole. Due to relatively shallow water depths no towed SSS imagery
was acquired.

5. A moving vessel profiler (MVP) was installed on the port quarter of the vessel.

A full survey of the R/V Ocean Explorer was conducted on May 6, 2015 by OSI during
which reference points (permanent shipboard benchmarks) were established onboard the
vessel to define a fixed reference frame, vessel reference point (RP), draft measurement
locations and sensor mounting locations. These points were “surveyed” using a precision
total station optical theodolite and electronic distance meter while the vessel was hauled out
and blocked on land. Offsets measured during the 2015 total station survey were confirmed
during the 2017 vessel mobilization employing a steel tape measure.

The multibeam transducer pole is capable of variable draft settings. During the 2017 vessel
mobilization the initial transducer phase center-to-RP value was established relative to
shipboard benchmarks employing a steel tape measure. The relative distance between
transducer phase center and vessel RP did not change during the survey. Survey offsets and
estimated measurement accuracies were incorporated into the CARIS vessel configuration
file.

Major data acquisition system components that were employed on the R/V Ocean Explorer
during the project are summarized in Table 1 below. A brief description of the equipment
also follows.
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A.l1.2

R/V Osprey —*“SB”

R/V Osprey, CT Registration CT7934BC, is a 7.9-meter fiberglass vessel, with a 2.6-meter
beam and nominally 0.6-meter draft. R/V Osprey is powered by two 150 HP Yamaha
outboard engines.

Figure 2. R/V Osprey configured for hydrographic survey operations.

The R/V Osprey was also modified to support hydrographic survey operations by OSI. The
following summarizes the major adaptations and/or custom survey support hardware installed

on the R/V Osprey:

1. Survey system control modules (processors) and computer systems were installed at
purpose-built work stations in the main cabin of the vessel.

2. A measured and indexed Inertial Measurement Unit (IMU) mounting plate was
installed on the vessel’s fore-aft (roll) centerline at the approximate pitch center of
rotation. The POS MV IMU was installed on this plate which resides approximately
0.03 meters above the plane of the vessel waterline.

3. A retractable multibeam transducer pole, constructed of thick-wall stainless steel

pipe, was attached to the starboard side of the vessel at the approximate pitch
centerline. The pole was attached at two points: a substantial, positive locking swivel
on the gunwale of the vessel and a “stiff arm” protruding from aluminum H-beam
integrated into the roof of the vessel. When deployed, the top of the transducer pole
is bolted to a point on the stiff arm attachment point and clamped tight at the gunwale
swivel point thereby eliminating pole movement. This configuration allows for
repeatable deployment of the transducer during data acquisition and ease of retrieval
for transit.
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4. To support “fixed mount” side scan sonar (SSS) operations a substantial, custom
fabricated, SSS mounting bracket was affixed to the starboard quarter of the vessel.
Due to relatively shallow water depths no towed SSS imagery was acquired.

A full survey of the R/V Osprey was conducted on July 27, 2017 by OSI during which
reference points (permanent shipboard benchmarks) were established onboard the vessel to
define a fixed reference frame, vessel reference point (RP), a draft measurement location, and
sensor mounting locations. These points were “surveyed” using a precision total station
optical theodolite and electronic distance meter while the vessel was hauled out and blocked
on its transport trailer. Offsets measured during the 2017 total station survey were later
confirmed employing a steel tape measure.

The multibeam transducer pole is capable of variable draft settings. During the 2017 vessel
mobilization the initial transducer phase center-to-RP value was established relative to
shipboard benchmarks employing a steel tape measure. The relative distance between
transducer phase center and vessel RP did not change during the survey. Survey offsets and
estimated measurement accuracies were incorporated into the CARIS vessel configuration
file.

Major data acquisition system components that were employed on the R/V Osprey during the
project are summarized in Table 2 below. A brief description of the equipment also follows.
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Table 1
R/V Ocean Explorer “OE” Acquisition Equipment
Model/ Firmware/Software Serial
System Data Manufacturer Version No. Ver. Number (s)
Side Scan
Sonar Towfish | Imagery/Contacts EdgeTech 4125 N/A 46118
(fixed-mount)
Side Scan 4125D
Sonar Imagery/Contacts EdgeTech 4125P V. 36.0.1.120 46921
Processor
Multibeam
Echosounder Soundings Reson 7125 SV2 SV2 SP4 7K 6,0,0,6 | 18342213063
Processor
Multibeam .
Echosounder Soundings Reson 7125 SV2 N/A Proj. 4712049
Rec. 0213063
Transducer
. MicroX
Surfgczsc?und Sound Speed AML S%}‘Eg;ﬁa\ge N/A 10315
p & SV-X 201525
Moving Vessel | ¢ 4 gpeed ODIM MVP30 MVP Controller 2.43 10646
Profiler (MVP) ’
Micro SVPT SV-X-203108
SMZ:Ic)i %’cr):)lg?e Sound Speed AML SV-Xchange & N/A PT-7786
Spensors 2) p Oceanographic | Pressure/Temp SV-X-201527
Sensor PT-7777
. Base-X Base X-25016
P profiter | Sound Specd | Occanographic | Y Xehange 415 SV-X 201521
p grap P-Xchange P-X 303077
Navigation Position .
o o Applanix/ POS MV 320 HW 1.1-7 TPU 3352
Vessel Attitude Attitude, Trimble V.4 SW 05.03 IMU 497
& Heading Heading
Navigation Position Trimble MS750 1.58 220209271
(comparison)
U.S.C.G.
Differential . 0220096149
Beacon DGPS correctors Trimble ProBeacon 3 0220181937
Receivers (2)
Land Survey | RTK GPS Base | p; 1o 5700 V3.01 220332818
GPS Station
Water Level | g i Draft GEDruck | PDCR-830 N/A 363764
Gauge
Lead Line Bar Check OSI Lead Disk N/A 2010B
Steel Tape Static Draft BMI Ergoline 100 N/A N/A
Measure
. . . 20212221
Autopilot Vessel Steering Simrad AP50 VIR4 DAI711
_5-
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Table 2
R/V Osprey “SB” Acquisition Equipment
Model/ Firmware/Software Serial
System Data Manufacturer Version No. Ver. Number (s)
Side Scan
Sonar Towfish | Imagery/Contacts EdgeTech 4125 N/A 53387
(fixed-mount)
Side Scan 4125D
Sonar Imagery/Contacts EdgeTech 4125P V. 36.0.1.120 53276
Processor
Multibeam
Echosounder Soundings Reson 8125 8125-2.10-A50F 39337
Processor
Multibeam
Echosounder Soundings Reson 8125 8125-1.08-9E98 1008298
Transducer
Surface Sound | g i Speed Sea-Bird SBE-37 N/A 6372
Speed Electronics
. Base-X Base X-25028
Sogrrldﬁslpfed P rmary s(’f““d o AML | SV-Xchange 4.15 SV-X 203524
ote pee CeAnoLraphic | p_xchange P-X 304351
QC Comparison Base-X Base X-25016
Sogﬁgtigfed Sound Speed 0ceaﬁ2/[; hic | SV-Xchange 4.15 SV-X 201521
(shared with OE) grap P-Xchange P-X 303077
yoavgaon, | Rosiion Applanix/ | POS MV 320 HW 1.2-10 TPU 6415
. 7 Trimble V.5 SW 07.92 IMU 861
& Heading Heading
U.S.C.G.
Differential DGPS correctors .
Beacon for POS MV Leica MX 52R N/A 2531
Receiver
Navigation
with integrated Position .
DGPS (comparison) Trimble DSM 232 1.71 220246318
Receiver
Lead Line Bar Check OSI Lead Disk N/A OSI 50-2
Steel Tape Static Draft BMI Ergoline 100 N/A N/A
Measure
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A2 Echo Sounding Equipment
A2 Side Scan Sonar System

A.2.1.1  EdgeTech 4125

The fixed-mount or “pole mount” SSS system on each vessel was an EdgeTech 4125 dual-
frequency CHIRP system operating at a nominal frequency of 600 kHz. The second
frequency, 1,600 kHz, was not enabled during this survey. This sonar was operated at the 50
m range scale only. The system consists of a portable Topside Processing Unit (TPU) and
sonar towfish. The towfish was equipped with an optional telemetry package that allowed for
towfish-TPU communication via a coaxial cable connection. The towfish was equipped with
standard sensors for pitch, roll, heading, and depth (pressure). However, given that the
respective systems were fixed-mounted, none of these sensor data were used during data
processing. The TPU connected to the SSS acquisition computer through a dedicated
Ethernet cable. In the case of the R/V Ocean Explorer a 4125 SSS positioning verification
test was performed in the vicinity of the vessel’s home port on July 17, 2017 (DN 198). In
the case of the R/V Osprey a 4125 SSS positioning verification test was performed in the
vicinity of the survey area on August 24, 2017 (DN 236). The respective tests are
documented in the DAPR Appendix II: Echosounder Reports. On each vessel positioning
accuracy was verified during the course of the survey by observation of coincidental adjacent
and/or reciprocal data.
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Figure 3. Pole-mounted EdgeTech 4125 SSS transducer as configured on the R/V
Ocean Explorer for Project OPR-K354-KR-17. The AML Micro X surface sound
speed sensor is located within the multibeam bow fairing. Note that the SSS
transducer module (pointing down in this photo) is separated from the electronics
module which is secured parallel to the forward side of the transducer pole. A Reson
7125 transducer is mounted to the bottom of the pole in this photo.
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Figure 4. Pole-mounted EdgeTech 4125 SSS transducer as configured on the R/V
Osprey for Project OPR-K354-KR-17. In this photo the SSS is resting in its transit
cradle.

A22 Multibeam Echosounders

Two types of multibeam echosounders were employed on this project. The R/V Ocean
Explorer was equipped with a Reson SeaBat 7125 SV2 while the R/V Osprey was equipped
with a Reson SeaBat 8125. A description of each sonar follows.

A22.1 Reson SeaBat 7125 SV2

The SeaBat 7125 SV2 is a dual-frequency Multibeam Echosounder (MBES) System with
operational frequencies of 200 kHz or 400 kHz. For Project OPR-K354-KR-17, the
echosounder’s 400 kHz capability was employed. At this frequency and at the beam spacing
basis chosen for this project, the 7125 system is able to illuminate a swath of the seafloor that
is 140° across track by 1° along track with a maximum ping rate of 50 Hz. The system can be
configured with numerous beam density and swath angle combinations. The 512-equidistant
beam configuration was used for Project OPR-K354-KR-17. For this project the swath width
was maintained at either 130° or 140° based on site conditions and/or area-specific necessity.
The manufacturer’s stated depth resolution is 6 mm. This sonar system, as employed, is
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designed to comply with International Hydrographic Organization (IHO) standards to
measure seafloor depths to a maximum range of 175 meters. Digital data were output
through the Ethernet data port and displayed in real time on a high-resolution color monitor.

Figure 5. Pole-mounted Reson 7125 transducer as configured on the R/V Ocean Explorer for
Project OPR-K354-KR-17.

The transducer X, Y, Z position and angular offsets [relative to the vessel frame and a vessel
reference position (RP)], were referenced to values derived during the 2015 full static survey
with values confirmed prior to the 2017 survey.
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A.2.2.2 Reson SeaBat 8125

The SeaBat 8125 is a 455 kHz Multibeam Echosounder (MBES) that measures the relative
water depths across a swath oriented perpendicular to the vessel’s track. The ensonified
swath propagates out 120° in the across-track axis and 1° in the along-track axis. The system
forms 240 equiangular beams within this swath, each having an across-track angle of 0.5°.
The SeaBat 8125 has a maximum ping rate of 30 Hz (range dependent) with backscatter
(Snippets) enabled. Snippets was enabled during this survey. The manufacturers stated
depth resolution is 6 mm and the system is designed to comply with International
Hydrographic Organization (IHO) standards to measure seafloor depths to a maximum range
of 150 meters. Digital data were output through an Ethernet port and displayed real-time on
the system’s monitor.

Figure 6. Pole-mounted Reson 8125 transducer (with custom bow faring) as configured on
the R/V Osprey for Project OPR-K354-KR-17. Note the Sea-Bird SBE37 surface sound
speed sensor attached to the outboard side of the multibeam transducer. Also note the pole
mounted SSS deployment post and aft end of EdgeTech 4125 SSS fish on the right side of
this image.

The transducer X, Y, Z position and angular offsets [relative to the vessel frame and a vessel
reference position (RP)], were referenced to values derived during the R/V Osprey July 27,
2017 full static survey.
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A3 Manual Sounding Equipment
A3l Lead Line

The lead lines were constructed by OSI utilizing 9 kilogram, 0.3-meter round lead disks
attached to stainless steel cables with permanent index markers established at measured 1-
meter intervals.

The lead lines were calibrated prior to survey operations for each vessel using a steel tape
measure to verify index mark accuracy. The lead line calibrations were accomplished on
July 15, 2017 (DN 196) and July 20, 2017 (DN 201) for the R/V Ocean Explorer and R/V
Osprey respectively (see DAPR Appendix II for results).

A4 Positioning and Attitude Equipment
A4.1 Applanix POS MV

An Applanix POS MV 320 V.4 or POS MV 320 V.5 system was installed on the respective
survey vessels to provide position and attitude data. The POS MV (Position and Orientation
System for Marine Vessels) consists of a rack mountable POS Computer System (PCS), a
separate Inertial Measurement Unit (IMU) and two GPS receivers.

The POS MV combines the IMU and GPS sensor data into an integrated and blended
navigation solution. Per manufacturer’s literature there are two navigation algorithms
incorporated into the system, namely a tightly coupled and a loosely coupled inertial/GPS
integration. Tightly coupled inertial/GPS integration involves the processing of GPS pseudo
range, phase and doppler observables. In this case, the GPS receiver is strictly a sensor of the
GPS observables and the navigation functions in the GPS receiver are not used. With loosely
coupled inertial/GPS integration, the GPS position and velocity solution are processed to aid
the inertial navigator.

The POS MV generates attitude data in three axes (roll, pitch and heading). Roll and pitch
measurements are made within an accuracy of 0.02°. Heave measurements supplied by the
POS MV maintain an accuracy of 5-centimeters or 5% of the measured vertical displacement
for movements that have a period of up to 20 seconds.

The GPS Azimuth Measurement Subsystem (GAMS) allows the POS MV system to achieve
high-accuracy heading measurement. The GAMS subsystem uses two GPS receivers and
antennas to determine a GPS-enhanced heading that is accurate to 0.02° or better (using an
antenna baseline > 2 meters) when blended with the inertial navigation solution. The system
uses this heading information together with the position, velocity and raw observations
information supplied by the primary GPS receiver. GAMS heading was employed for all
survey data acquisition and GAMS status was monitored continuously during survey
operations using the MV-POSView controller software.
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For the R/V Ocean Explorer, IMU and antenna offsets, relative to the vessel frame and a
vessel RP, were measured during the 2015 full static survey (values confirmed prior to the
2017 survey). For the R/V Osprey, IMU these parameters were measured during the 2017
full static survey. For each vessel an Applanix-specified GAMS calibration procedure was
conducted during mobilization and prior to acquisition of any of the calibration data of
record. In the case of the R/V Ocean Explorer the GAMS calibration was conducted on July
17,2017 (DN 198). In the case of the R/V Osprey the GAMS calibration was conducted on
August 23, 2017 (DN235).

A4.2 DGPS

In the case of the R/V Ocean Explorer individual Trimble Pro Beacon DGPS beacon
receivers were manually tuned to one of the two local USCG differential beacon stations and
interfaced, as signal quality dictated, to the POS MV. Onboard the R/V Ocean Explorer, on
one occasion, the primary DGPS corrector source, English Turn, LA become unusable due to
station maintenance or nearshore weather (assumed). In this case the secondary DGPS signal
(Angleton, TX) was utilized for a short period.

In the case of the R/V Osprey the POS MV was supplied with DGPS correctors from the
English Turn, LA beacon via a Leica MX 52R. In no case during the survey was the English
Turn, LA signal unusable.

Refer to the Vertical and Horizontal Control Report for additional details of DGPS position
correctors.

A43 Other Positioning and Attitude Equipment
A.4.3.1  Secondary Positioning

On both vessels a secondary GPS was setup in parallel to the POS MV and was used to
trigger “position integrity alarms” within HYPACK. The secondary GPS system consists of
an integrated GPS and DGPS receiver and operated in DGPS mode. Each vessel’s secondary
DGPS system was manually configured to tune to the second closest USCG differential
beacon (Angleton, TX).

A5 Sound Speed Equipment

Onboard the R/V Ocean Explorer the surface sound speed sensor, the sound speed
comparison profiler, and the undulating sound speed profiler (ODIM MVP) were all fitted
with AML Oceanographic sensors which were manufacturer calibrated prior to survey data
acquisition. Onboard the R/V Osprey the surface sound speed sensor, a Sea-Bird Electronics
SBE-37 and the sound speed profiler, an AML Oceanographic instrument, were also
manufacturer calibrated prior to survey data acquisition. Copies of the calibration sheets are
included in DAPR Appendix IV. The two survey vessels shared a single AML Base-X sound
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speed profiler which was used periodically for sound speed profile comparisons. Sensors on
this “comparison” instrument were manufacturer calibrated prior to use on the project.

A5.1 Sound Speed Profiles
A.5.1.1  Sound Speed Profiler R/V Ocean Explorer: ODIM MVP30

The MVP30 was the primary sound speed profiler employed on the R/V Ocean Explorer
during this survey. The ODIM MVP30 Moving Vessel Profiler allows sound speed profiles
to be collected while the vessel is underway. The ODIM MVP consists of towfish-mounted
sensors (AML sound speed, temperature, and depth “micro SVPT”), an electro-mechanical
conductor cable, and an electric winch. The MVP may be deployed manually using the
winch controls or remotely using the ODIM MVP Controller Software. When operated in
“FreeWheel” mode while underway, the MVP falls near-vertically to a preset depth off the
bottom, collecting sound speed and temperature/depth measurements at a frequency of 10
Hz. During data acquisition on the R/V Ocean Explorer “MVP casts” were performed at
approximately 15-minute intervals.

Figure 7. ODIM MVP30 as mounted on the port quarter of the R/V Ocean Explorer.
A.5.1.2  Sound Speed Profiler R/V Osprey: AML Oceanographic Base-X

An AML Oceanographic Base-X sound speed profiler was the primary sound speed profiler
employed on the R/V Osprey during this survey. As mentioned above a second AML Base-X
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logging profiler, shared between both vessels, was employed to acquire comparison cast data
for sound speed confidence checks. Sound speed confidence checks were performed
periodically during the course of the survey. This instrument collects high-precision direct
sound speed and pressure measurements. Each of the instruments employed on this project
was configured to take measurements at a rate of 5 Hz. These data were stored internally and
downloaded via a serial connection using the field logging computer. Throughout the course
of data acquisition on the R/V Osprey “AML casts” were performed at an interval of
approximately 1-2 hours.

As mentioned above sound speed data from a secondary AML Base-X was used for
comparison casts. In practice the secondary AML Base-X was physically attached to either
the MVP freefall fish or the primary AML Base-X (vessel dependent) and the paired sensors
deployed to the deepest practical depth while both instruments logged data. Data from both
instruments were compared employing utilities within NOAA’s Velocwin program.

A52 Surface Sound Speed R/V Ocean Explorer: AML Micro-X

The AML Micro-X is a high-accuracy sound speed sensor capable of measuring and
transmitting sound speed data directly to the MBES via a manufacturer-supplied data cable.
The Micro-X, mounted within the bow faring of the MBES transducer, transmitted real-time
surface sound speed data to the Reson 7125 multibeam system and the HYPACK acquisition
computer via the Reson interface. The Micro-X, like the AML SVPT and Base-X sensors
discussed above, uses a sound speed “exchange” sensor.

A5.3 Surface Sound Speed R/V Osprey: Sea-Bird Electronics SBE-37

The SBE-37 is a conductivity/temperature sensor capable of calculating sound speed values
in real time and transmitting these data directly to the SeaBat 8125 TPU via a manufacturer-
supplied data cable. The SBE37 was mounted directly to the starboard side of the SeaBat
8125 transducer. The data output from the SBE37 were also sent directly into HYPACK
SURVEY, so the real-time surface parameters (temperature, salinity, and sound speed) could
be monitored and logged.

A.6 Horizontal and Vertical Control Equipment

A.6.1 Precise Positioning: Trimble 5700 GPS

Prior to and during the course of the survey the accuracy of the primary positioning system of
each vessel was verified by means of a physical measurement to temporary horizontal
control/navigation checkpoints located at each vessel’s base of operation. Each checkpoint
was established using a Trimble 5700 GPS system configured with a Trimble Zephyr
Geodetic antenna.
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A.6.2 Pressure Gauge: GE/Druck Water Level Gauge

Onboard the R/V Ocean Explorer data from a GE/Druck pressure sensor were used to
calculate vessel static draft values while the vessel was offshore. The water level system
consists of a vented pressure transducer connected to a top-side voltage converter. The
system transmits a serial “depth” string to the HYPACK logging computer. The pressure
transducer was installed well below the waterline at a fixed elevation within the multibeam
transducer pole. As mentioned earlier, the otherwise sealed base of the multibeam pole was
configured with a small copper orifice, in effect making the transducer pole a stilling well.
The physical offset between the sensor “depth” and vessel draft was established dockside
during a series of physical draft measurements versus sensor value observations (static
dockside calibration).

During offshore operations on the R/V Ocean Explorer, sensor data were logged once a day
(when practical) when the vessel was at full stop. The system was configured to record a
water level at a rate of 20 Hz. Water level readings were logged to a HYPACK .RAW file
for 5-10 minutes while the vessel was at a full stop. The average sensor value for the term of
the observation was used for each offshore static draft calculation. Sensor readings were
adjusted based on the derived fixed offset value established during the static dockside
calibration procedure. This approach allowed the field team to accurately track vessel static
draft despite offshore conditions.

Given that the R/V Osprey returned to a dock each night, static draft measurements were
accomplished before and after survey each day and no electronic means of draft
determination were employed.

A.6.3 Steel Tape Measure

A plastic coated steel tape measure was employed throughout the survey on both vessels for
various tasks requiring physical measurements. Offset confirmations and manual static draft
measurements aboard each vessel were accomplished employing a steel tape measure. Static
draft measurements were made relative to permanent shipboard benchmarks which were
related to the vessel RP during the full vessel survey.

A7 Additional Acquisition Equipment

A.7.1 Bottom Sampler

A sediment sampler was employed to obtain seafloor sediment samples within the survey
area. A hydraulic pot hauler aboard the R/V Ocean Explorer was used to recover the unit.

Onboard the R/V Osprey a smaller bottom sampler was employed. As such, the unit was
recovered by hand.
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A7.2 Auto Pilot

A Simrad AP50 Marine Autopilot was installed on the R/V Ocean Explorer and interfaced
with HYPACK to steer the vessel during concurrent MBES and SSS mainscheme data
acquisition. When activated, the Autopilot controlled the rudder adjustments to keep the
vessel on line.

While an autopilot was installed onboard the R/V Osprey it was not interfaced to HYPACK.
This vessel’s autopilot was used during transit and, conditions permitting, to aid in line
steering in “manual control” mode.

A.8 Computer Hardware and Software

A.8.1 Computer Hardware

Table 3
Computer Hardware

Vessel Use Manufacturer Model Operating System
R/V Ocean MBES/POSPac/SSS OSI Custom . .
Explorer Acquisition and Log-Keeping Build OSI Custom Windows 10 64-bit
RV Ocean MVP Acquisition Hewlett HP 530 Windows XP
Explorer Packard
RIV Ocean Onboard Data QA/QC OSICustom | g1 ytom | Windows 10 64-bit
Explorer Build
R/V Ocean | AML Base-X Comparison Cast Dell D830 Windows XP
Explorer Download
MBES/POSPac/SSS OSI Custom . .
R/V Osprey Acquisition and Log-Keeping Build OSI Custom Windows 10 64-bit
R/V Osprey Onboard Data QA/QC Shuttle XPC SH67H3 Windows 7 64-bit
AML Base-X Primary Sound
R/V Osprey | Speed Profiler and Comparison Dell D830 Windows XP
Cast Download

Onboard both vessels concurrent MBES, POSPac, and SSS acquisition was accomplished on
a single computer (per vessel) running HYPACK SURVEY/HYSWEEP SURVEY, Applanix
POSView, and EdgeTech Discover software simultaneously. On each vessel this same
computer was also used to keep an EXCEL-format acquisition log. Each vessel’s
“acquisition” computer was a Windows 10 64-bit computer having a MSI Military Class 4
Motherboard, a 3.2 GHz Intel Core i5 quad core processor (i7 on the R/V Ocean Explorer),
redundant 250 gigabyte (GB) solid-state program drives, redundant 2 terabyte (TB) internal
data hard drives, three gigabit network adapters, 16 GB of RAM, dedicated graphics,
multiple display monitors, 9 serial ports and multiple USB-3 ports.
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A second 15 processor version of the computer build described above was employed on the
R/V Ocean Explorer as a data review machine. Onboard the R/V Osprey the data review
machine was a Windows 7 64-bit computer having a 3.57 GHz Intel Core i5 processor, a 1
terabyte (TB) RAID 0 primary solid-state drive (SSD), a 2 TB internal hard drive backup,
three gigabit network adapters, and a single high-definition display monitor.

Each of the data review machines was also used as the onboard data backup hub. In practice
data were synced across the network after the completion of each trackline and soon after
synced to an external 2-GB or 4-GB removable USB-3 drive.

Data processing was completed at the home office using multiple Windows 10 64-bit
computers with the following typical hardware specifications: 3.40 GHz Intel Core 17-4930K
processor (6-core/12-thread), 120 GB primary SSD, 2 TB RAID 0 (high-performance) SSD
data drive, two 2 TB hard drives in RAID 1 (redundant) configuration, 16 GB of RAM, dual
graphics cards, and four high-definition displays. The multiple computers shared data over a
10 gigabit local area network.
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A.8.2 Computer Software

Computer software utilized during this survey is itemized in Table 4 below.

Table 4
Computer Software
Manufacturer Application Version Version Date
HYPACK HYPACK SURVEY 17.1.3.0 Jan. 26,2017
HYPACK HYSWEEP SURVEY 17.1.11.0 Jan. 25,2017
EdgeTech Discover 4125D 8.1 36.0.1.120 Oct. 25,2016
Teledyne CARIS HIPS/SIPS 10.2.3 May 23, 2017
Teledyne CARIS HIPS/SIPS 10.4.0 Oct. 26, 2017
Teledyne CARIS Notebook 3.1.1 SP1 2011
HYPACK MBMax64 17.1.9 June 9, 2017
Chesapeake Technology Sonar Wiz 5 5.1.0.40 Sept 4, 2013
NOAA NOAA Velocwin 8.92 May 8, 2008
AML Oceanographic SeaCast 425 April 12,2016
Microsoft Office (Word, Excel) 2016 | 16.0.6965.2058 | June 3, 2016
ODIM Brooke Ocean MVP Controller 2.430 Jan. 20, 2010
Applanix MYV POS View 7.92 April 9, 2014
Applanix POSPac MMS 7.1 June 8, 2016
Global Mapper Software LLC Global Mapper 13.2 June 20, 2012
AutoDesk Inc. AutoCAD 2004 Feb. 14, 2003
Trimble Pro Beacon (DOS) N/A Sept 12, 1994
Trimble DSM Utility 0.90 July 7, 2006
Trimble GPS Configurator 4.10 March 20, 2013
National Geodetic Survey OPUS 2.3 July 7, 2016
UNH-CCOM/NOAA HydrOffice QC Tools 2 2.1.2
NOAA HSTP XMLDR 18.1 (7665) Jan 18, 2018
A.8.2.1 HYPACK SURVEY

On both vessels survey vessel trackline control and position fixing were accomplished by
using the HYPACK SURVEY data-logging and navigation software package. Vessel
position data were output from the POS MV at 25 Hz frequency and transmitted to the
navigation computer system, which processed these data in real-time into the desired
mapping coordinate system (UTM Zone 15 North, NAD 83). Raw and processed position
data were continuously logged onto the computer hard drive, sent to the autopilot (on the R/V
Ocean Explorer “OE”), and displayed on a video monitor, enabling the vessel’s helmsman

-19 - Data Acquisition and Processing Report



OPR-K354-KR-17 OCEAN SURVEYS, INC.

(and autopilot on the OE) to guide the survey vessel accurately along pre-selected tracklines.
Tracklines and survey features were displayed on the helm monitor with geographic
reference data that included current NOS raster nautical charts (RNCs) and other pertinent
survey reference files.

Motion and predicted tide-corrected sounding data were displayed as HYPACK gridded
depth models and coverage matrices. HYPACK “targets” were also recorded to mark the
location and time of significant observations during data acquisition, such as MVP or Base-X
cast positions, bottom sample locations, and side scan targets of interest. Raw, geographic
position data (NADS83 degrees latitude and longitude) were time tagged with UTC time by
the POS MV and recorded by HYPACK SURVEY in .RAW format line files.

The HYPACK computer was also used for sensor monitoring and data quality review while
data were acquired. Ultilities in the acquisition module of HYPACK notify the operator with
a visual alert in the event of a sensor malfunction or, in some cases, when a sensor parameter
drifts out of operator-set limits (e.g. DGPS position comparison or surface sound speed
change).

Aboard each vessel HYPACK SURVEY was used to generate real-time SSS positioning
which was transmitted to and recorded by the respective instances of Discover SSS software.
In the case of pole-mounted 4125 SSS, HYPACK’s “Genoffset.dll” was used to calculate
SSS fish position. This process is described in more detail in Section C.1.4. Towfish
position was recorded in the HYPACK RAW data, and the real-time position was sent to the
individual instances of Discover to serve as primary positioning for each vessel’s SSS
system.

Each vessel’s acquisition computer’s HYPACK SURVEY program was configured to use
GPS UTC time to continuously sync the computer time. Acquisition PCs were synced using
the Group 7 message from the POS MV.

A.8.22 HYSWEEP SURVEY

On each vessel multibeam data were logged with HYPACK HYSWEEP software which was
run simultaneously with HYPACK SURVEY. Multibeam raw beam ranges, intensities, and

quality flags were time tagged with UTC time by the Reson 71P or 81P respectively and
recorded by HYSWEEP in HSX format line files.

Motion and attitude data (heave, pitch, roll, and heading) were time tagged with UTC time by
the POS MV and recorded by HY SWEEP in HSX format line files.

Multibeam backscatter data were recorded via HYSWEEP SURVEY in HYPACK .7K or
81X format respectively.

On each vessel HYSWEEP SURVEY was also configured to display and record a network-
streamed instance of the EdgeTech SSS signal. This SSS imagery waterfall, viewed in a
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HYSWEEP SURVEY window, was monitored along with the imagery waterfall viewed
using the primary SSS acquisition software, EdgeTech’s Discover. The HYSWEEP-
recorded SSS data were not intended to be a project deliverable. As such the HY SWEEP-
recorded SSS data were stripped from the .HSX files (using HYPACK’s HSX Utilities
module) prior to compilation of the project deliverables.

The HYSWEEP SSS functionality was meant to be a field tool. Use of this tool has at least
three benefits including the following: First, by means of the HYSWEEP/SSS interface,
upon “starting” a survey line in HYPACK a SSS file was simultaneously “started” in the
Discover software. The Discover-recorded file, logged in a separate directory on the
acquisition computer, was named by HYPACK with the identical name of the corresponding
HYPACK file; the only difference in file name being the extension. Specifically, the
Discover-recorded file is given a .JSF extension. This functionality was not only a
convenience but also helped to eliminate log entry file name transcribing errors and
happened to make file correlation easier during processing.

The second benefit, as mentioned above, is the ability to view a second instance of the SSS
waterfall. Often times the HYSWEEP SSS waterfall was setup differently than the Discover
waterfall, e.g. color palate and gain. This afforded the field teams an alternate view of a
given feature which is sometimes helpful in interpreting the character of the feature.

Finally, HYPACK’s standard “double click” targeting functionality also works in the
HYSWEEP SSS waterfall. As such, certain features viewed in the HYSWEEP SSS waterfall
were “targeted” and displayed on the HYPACK SURVEY map window for future
consideration or avoidance.

A.8.2.3  EdgeTech Discover 4125D

Discover is a side scan sonar control and acquisition software that interfaces directly with the
EdgeTech SSS systems via a dedicated Ethernet connection. As described above, for each
vessel, the software was installed and operated on the primary acquisition computer which
also ran HYPACK, Applanix POSView, and EXCEL. The majority of the EdgeTech settings
are controlled within this software; these include the specific sensor inputs/outputs, side scan
range settings, display gains, color palettes, real-time bottom tracking parameters, file
recording characteristics, pressure sensor zero depth calibration (if applicable), altitude
alarms, and navigation offsets.

On both vessels Discover received fish position information from the HYPACK SURVEY
program via a looped serial connection (HYPACK-out to Discover-in on the same
computer). HYPACK SURVEY calculated and transmitted fish position based upon the
fixed physical offsets of the EdgeTech 4125 SSS relative to the vessel RP. Given that
HYPACK was providing position information to Discover navigation offset settings within
Discover were set to zero.
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In addition to receiving position, Discover was configured to accept an ancillary time input.
A NMEA ZDA message was generated by the POS MV and delivered to Discover over a
serial connection. The software used this timing message to sync its time and the EdgeTech
4125 TPU time to UTC.

All SSS scrolling waterfall data displays (Discover and HYSWEEP) were configured to
display uncorrected side scan sonar imagery. These displays were arranged on a vertically
oriented high-definition IPS (In-plane switching) display.  Scrolling imagery was
continuously reviewed during collection for data quality, feature detection, and to identify
water column noise and/or interference (e.g. fish, boat wakes, refraction, etc.). System and
user alarms were monitored to ensure continuous system functionality.

Discover compiled system specific side scan sonar image data along with position records
and stored these data in EdgeTech .JSF format. Based on past project experience, OSI has
determined that JSF files produce superior imagery in CARIS. Therefore, XTF data were not
recorded for this project.

A.82.4  CARIS HIPS and SIPS

All multibeam echosounder data were converted from raw HYPACK format data files to
HDCS format and processed using CARIS Hydrographic Information Processing System
(HIPS) software.

All SSS data were converted from raw JSF format line files to HDCS format and processed
using CARIS SIPS software.

HIPS/SIPS was also utilized to process MBES and SSS calibration data, which included
MBES patch and performance tests, and SSS position confidence tests.

In practice, for both HIPS and SIPS, Version 10.2.3 was used during data conversion and
processing during the time of data acquisition. Soon after the period of data acquisition all
further conversion and processing was accomplished using Version 10.4.0.

CARIS HIPS/SIPS Version 10.4.0. was employed to create the final MBES coverage surface
and SSS mosaic data deliverables.

A process previously accomplished using CARIS Notebook was largely accomplished
employing the Feature Editing Module within CARIS HIPS/SIPS 10.2.3. or 10.4.0.
However, CARIS Notebook was used sporadically to this end. The Feature Editing Module
was used during home office processing to track and organize side scan sonar targets of
interest, i.e. significant targets and targets requiring further investigation. Danger to
Navigation (DtoN) submittals were compiled and exported in S-57.000 format using the
Feature Editing Module or CARIS Notebook. Field investigation assignments were tracked
and conveyed to the field team using, among other tools, HOB files created in the Feature
Editing Module or CARIS Notebook.
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A.82.5 CARIS Notebook

As mentioned above CARIS Notebook, a predecessor to CARIS’ Feature Editing Module
was used sporadically during home office processing for many of the functions described
above.

A82.6 HYPACK MBMax

MBMax was used for various shipboard and home office support functions such as patch test
data processing and performance test data processing as well as general day-to-day shipboard
and home office data QA/QC review. MBMax patch and performance test data processing
were accomplished as a QA/QC measure and to validate the CARIS-derived values.

A.8.2.7  Chesapeake Technologies, Inc. (CTI) SonarWiz 5

CTI’'s SonarWiz was used frequently aboard the survey vessel for various SSS QA/QC
functions such as image quality review and positioning accuracy confirmation.

A.82.8 NOAA Velocwin

Velocwin was used to convert the MVP sound speed cast data into CARIS SVP format.
Along with the AML Oceanographic data processing software, SeaCast, and Microsoft
Excel, the Velocwin software was also used for sound speed comparisons performed
periodically throughout the course of the survey.

A.8.2.9  AML Oceanographic SeaCast

Onboard the R/V Osprey sound speed cast data were acquired using an AML Oceanographic
Base-X system. And, as mentioned previously, both vessels shared an AML Base-X system
that was used for comparison QA/QC vs. each vessel’s primary sound speed profiler. The
software used to interface with the Base-X instrumentation is AML’s SeaCast software. This
software was used to configure the instruments for deployment and to download the raw cast
data. Since the data collected during each cast were continuous during deployment (i.e.
collected during equalization, and both the down and up cast data), the data had to be
processed to create a useable down-cast file. The processing of the raw cast data was
accomplished using an OSI-developed Excel workbook.

Routines contained within the customized Excel workbook read in a raw SeaCast exported
data file, isolate the down cast, plot the data, and generate, among other things, the
corresponding Velocwin-compatible .ZZQ file used in processing a comparison cast with
Velocwin.
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A.8.2.10 Microsoft Office Word and Excel

MS Word was used for report generation. MS Excel was used for log keeping (acquisition
and processing), organization and preparation of field and office tasks, report figure
production and statistical data analysis. Excel was also used to reformat sound speed/depth
data into the .ZZQ format files for use in Velocwin’s sound speed comparison cast utility.

A.8.2.11 ODIM Brooke Ocean MVP Controller

Onboard the R/V Ocean Explorer only a dedicated laptop computer was used to operate the
ODIM MVP30 Controller Software. The System Configuration Window was used to
interface the MVP towfish, MVP winch and the navigation and depth data strings output
from HYPACK. Position, depth and vessel speed data were received from HYPACK and
sound speed profiles were exported to HYSWEEP to be used for real-time correction of the
multibeam waterfall display.

The deployment configuration, alarms and data logging options were set in the Configuration
Window, including profile depth limit, max cable out and docked cable out. Sound speed
profiles (SV Files) were saved to the MVP laptop and the .CALC files were post processed
and converted to CARIS .SVP files using Velocwin. During manual casts, completed
periodically during sound speed comparisons, the MVP fish was allowed to reach near full
water depth.

The Main Operator Window was used to remotely “cast” the towfish and to monitor the
towfish parameters and alarms. Graphical tabs in the Main Operator Window were used to
monitor towfish depth and surface sound speed. The “view profile” button was utilized to
review the current sound speed profile. The manual logging option was toggled on during
the acquisition of stationary water column, MVP casts.

A.8.2.12 Applanix MV POSView

On both vessels the MV POSView controller software was used to configure and monitor the
POS MYV navigation and motion systems. IMU parameters (heave, pitch, roll), navigation
and GAMS status were monitored continuously at the acquisition stations. Visual alarms
were configured to alert the operator in the event that attitude, position, velocity, heading or
heave accuracy was degraded.

MYV POSView was also used to start and end logging for daily POSPac files which contain
True Heave data and are used for various QA/QC analysis.

A.8.2.13 Applanix POSPac MMS Post-Processing Data
POSPac MMS is a post-processing software module, which, given acceptable distance and

geometry between the survey vessel and nearby Continuously Operating Reference Stations
(CORY) stations, significantly increases the efficiency, accuracy, and robustness of mapping
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and surveying using GPS data. Using POSPac MMS in post processing, reliable decimeter
level or better accuracy can be obtained from existing reference station networks without
having a dedicated station located close to the project area.

POSPac data were acquired during survey operations primarily so the TrueHeave component
of the solution was available for application to MBES data.

Inertially Aided Post Processed Kinematic (IAPPK) position and attitude, was not applied to
the MBES data as the area of operation did not fall within a network of shore-based CORS
stations.

A utility developed by OSI was used to extract high rate position and heading data from the
raw POSPac files. Once the 4125 data were converted in CARIS, the lower frequency fixed-
mount SSS fish position and heading logged to the JSF file were replaced with the high rate
position and heading data extracted from the POSPac files using the Generic Data Parser
Tool in CARIS HIPS/SIPS.

A.8.2.14 Global Mapper

This 3-D visualization software and geographic information system was employed to create
detailed sun-illuminated Digital Terrain Model (DTM) images, display vector geographic
data and convert file formats. These data were used for QC checks and presentation
purposes.

A.8.2.15 AutoCAD 2004

AutoCAD drafting and geographic information system was employed for pre-survey
planning, line file construction, hydrographic data QC and the production of presentation
graphics.

A.8.2.16 Trimble ProBeacon and DSM Ultility

The Trimble ProBeacon PC interface program was installed on a utility laptop computer
onboard the R/V Ocean Explorer and used to configure the Trimble ProBeacon to receive
DGPS correctors from the selected USCG station. The PC Interface Program was run
through a DOS command window to enter the receiver frequency, check the receiver status
and monitor the RTCM messages. Trimble’s DSM Utility was used to configure and
monitor the DSM232 which was used onboard the R/V Osprey as the position comparison
DGPS.

A.8.2.17 Trimble GPS Configurator
The Trimble GPS Configurator software was installed on a utility laptop and used to

configure the Trimble 5700 Receiver. The software is a menu-driven Windows program that
was used to configure the RTK GPS base station (used for pre-survey calibrations). This
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software is also used to monitor system status and start/stop internal logging the results of
which were submitted as RINEX-format files to the National Geodetic Survey’s Online
Positioning User Service (NGS OPUS).

A.8.2.18 NGS OPUS

The NGS’ online OPUS software was used to transform dual-frequency GPS observables,
recorded with the Trimble 5700, into what the NGS describes as “high—accuracy National
Spatial Reference System coordinates.” The resultant coordinates were used as local
reference points against which the survey vessel’s POS MV DGPS position solution accuracy
was verified during port stops throughout the project.

A.8.2.19 HydrOffice QC Tools 2

UNH-CCOM/NOAA’s HydrOffice QC Tools 2 was used for various surface QC tasks
including the following:

e Flier Finder v5 - Scan grids for anomalous grid data “fliers”
e Holiday Finder v4 - Scan grids for empty grid nodes that meet NOAA NOS
Hydrographic Survey Specifications and Deliverables (HSSD) definitions of

“holidays.”
e Grid QA v5 - Compute basic grid statistics to ensure compliance to uncertainty and
density requirements.

e Designated Scan v2 - Scan grids to ensure the eligibility of soundings designated.

e Feature Scan v7 - Scan features to ensure proper attribution.

e VALSOU Check v6 - Ensure surveyed features are properly accounted for in the
gridded bathymetry.

e Submission Checks v3 - Ensures the required directory structure and completeness of
survey deliverables.

A.8.2.20 NOAA HSTP XmIDR

Used in compilation and printing (to PDF) of project Descriptive Reports.
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A.8.2.21 Acquisition System Block Diagram — R/V Ocean Explorer
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A.8.2.22 Acquisition System Block Diagram — R/V Osprey
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B. QUALITY CONTROL

B.1 Data Acquisition

All data acquisition and processing were performed under the supervision of the Chief of
Party. Field acquisition was performed under the supervision of a Lead Hydrographer and a
Senior Hydrographer, each with over three years of experience conducting hydrographic
surveys. The Chief of Party as well as the lead hydrographer on each vessel are
ACSM/NSPS/THSOA “Certified Hydrographers.”

Prior to the survey, a review of the current charted data was conducted to identify critical
features and areas including platforms, obstructions and wrecks. The Composite Source File
(CSF) and Project Reference File (PRF) supplied by NOAA were included in this review.

The Hydrographic Survey Project Instructions called for “Complete Coverage” over much of
the survey area. In areas not requiring Complete Coverage, “Set Line Spacing” was called
for. In consideration of the Project Instructions, where required, line plans were created to
achieve 100% SSS coverage with concurrent MBES. It should be noted that the Project
Instructions included a “Towfish Operation Waiver” which permitted SSS towfish height
above the bottom of 6-20% of SSS range (as opposed to the traditional 8-20%). The fixed
mount SSS on both vessels was operated only at the 50-meter range scale. For most
Complete Coverage areas, 100% SSS coverage lines were planned as follows:

e 80-meter line spacing (in anticipated and/or preliminary water depths > 5 meters)
resulting in 20 meters of outer range overlap; SSS nadir coverage provided by the
MBES

e 40-meter (or less) line spacing (in anticipated and/or preliminary water depths < 5
meters). The 40 meter line plan, which was essentially 80 meter line plan “splits”
resulted in substantial outer range overlap where conditions allowed. As in the case
above, SSS nadir coverage was provided by the MBES.

e NOAA-assigned and/or survey-generated investigations in assigned “Complete
Coverage” and “Set Line Spacing” coverage areas were accomplished with 200%
SSS coverage on variable spaced line plans which were constructed on a case-by-case
basis in consideration of water depth, local conditions, the anticipated or observed
character of the feature.

A certain relatively deep reach of the assigned survey area was covered with Compete
Coverage MBES in lieu of 100% SSS. In this area SSS was in fact acquired but was not used
to demonstrate Complete Coverage.
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In certain areas the Project Instructions called for 200 meter “Set Line Spacing” coverage.
As such, in these Set Line Spacing areas, SSS was acquired but no attempt was made to
achieve a coverage specification.

Data acquisition quality control procedures were established and performed to ensure survey
data met requirements specified in the Project Instructions, SOW, and HSSD.

B.1.1 Bathymetry: Multibeam Echosounder (MBES)

Transducer offsets for the Reson 7125 (R/V Ocean Explorer “OE”) and Reson 8125 (R/V
Osprey “SB”) were measured relative to permanent shipboard benchmarks and to the vessel
reference position (RP) using a steel tape measure. The benchmarks were established during
the full static surveys of the respective vessels which were completed using standard optical
survey equipment and techniques. For both vessels, the transducer mounting orientation as
relates to the vessel’s fore/aft centerline and the POS MV IMU orientation was set, using a
portable, survey grade gyroscopic compass mounted on a square plate.

The R/V Ocean Explorer’s transducer orientation was established as follows: soon after the
2015 fixed static survey, once the vessel was launched, the vessel was secured to a fixed
dock on a calm day with engines ahead pulling the dock lines taut. At this time the
transducer pole was rotated until the heading of the transducer matched the physical heading
of the POS MV IMU (via gyrocompass observations). The gyrocompass was passed back
and forth multiple times to confirm that the orientation of the IMU matched the orientation of
the transducer. At this time index marks were permanently scribed into both the transducer
pole and vessel attachment point such that the initial transducer orientation could be reliably
repeated if it was necessary to move the transducer pole, e.g. to accommodate a draft change
or, in this case, remobilization for a new field season. These permanently scribed index
marks were used to accomplish the initial alignment during the 2017 mobilization. A patch
test was then used to determine minor residual misalignments between the transducer and the
POS MV IMU. As regards the attachment and alignment of the entire transducer mounting
system, apart from retracting the pole for transit, once the draft and alignment were set
during mobilization no changes were made for the period of the survey. As mentioned
earlier, daily roll check patch test results indicated that the multibeam pole was stable for the
period of the survey.

The R/V Osprey’s transducer orientation was established during the 2017 static survey of this
vessel. In general the transducer orientation was accomplished in the same manner as
described above for the R/V Ocean Explorer except that the R/V Osprey’s transducer
orientation was accomplished with the vessel on its transport trailer. Concerning the
attachment and alignment of the entire transducer mounting system, apart from retracting the
pole for transit, once the draft and alignment were set during mobilization no changes were
made for the period of the survey. Daily roll check patch test results indicated that the
multibeam pole was stable for the period of the survey.
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The POS MV IMU “bullseye” or reference point, located on the top of the IMU served as the
vessel RP on the R/V Ocean Explorer. For the R/V Osprey, the X, Y position of the IMU
bullseye describes the horizontal coordinates of the RP but the Z component of the RP
coordinate is referenced to the IMU mounting plate (bottom of IMU) at the X, Y position of
the bullseye. On both vessels the IMU mounting plate and key components of the transducer
pole mounting apparatus are permanently installed hardware components of the respective
vessels. For detailed information regarding system offsets refer to Section C Correction to
Echo Soundings.

On the R/V Ocean Explorer the Reson 7125 processor was interfaced with the POS MV such
that UTC date and time information from the POS MV were used to accurately time stamp
the Reson output data string. The Reson 7125 processor received a pulse-per-second (PPS)
signal and a serial $ZDA NMEA timing string from the POS MV. The POS MV also
supplied a “TSS1” message to the Reson TPU allowing for real-time roll stabilization.
Surface sound speed measured at the transducer head with the AML Micro-X was output to
the Reson 7125 processor to be used in beam-forming. The 7125’s “Normal” filter was used
for sound speed filtering. Raw sounding data were output from the Reson 7125 TPU to the
HYPACK acquisition computer via an Ethernet connection.

On the R/V Osprey the Reson 8125 processor was interfaced with the POS MV such that
UTC date and time information from the POS MV were used to accurately time stamp the
Reson output data string. The Reson 8125 processor received a serial SUTC NMEA timing
string from the POS MV. The POS MV also supplied a “TSS1” message to the Reson TPU
allowing for use of roll compensated depth gates which were employed sporadically
depending on factors such as water depth, bottom type, and water column interference. Real-
time roll stabilization is not an option on the Reson 8125. As such, roll correction is
accomplished during post processing. Surface sound speed measured at the transducer head
with the Sea-Bird SBE-37 was output to the Reson 8125 processor to be used in beam-
forming. Raw sounding data were output from the Reson 8125 TPU to the HYPACK
acquisition computer via an Ethernet connection.

The POS MV received DGPS correctors from a Trimble ProBeacon (OE) or a Leica MX52R
(SB). POS MYV position, heading and attitude data strings were output to the respective
HYPACK acquisition computers via an Ethernet connection.

For each vessel HYPACK SURVEY and HYSWEEP SURVEY were configured to record
position, heading, attitude and depth to RAW and HSX data files. For the real-time display,
system offsets for the IMU and for the transducer phase center were entered into the
HYPACK configuration files. These offsets were subsequently incorporated into the CARIS
data processing routine for the respective vessels.

Prior to the start of data collection on either vessel, in light of physical offsets derived during
the respective full static surveys, each vessel’s static draft was measured and the transducer
draft was confirmed by means of a “bar check” while alongside a dock. The bar check
procedure consists of lowering the lead line disk to various indexed depths (calibration
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points) directly below the multibeam transducer and recording the nadir depth value output
from the respective Reson echosounder as returned from the acoustic target. Aboard each
vessel a “spot check” was also completed which consisted of sounding the seafloor directly
below the multibeam transducer with the lead line while simultaneously observing the
multibeam nadir depth. Throughout the course of the survey bar checks were completed
periodically on each vessel. All bar checks and spot checks indicate that the respective
multibeam sonar systems were performing within expected accuracy limits (DAPR Appendix
10).

For the R/V Ocean Explorer residual transducer alignment offsets (patch test) and multibeam
system performance test were completed on July 17, 2017 (DN 198). The vessel and MBES
calibration to establish the dynamic draft correction table (squat test) was performed on July
19, 2017 (DN 200). The July 17, 2017 patch test is the patch test of record for this field
season.

On the R/V Osprey a preliminary “vessel acceptance” residual transducer alignment offsets
(patch test) and multibeam system performance test were completed on August 18, 2017 (DN
230). The vessel and MBES calibration to establish the dynamic draft correction table (squat
test) was also performed on this day (DN 230).

In the case of both vessels the tests were performed with the respective POS MVs in RTK
GPS mode as a land based RTK GPS base station was established for this purpose. These
data were collected nearby the vessel’s home port once the vessel was mobilized and
physical offsets derived.

After each vessel transited to the project area a second set of vessel-specific patch test and
performance test data were acquired. Specifically, on the R/V Ocean Explorer, a
confirmation patch test was performed adjacent to the survey area (south of the Freshwater
Bayou Canal Lock) on August 3, 2017 (DN 215). None of the OE’s survey system
components were removed during transit to the project area, therefore, as mentioned above,
the July 17, 2017 patch test is considered the patch test of record for the R/V Ocean Explorer.
The initial performance test of record was performed south of the Freshwater Bayou Canal
Lock on August 4, 2017 (DN 216). Verification or “close out” patch and performance
testing for the R/V Ocean Explorer were performed at the completion of the project on
October 12, 2017 (DN 285). Close out test results were in keeping with the pre-survey
results. This vessel’s patch test and performance test results of record are presented in DAPR
Appendix IL

Since the R/V Osprey’s survey system components were removed from the vessel for transit
to the project area, the vessel was reassembled once onsite, and, the initial patch test and
performance test of record were performed in southern Vermillion Bay, LA (Southwest Pass)
on August 24, 2017 (DN 236). Verification or “close out” patch and performance testing for
the R/V Osprey were performed at the completion of the project on October 12, 2017 (DN
285). Close out test results were in keeping with the pre-survey results. This Vessel’s patch
test and performance test results of record are presented in DAPR Appendix II.
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Given that each vessel’s multibeam transducer was deployed on a retractable pole, in order to
maintain confidence that the deployed pole was stable, multiple interim “roll” patch tests
were performed throughout the course of the survey. In practice, reciprocal multibeam data
were collected on a short set of lines at a convenient time each day and processed onboard to
confirm system stability. In cases where the pole was deployed after transit, e.g. after
returning to the survey area after a port call, a roll test was conducted immediately prior to
data acquisition. Essentially, each vessel recorded at least one interim roll test at least once
during each respective day of acquisition. In all cases, results of interim roll testing on both
vessels indicated that the respective multibeam pole was stable.

The SeaBat display and user interface of the Reson 7125 or 8125 TPU were used to
configure MBES settings, to monitor sounding acquisition, and to adjust system parameters
in real time.

On the R/V Ocean Explorer the Reson 7125 was operated in equidistant mode using 512
return beams. As mentioned previously the system is capable of operating in equidistant
mode with a swath of 140°. However, the swath was reduced to 130° for all project data
acquisition due to observed degradation of data quality in the outer beams (beyond 65°)
caused primarily by dynamic changes in the sound speed profile. The roll stabilization
feature was activated throughout the term of the project.

Aboard the R/V Osprey the Reson 8125 was operated in the system’s only available mode,
equi-angle with 240 return beams spread over a swath of 120°. Roll stabilization is not
available for this Reson model.

On both vessels “absolute” depth gates were conservatively employed to reject fliers during
mainscheme and crossline data acquisition. Depth gate filters were used sparingly or turned
off all together during item investigations.

The respective Reson sounding profile “wedges” were monitored in real time. Power and
gain settings were monitored and adjusted to optimize bottom detection. Range settings were
monitored and adjusted for observed depths to maximize the ping rate.

Bathymetry, position, motion and heading data were logged in HYPACK SURVEY and
HYSWEEP SURVEY. Position information from the each vessel’s primary and secondary
GPS receivers (POS MV and Trimble DGPS) were continuously compared in HYPACK
SURVEY and status indicators were monitored in real time. By means of a utility in the
HYPACK SURVEY program a position disparity between the primary and secondary
positioning systems that exceeded two (2) meters would be reported by means of a visual
alarm on the data acquisition screen of each vessel.

The HYSWEEP SURVEY program allows for real-time monitoring of surface sound speed
as transmitted by the respective vessel’s transducer-mounted sound speed device. A utility in
HYSWEEP SURVEY allows for real-time comparison of the surface sound speed to the
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surface sound speed recorded in the most recently acquired water column sound speed
profile. For this project the respective vessel systems were configured to provide a visual
alarm if the difference between these surface sound speed values exceeded 2 meters per
second. Hydrographers endeavored to acquire sound speed casts at an interval of < 15
minutes on the R/V Ocean Explorer or every 1-2 hours on the R/V Osprey. However, when a
dynamic surface sound speed was noted, sound speed profile casts were acquired more
frequently.

On both vessels, in HYSWEEP, real-time MBES sounding wedge and digital terrain model
(DTM) waterfall displays were monitored. The sounding wedge, DTM waterfall, and plan
view coverage displays were corrected for draft, motion, predicted tides and sound speed.
Survey coverage was tracked in the HYPACK SURVEY display window with a matrix file
updated in real time. MBES survey line names were composed of the year, vessel, day
number, UTC time and line number, for example: 20170E2320811 5458. HSX/RAW or
2017SB2581419 7419.HSX/RAW where “OE” stands for Ocean Explorer and “SB” stands
for Small Boat (Osprey).

The POSView software was used to monitor position, heading and motion accuracy status
indicators. Applanix “TrueHeave” data (included in POSPac data) were acquired and
recorded during survey operations. The TrueHeave algorithm uses a delayed filtering
technique to increase heave measurement accuracy, reducing error caused by IMU drift and
long-period ocean swell. In most cases POSPac data were logged at least 5 minutes prior to
and after MBES acquisition. POSPac TrueHeave file names include the project number,
vessel abbreviation, year, device (POS MYV), day number, and month/day (ex:
17ES024 OE 2017 POS 265 0922.000). POSPac files were saved in individual day
folders. Once the file size reached 64 MB, a new file was created; therefore, each day of
survey has multiple TrueHeave files.

Aboard each vessel the POS MV heave bandwidth filter was configured with a dampening
ratio of 0.707. The cutoff period of the high-pass filter was determined by estimating the
swell period encountered during the project. A heave bandwidth filter of 10 seconds was
employed for Project OPR-K354-KR-17 data collection.

On the R/V Ocean Explorer, which operated on a 24-hour/day schedule, during the daily
“UTC midnight” changeover, the vessel was stopped and a number of mandatory and/or
elective QA/QC functions performed: a static draft physical measurement was obtained
(conditions permitting), a transducer pole stilling well pressure series was acquired and
processed into a static draft value (conditions permitting), and a new Applanix
POSPac/Trueheave file was begun. Given that the R/V Osprey was operated on a nominal
12-hour/day schedule, a new POSPac file was started each day and a dockside static draft
physical measurement was recorded before and after daily operations.

On each vessel data were copied, via network connection, onto a shipboard data backup
computer which also served as the data QA/QC platform. Data were copied from this
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computer to removable media, 2-TB or 4-TB USB drives, frequently throughout each survey
day. These data were periodically transferred to OSI’s home office via courier delivery.

Each vessel completed the following checks periodically throughout the course of the survey:
a bar check was performed to verify echosounder draft offsets and system sounding accuracy
and a sound speed profile comparison cast was performed to ensure the primary sound speed
profiler on each vessel compared favorably to an independent, recently calibrated sound
speed profiler. In all cases for both vessels the results of the bar checks and sound speed
comparisons indicated that the respective systems were functioning properly.

Finally, during home office processing, coincidental MBES data from both vessels were
compared (treated like Junction Survey analysis). The results of this analysis are presented
in Section B.3.

B.1.2 Imagery: Side Scan Sonar

As noted above “fixed mount” SSS is the only deployment method employed during this
survey. On each vessel the horizontal position of the SSS was measured in relation to the
vessel RP. These values were ultimately used in creating the CARIS vessel file (discussed
later). However, horizontal offsets entered into the HYPACK SURVEY data acquisition
program, used to calculate fixed mount fish position for real-time positioning, were
referenced to the survey vessel “steering point” origin which was accurately related to the
vessel RP.

As discussed previously, EdgeTech Discover side scan sonar acquisition software was used
to log the SSS imagery and position information in JSF file format. On each vessel Discover
received towfish position from HYPACK SURVEY and ship heading directly from the POS
MV. SSS survey line names are identical to their simultaneously recorded HYPACK
counterparts, the only difference being the .JSF file extension.  For example:
20170E2320811 5458.JSF or 2017SB2581419 7419.JSF where “OE” stands for Ocean
Explorer and “SB” stands for Small Boat (Osprey).

Over much of the study area over one hundred percent (100%) SSS coverage was attained
employing line spacing described in Section B.1. above. However, as mentioned above, one
relatively deep section of the study area was surveyed with Complete Coverage multibeam.

Each vessel’s speed was maintained such that any 1 m? objects would be ensonified more
than three times per pass at the operating range scale.

For the fixed mount configuration, the 4125 SSS towfish height was not dynamically
adjustable (as compared to a towed fish). As such, towfish altitude varied based on water
depth. Therefore, on any given trackline, the SSS altitude may have been marginally below
the 6-20 percent range scale limit, i.e. at times the altitude was less than 3-meters which is
the shallow limit when using the 50-meter range scale. For any towfish height below 6
percent of the 50-meter range scale (3-meters), the effective scanning range is defined to
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equal 16.7 times the towfish height. As mentioned previously, 40-meter “splits” lines were
run in the shallow reaches of the study area. By “splitting” lines the 100% SSS coverage
requirement was far surpassed especially in light of the Towfish Operation (height) waiver
mentioned in Section B.1.

Confidence checks observed across the full SSS range (e.g. scour marks and bottom type
changes) were recorded frequently throughout each survey day (on each vessel) to verify
system operation and object detection capabilities. Confidence checks were recorded with line
names, observation times, and comments in the daily acquisition log.

Approximate vessel speed for SSS acquisition on the R/V Ocean Explorer was 7-9 knots
while the R/V Osprey speed was 5-7 knots.

B.1.3 Sound Speed
B.1.3.1  Sound Speed Profiles

On the R/V Ocean Explorer sound speed profile data were acquired with the ODIM MVP30
approximately every 15 minutes, except when this time interval occurred while the vessel
was turning. The MVP operator acquired casts more frequently if high variability was noted
in the surface sound speed, prompted when the surface sound speed alarm threshold was
exceeded (> 2 meters/second change). Profiles were acquired to a depth approximately 0.8
meters off the bottom when operating in freewheel mode. All casts were acquired inside the
bounds of the survey area or outside the survey area within 250 meters of the boundary.
Profiles acquired outside the survey area (within 250 meters) were typically acquired on the
lead-in to a given transect. The moving vessel profiler was operated in accordance with the
ODIM Brooke Ocean’s MVP30 Operation and Maintenance Manual.

The ODIM MVP Controller software was configured to receive navigation data from
HYPACK via the MVP.dll. HYSWEEP SURVEY was configured to receive MVP casts in
real time to correct the real time waterfall and profile displays with the most recent sound
speed profile. MVP cast position, sound speed and depth data were recorded in .CALC file
format and saved to the designated MVP laptop computer. Profiles were named for day
number and cast number, for example: MVP_DN260 0041.calc.

Aboard the R/V Osprey sound speed profile data were acquired with an AML Base-X
approximately every 1-2 hours during survey operations. Profiles were acquired more
frequently if high variability was noted in the surface sound speed or the survey vessel
moved between survey area locations. The surface sound speed alarm in HYSWEEP
SURVEY was used as an indicator that additional casts were necessary; however, there were
certain periods during the survey when the surface sound speed was highly irregular. It
would have been impractical during these periods to collect an additional sound speed cast
each time the surface sound speed changed by 2 m/s. As a result, the hydrographers used
their judgment about when and where to collect sound speed profile casts. Up to 11 sound
speed profiles were collected on days such as this.
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Profiles were manually acquired by lowering the instrument to the seafloor. Locations for
the casts were selected to maximize depth and capture a profile representative of conditions
observed within a daily operating area. At all times the instrument reached full bottom depth
at the cast location. All casts were acquired in or within close proximity to the survey area.

Individual R/V Osprey sound speed profiles were named according to the following
convention: Last digit of the instrument serial number, day number (DN), daily profile
number, for example: 8 DN246 4.vel

Individual casts were saved in both HYPACK .VEL and CARIS .SVP format.

After a cast was downloaded and processed using the AML SeaCast software and a custom
OSI EXCEL spreadsheet, the resulting HYPACK compatible VEL file was loaded in
HYSWEEP SURVEY to sound speed correct the real-time waterfall and profile displays
allowing for enhanced real-time QA/QC capability.

B.1.3.2  Surface Sound Speed

For the respective vessels the AML Micro-X or Sea-Bird SBE-37 sound speed sensor was
installed on the multibeam transducer essentially at the draft of the transducer phase center.
Real-time surface sound speed values were transmitted to the respective Reson 7125 or 8125
topside unit and subsequently recorded with multibeam echosounder data in the raw
HYPACK .HSX data files. Sound speed data were also utilized by HY SWEEP SURVEY
which was configured to display a visual alarm if the surface sound speed changed +/- 2 m/s.
Variations in surface sound speed were monitored and evaluated as an indicator of surface
water temperature/salinity fluctuation and potential water column variation which would
necessitate additional sound speed profile measurements.

Each vessel occasionally performed a “daily surface sound speed quality assurance (DQA)
check” employing NOAA’s Velocwin software. Velocwin’s DQA comparison considers the
surface sound speed sensor value to the draft-appropriate surface sound speed of a recently
acquired sound speed profile.

B.14 Horizontal and Vertical Control

The U.S. Coast Guard (USCG) Differential GPS (DGPS) station in English Turn, LA served
as the primary horizontal position control for each vessel and USCG station in Angleton, TX
served as the secondary horizontal position control. The POS MV primarily received pseudo
range corrections from the English Turn station. However, on one occasion, the Angleton,
TX signal was used on the R/V Ocean Explorer when the English Turn signal was
unavailable or degraded due to thunderstorm activity (assumed) between English Turn and
the survey boat.

-36 - Data Acquisition and Processing Report



OPR-K354-KR-17 OCEAN SURVEYS, INC.

Prior to the start of survey operations, navigation checkpoints were established at each
vessel’s Louisiana base of operations employing a Trimble 5700 with a Zephyr geodetic
antenna. Multiple dual-frequency GPS observation sessions were recorded at these locations.
The dual-frequency GPS observables were submitted to the National Geodetic Survey’s
(NGS) Online Positioning User Service (OPUS) and processed to determine the positions of
the temporary control points. NGS provided an OPUS Report which included both ITRF and
NADS3 coordinates along with position accuracy information. These reports are provided in
the Horizontal and Vertical Control Report (HVCR).

On the R/V Ocean Explorer positioning system confidence checks of the POS MV were
accomplished at the start of survey and during provisioning stops in Intracoastal City, LA.
On the R/V Osprey positioning system confidence checks were accomplished each morning
prior to leaving the vessel’s Cypremort Point, LA dock. In practice the distance between the
respective vessel’s reference point (RP) and the dockside horizontal control point, as
computed by the navigation system, was compared to the tape-measured distance between
the vessel RP and the horizontal control point. In all cases, dockside navigation system
accuracy testing demonstrated that the each vessel’s POS MV, employing USCG correctors
(from either source mentioned above), had an accuracy of better than 1.0 meter. A tabulation
of navigation system performance checks is included in DAPR Appendix III.

On each vessel a HYPACK SURVEY “position integrity alarm” was utilized throughout the
term of the survey. In practice the utility continuously compared independent positioning
sources, i.e. the position reported by the respective vessel’s POS MV to the position reported
by the Trimble DGPS. For the purposes of the comparison the physical, shipboard position
of the DGPS antenna was related to the RP (POS MV IMU) via forward and starboard offsets
in HYPACK SURVEY. The position solution difference, expressed in meters and viewed on
a window on the HYPACK SURVEY display, was monitored by the acquisition team. An
on-screen visual alarm notified the system operator if the difference in positions exceeded 2-
meters.

The alarm proved valuable in quickly drawing attention to the DGPS beacon status when a
station went offline or had a degraded signal.

During data acquisition, the MV-POSView controller software was used to monitor real-time
position accuracy, with the accuracy alarm set at 2.0 meters.

Per the Project Instructions, water level data from NOS-NOAA Tide Station 876-4227,
LAWMA, LA was used for vertical control. Predicted tide files were downloaded from the
Center for Operational Oceanographic Products and Services (CO-OPS) website,
http://opendap.co-ops.nos.noaa.gov/axis/text.html, prior to survey operations. Predicted tide
files were used during preliminary processing. Preliminary tides from the LAWMA station
were downloaded and reviewed for data gaps. Verified tides were downloaded and reviewed
when available.
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Final project data are delivered with verified tides applied using a slightly altered version of
the preliminary zoning file provided by CO-OPS, “K354KR2017rev.zdf.” Neither time nor
magnitude multiplier changes were made to the preliminary zoning file provided by CO-
OPS. However, the CO-OPS provided zoning file was found to have a minor flaw in the 6
vertex of Zone #82. It was discovered during data processing that this vertex did not fall
exactly on a nearby vertex of the adjacent zone (the presumed intention of CO-OPS). The
result was a long, narrow, triangular area with no zoning coverage. The non-coverage
triangle had two legs roughly 11.6 kilometers long with the third leg being only about 4
meters long. OSI adjusted the Zone #82 vertex which resulted in elimination of the non-
coverage area. The OSI-edited zoning file included with the project deliverables uses the
same name as noted above, i.e. the file name, as delivered by CO-OPS, was retained.

B.1.5 Feature Verification

When necessary, development/investigation MBES only lines were run over significant
contacts and other features observed in MBES and SSS records to determine a least depth in
accordance with Complete Coverage specification in the HSSD (Section 5.2.2.3). During
home office processing, once an item was deemed significant, nearly significant, or simply
required more data to make a determination, the contact or outstanding sounding position
was conveyed to the field team in various formats including:

An EXCEL tracking table that was added to the acquisition log
a HYPACK target file of point items

an AutoCAD-compatible .DXF file for area features

a HYPACK line file (.LNW) for SSS or MBES fill in areas

A series of short MBES lines were run over the feature from multiple directions to obtain
soundings on the object at various angles with high sounding density.

Given that the SSS coverage requirement for this project was 100% (as opposed to the
traditional 200%) there were many instances where the first pass, single SSS coverage was
not sufficient for data analysts to confidently describe the nature of a particular feature.
Furthermore, the shadowing effect of items such as oil platform legs, dense fish schools, etc.
resulted in data gaps that might otherwise have been ensonified with the second coverage
afforded by the traditional 200% coverage requirement. These data gaps were identified
during home office data processing and conveyed to the field team via the various methods
bulleted above. All such data gaps were eventually filled with 200% SSS coverage or
Complete MBES coverage while the field team was still mobilized.

B.1.6 Bottom Sampling

Bottom samples were acquired in close proximity to the recommended positions included in
the PRF provided with the OPR-K354-KR-17 Project Instructions. Both vessels shared
responsibility for sediment sample acquisition. On each vessel a sediment sampler was
deployed from a davit to acquire the requisite sample. Bottom sample locations were logged
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in a target file in HYPACK SURVEY. Once the sample was on deck it was photographed
and classified based on the criteria outlined in Appendix H, Bottom Classification, in the
HSSD.

B.1.7 Other
B.1.7.1  Autopilot

Onboard the R/V Ocean Explorer the Simrad AP50 Autopilot was configured to receive
heading from the POS MV, and speed, position and the Autopilot (APB) message from
HYPACK. Once in control, the Autopilot maintained the vessel steering point within
approximately 2 meters of the selected trackline.

B.1.7.2  Digital Acquisition Logs

On each vessel an acquisition log was maintained in Microsoft Excel to record all pertinent
information related to acquisition, such as:

Daily operations and locations

Weather and sea state observations

MBES/SSS survey line ID and start time

Date and Time of MVP (or AML) and TrueHeave (POSPac) files

Navigation System Performance Checks, Bar Check Table, Vessel Water Level
Tabulation and Sound Speed Comparison Table

Systematic changes (i.e. equipment repairs or replacements)

SSS Confidence Checks

Significant SSS contacts or Bathy features

Excessive Noise in the SSS/MBES records due to fish, vessel traffic, or surface noise
Deviations from planned tracklines or Data Gaps

System “crashes” or Position Outages

Line Miles and Survey Statistics

e [tem investigations

B.2 Data Processing
B.2.1 Bathymetry
L. Data Conversion and Preliminary Sounding Correction

QA/QC level processing was completed onboard the survey vessel; however, all formal data
processing occurred at OSI’s home office. In practice, data disks were shipped via courier to
the home office processing center during convenient in-ports. Using this approach the lag
between acquisition and data check-in at the home office was about one week for R/V Ocean
Explorer data and more frequently for R/V Osprey data. Offshore conditions permitting, disk
transfers were made between vessels which allowed for more frequent transmittal of both
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vessels’ datasets. Shipping frequency became more important near the end of the survey as
quicker home office input was desirable. In addition to courier delivery, especially near the
end of the field program, data were transmitted via FTP.

Upon receipt of a data disk (or FTP download), information contained in the daily
acquisition log was compared to the data package to ensure that no files were lost or omitted.
Prior to data processing the acquisition log was consulted to verify line names and file size
and to remove any aborted lines from the preprocess folder prior to converting the data in
CARIS HIPS. All accepted MBES & SSS line data, POS MV TrueHeave files, and sound
speed profile data were entered into the survey processing log, which was subsequently used
to track the processing progress of each line and to enter all notes pertinent to individual
lines or days. The processing log was built from the acquisition log in that any pertinent
information regarding accepted line data was propagated from the acquisition log.

Vessel-specific configuration files ((HVFs) were created in CARIS HIPS Vessel Editor prior
to data conversion. The HVF files contained transducer offsets relative to the RP, alignment
offsets derived from the calibration testing, as well as the waterline height and standard
deviation values for all surveyed parameters (used to model sounding uncertainty).
Duplicate HVFs were created for the MBES system to convert lines into HDCS folders
according to classification, i.e. mainscheme lines, crosslines, investigation lines. Waterline
correctors were updated in the HVF files as new values became available. See Section C

Corrections to Echo Soundings for additional information regarding vessel configuration
files.

During the first few days of data acquisition the recorded, stand-alone Applanix POSPac files
were affected by occasional brief network interruptions with durations on the order of around
5 to 22 seconds. It was initially believed that the cause of the outages was a faulty network
cable which was replaced on DN 221. However, subsequent outages suggest that network
collisions may have been responsible. As a result of the network interruptions the
TrueHeave or delayed heave record within each file was affected as well.

CARIS HIPS does not allow for application of TrueHeave files with data gaps. Rather than
forego using the discontinuous TrueHeave files, OSI developed a utility to “fill” TrueHeave
gaps with the real-time heave data recorded by HYPACK. In practice the utility loops
through a given POSPac file and searches for gaps in the TrueHeave record of > 0.1 second.
If a gap is detected the utility then polls the appropriate HYPACK .HSX file and extracts the
non-delayed, real-time heave values for the period of the data gap. Finally, a TrueHeave file
(supplemented with real-time heave as appropriate) is written as a TrueHeave group 111-only
file (.000 format). During data check-in each and every POSPac file was analyzed for
TrueHeave gaps. For the few days affected by the network interruptions these .000 files
were used in lieu of the POSPac .000 file for application of TrueHeave. The analysis and
generation of “repaired” files described above was undertaken prior to the steps described
below. The “repaired” files, included with the project deliverables, include the following:

e 17ES024 OE 2017 TH 218 0806.000

e 17ES024 OE 2017 TH 219 0807.000
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17ES024 OE 2017 TH 220 0808.000
17ES024 OE 2017 TH 232 0820.000
17ES024 OE 2017 TH 263 0920.000
17ES024 OE 2017 TH 273 0930.000

It is important to note that at no time did the network outages described above result in an
interruption to the real time network stream as recorded by HYPACK. TrueHeave gaps
affected only files recorded by the R/V Ocean Explorer and only on the days indicated above.

Multibeam sonar data conversion and application of sounding correctors were completed
using routines developed employing CARIS’ Process Designer. The Process Designer
(model) runs a user-defined script which accomplished the following standard tasks in

succession:
1. Convert the HSX and RAW data to the HDCS data format, establish UTM grid.
2. Enable all multibeam beams.
3. Load zoned, preliminary or verified tides (when available).
4. Load daily TrueHeave files (if available).
5. Load and apply concatenated sound speed profile data. Sound speed profiles were

loaded with the CARIS nearest in distance within time correction method. A time
basis of 1-hour or 2-hours was used for R/V Ocean Explorer or R/V Osprey data
respectively. During CARIS SVP Correction, the following correctors were applied:
sound speed, heave, pitch, roll and waterline.

Merge data to apply vessel offsets/alignment, position, gyro, tide, and dynamic draft
correctors to bathymetry. HIPS/SIPS computes the fully corrected depth and position
of each sounding during the Merge process.

Compute TPU (Figures 8 & 9). Total Propagated Uncertainty (TPU) is calculated in
CARIS HIPS from contributing uncertainties in the echosounder, positioning and
motion sensor measurements as well as uncertainties associated with sound speed and
water level correction. The standard CARIS devicemodel.xml was used to create the
HVFEF.

A tide uncertainty value of 0.2 meters was provided in the OPR-K354-KR-17 Tides
and Water Levels Statement of Work. Sound speed TPU values were estimated from
manufacturer accuracy of the ODIM MVP30 and AML Micro-X and from guidance
in the OCS Field Procedures Manual (FPM) Appendix 4 under CARIS HVF
Uncertainty Values. The R/V Ocean Explorer’s MVP was deployed for a cast at a
frequency of <15 minutes and the R/V Osprey’s AML Base-X was deployed at a
frequency of <2 hours. As such a sound speed profile uncertainty value of 1 m/s and
4 m/s was chosen for the measured sound speed of the R/V Ocean Explorer and the
R/V Osprey respectively. A conservative value of 2 m/s was chosen for the sound
speed surface uncertainty despite the fact that the surface and near surface sound
speed profile gradient was relatively uniform throughout the period of the survey.
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Figure 8. Uncertainty values for the R/V Ocean Explorer entered into the Compute TPU
process in CARIS HIPS.
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Figure 9. Uncertainty values for the R/V Osprey entered into the Compute TPU process in
CARIS HIPS.
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II. Preliminary BASE Surfaces

Preliminary field sheets and Bathymetry Associated with Statistical Error (BASE) surfaces
were created for reviewing and cleaning full-density soundings using the Combined
Uncertainty and Bathymetry Estimator (CUBE) process. Daily data review and cleaning
were performed using 1-meter resolution CUBE surfaces as a guide for directed editing. Due
to water depth and in consideration of coverage requirements defined in the Project
Instructions, the survey was completed employing three types of MBES coverage, “Complete
Coverage Multibeam” according to the HSSD Section 5.2.2.3 - Options A and B and “Set
Line Spacing” according to the HSSD Section 5.2.2.4 — Option A. Depending on the MBES
acquisition methodology employed and in consideration of water depth, various CUBE
surfaces were created to evaluate coverage, e.g. l-meter resolution CUBE for “Complete
Multibeam” MBES coverage or, during early stage processing, 4-meter resolution CUBE for
“Set Line Spacing.” Both in the field and during home office processing, 1-meter resolution
CUBE surfaces were used to evaluate coverage for item investigations.

After the lines were run through the Process Designer, they were added to the 1-meter
Cleaning surfaces and the appropriately gridded Coverage surfaces. Depth, Standard
Deviation and Shoal surface models were viewed with sun illumination and/or vertical
exaggeration to highlight areas that would require immediate investigation. Standard
deviation surfaces were reviewed to evaluate data for consistency between overlapping
coverage and crosslines, and to detect potential systematic position, motion, tide, or sound
velocity errors. Highest standard deviation values were observed over obstruction features,
seafloor depressions, in the vicinity of offshore platforms and, due to wind setup affecting
application of zoned tides, at certain instances of overlapping/crossing data where one or
more intersecting lines were acquired during periods of relatively high wind or day-to day
winds with a contrary direction.

During late stage data review prior to creation of “final” surfaces it became evident that the
contours in the vicinity of the 4-meter contour (the demarcation line between Complete
Coverage and Set Line Spacing) were quite variable over a relatively large geographic range.
This phenomenon is commonly seen in large, flat bottom areas especially when using zoned
tides and DGPS positioning. Simply put, the jagged contours were visually unappealing.
Given that the 4-meter contour was the intended cutoff between the Complete Coverage and
Set Line Spacing surfaces (per the Project Instructions) it follows that the junction area of the
submitted surfaces would have been visually unappealing as well.

The along track density of the Set Line Spacing MBES data was more than sufficient to
support a 1-meter surface. As such OSI requested permission to submit Surveys H13041 and
H13042 as 1-meter surfaces rather than breaking each of these surveys into 1-meter/4-meter
surfaces. As seen in correspondence in DR Appendix II for the aforementioned surveys,
AHB agreed to the request in an e-mail dated January 12, 2018.
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Coverage surfaces were reviewed for any data gaps meeting the criteria described in HSSD
Sections 5.2.2.3 and 5.2.2.4 respectively. As mentioned above, only 1-meter surfaces were
delivered. All surfaces were reviewed to ensure that Complete Multibeam Coverage was
obtained over significant shoals and features. Density layers were reviewed to verify that
95% of all nodes in the Complete Coverage and Set Line Spacing surfaces were populated
with at least 5 soundings (using a 1-meter grid for both).

I11. Data Cleaning and Processing

Line attitude and navigation data were reviewed in their respective CARIS editors to ensure
that there were no problems with the correctors, such as gaps in attitude data or navigation
jumps.

CARIS surface filters were employed to clean the majority of fish, noise, multipath returns,
and gross fliers. To avoid poor surface filter performance where survey lines intersect, 2-
meter surfaces were created such that no survey line overlapped another survey line. Due to
the abundance of fish, shrimp, and other water column returns, surface filters were
commonly run multiple times.

Swath Editor was used to review the surface filter results and further clean fliers or reaccept
over-filtered soundings. Soundings were colored by depth and reviewed in multi-directional
profile and plan view displays. Tracklines and swath boundaries were viewed in the CARIS
Map window in reference to BASE surfaces, charted data (RNC/ENC), SSS contacts and
field annotations (HYPACK target files).

The CARIS Subset Editor was used to clean fully-corrected, geospatially located soundings
in 2-D and 3-D displays. Soundings were primarily colored by line to verify the validity of
bathy features or SSS contacts recorded by multiple MBES passes and to reject fish or water
column noise recorded in one MBES pass and disproved by overlapping coverage from a
different MBES line. Areas with multiple sounding coverages from adjacent survey lines
were evaluated to increase confidence in outer beams and over significant features. Subset
boundaries were viewed in the CARIS Map window in reference to BASE surfaces, charted
data (RNC/ENC), and SSS contacts.

Full density soundings were reviewed for each SSS contact in the CARIS Subset Editor and a
sounding was designated for the representative least depth of significant contacts.

“Outstanding” sounding flags were temporarily assigned to soundings on features, or
possible features, which required further review. Occasionally a request would be sent to the
field crew asking for additional coverage on the feature for clarification. Before finalizing
the survey, all Outstanding soundings were reviewed and resolved, then either marked as
“Accepted” or “Designated” as appropriate. No soundings were left with an “Outstanding”
flag.
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The Designated flag was used to identify the least depth of a feature and ensure that the least
depth would be represented in the finalized CUBE surfaces. When a designated sounding
was assigned to a feature, it indicated that no further investigation was required. OSI
followed Section 5.2.1.2.3 of the HSSD guidance on the criteria for choosing designated
soundings. Near nadir soundings were designated as least depths on features in lieu of outer
beam soundings whenever possible. In the instance that soundings from multiple MBES
lines suggested different least depths, the contact heights measured in side scan editor were
reviewed to assist with least depth designation and the near nadir soundings favored over
outer beam soundings.

Once the surface deliverables were finalized, chart comparisons were completed with the
surveyed depths and charted depths located on all affected Electronic Nautical Charts
(ENCs). The final chart comparison was completed using charts downloaded from the OCS
website, nauticalcharts.noaa.gov, on November 15, 2017. CARIS HIPS & SIPS and CARIS
Notebook and were utilized to complete chart comparisons with the appropriate ENCs. This
was accomplished by overlaying surveyed depths in the form of finalized surface layers,
sounding layers and S-57 features over the ENCs. Surveyed data were compared to all
charted depths, contours and features, with agreements, discrepancies and disprovals
addressed in each survey’s descriptive report and final feature file.

B.2.1.1  Methods Used to Maintain Data Integrity

All project raw data files were copied onto the onboard QA/QC processing computer. The
hard drives on the processing computer retained both the raw and QA/QC-processed data.
Raw data on the QA/QC processing computer were backed up to a removable, 2 TB or 4 TB,
USB-3 hard drive numerous times each day. During each port call the removable hard drive
was shipped to OSI’s home office. The removable drive was packaged for shipping only
after a redundant, fully populated backup had been placed in service onboard the vessel.

B.2.1.2  Methods Used to Generate Bathymetric Grids

After MBES sounding editing was complete, final BASE surfaces were created using the
CUBE algorithm as incorporated in CARIS HIPS and SIPS. The CUBE algorithm generates
surface models from multiple hypotheses that represent the most accurate possible depths at
any given position. Hypotheses with lower combined Total Propagated Uncertainty (TPU)
are given higher significance for incorporation into the final surfaces. Also, soundings closest
to a grid node have a greater weight on the node depth value than soundings that are further
away.
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The following options were selected when final CUBE surfaces were created:

Surface Type — CUBE

IHO (International Hydrographic Organization) S-44 Order la
Include Status — Accepted

Additional Attributes — Shoal and Deep

Disambiguation Method — Density & Locale

CUBE parameter configuration varied with surface resolution. The CUBE parameters
Capture Distance Scale and Capture Distance Minimum were modified according to grid
resolution to meet the requirement that the maximum propagation distance for a node shall be
no more than the grid resolution divided by the V2.

The Capture Distance Scale (CDS) defines a radial distance from the node which is based
upon a percentage of water depth. All soundings within this radius are included in the
Density value and propagated to the node.

The Capture Distance Minimum (CDM) defines a fixed radial distance in meters from the
node in which all soundings are included in the Density value and propagated to the node.

During CUBE surface creation, the maximum value of the two capture distance parameters is
used to set the actual capture distance. To ensure that the CDM was the determining factor
for the radius of influence for each node, a CDS value of 0.50 % was used for the creation of
submitted surfaces.

Example for a 1-meter BASE surface in depths less than 20 meters:

CDS = 0.005
CDM =1/ (\2)=0.707

The CDS radius maximum value (0.005 * 20 = 0.1 meters) will not exceed the CDM value
(0.707 meters) for the maximum depth, and therefore the Density Attribute Layer will
represent those soundings that lie within a fixed radial distance (0.707 meters) for all nodes.

Table 5 displays the CDS and CDM values entered for the submitted grid resolution.

Table S
CUBE Parameters Applied in Surface Generation

Grid Resolution Capture Distance | Capture Distance
(m) Scale (%) Minimum (m)
1.0 0.5 0.71
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Sounding density and coverage achieved is based on requirements specified in the Project
Instructions (as amended with AHB’s January 12, 2018 consent to allow for submission of
only 1-meter coverage surfaces). The Project Instructions’ coverage requirements are shown
below.

Table 6
Project Instruction Coverage Requirements

Coverage Water Depth Coverage Required

LNM not to exceed 6300 LNM. Acquire
backscatter data during all multibeam data
All waters in survey area acquisition (HSSD Section 6.2). Report
significant shoaling via weekly progress
report. COR may adjust survey prioritization
based on observed shoaling.

Inshore limit to 4 meters water depth for | 200 meter set line spacing HSSD Section

H13041 - H13043 5.2.2.4 Option A.
Greater than 4 meters water depth for Complete Coverage (refer to HSSD Section
H13041 - H13043 5.2.2.3)

Complete Coverage (refer to HSSD Section

All waters in survey area of H13040 5.22.3)

Complete Coverage (refer to HSSD Section

Disproval radius of features in all waters 5.2.2.3)

All significant features were developed with MBES to meet Complete Multibeam Coverage
standards. Feature investigations are integrated with their associated 1-meter complete
coverage surfaces, i.e. there are no stand-alone investigation surfaces.

The attributes associated with each grid node are as follows:

Depth Value

Uncertainty

Standard Deviation

Mean, Deep and Shoal Depths

Sounding Density

CUBE Surfaces: Hypothesis Count, Hypothesis Strength & User Nominated

B.2.1.3  Methods Used to Derive Final Depths

The Complete Coverage and Set Line Spacing grids were “finalized” as single 1-meter
surface per survey. Per the CARIS HIPS & SIPS 10 Users Guide, a finalized surface “is a
finished version of the surface that is ready for export.” Designated soundings were
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incorporated into the BASE surfaces when finalized making certain the least depth sounding
was honored in the grid. Given that the maximum project depth is < 20 meters the Complete
Coverage MBES surfaces were finalized at 1-meter resolution and, as mentioned above, the
Set Line Spacing data was included with the Complete Coverage surfaces at a I-meter
resolution.

B.2.2 Imagery

Preliminary QA/QC of the SSS data occurred simultaneously with data acquisition.
However, all formal data processing occurred at OSI’s home office. SSS data backup and
shipment methodology were identical to the treatment of MBES data as described earlier.
Once these data were received by the home office, the backup disk’s files and acquisition log
were reviewed to verify line names and file size and to remove any aborted lines from the
preprocess folder prior to converting the data in CARIS HIPS. All lines copied from the
acquisition computer were entered into the survey processing log, which was used to track
the processing progress of each line and to enter all notes pertinent to individual lines or
days.

Vessel-specific CARIS HVFs were created to convert EdgeTech JSF data files. All
Preprocess EdgeTech JSF data were converted to the HDCS data format in CARIS’
Conversion Wizard.

For the fixed mount SSS configuration, towfish positions were converted from the JSF sensor
position field and fish heading was taken directly from the POS MV. Since the SSS towfish
was mounted rigidly in relation to the vessel frame, the vessel heading derived with the POS
MV was applied during SSS processing instead of using heading from the SSS compass
sensor or deriving it from course over ground averaging. The real-time fixed mount SSS
imagery was acquired using 1 Hz position and heading input directly from the POS MV.
However, during post processing, 10 Hz position and heading data were substituted for the
slower update data using the CARIS Generic Data Parser.

The EdgeTech 4125 JSF file format does not record bottom tracking, i.e. towfish altitude.
The CARIS SIPS bottom tracking routine was used to 1) bottom track the imagery and 2)
populate the altitude field as required in the HSSD. Although the CARIS SIPS bottom
tracking routine was ultimately used to accomplish (and fine tune) the bottom tracking
solution, the bulk of the bottom tracking effort was accomplished by alternate means as
follows. In practice, line-by-line coincidental multibeam nadir depths were exported,
corrected for the difference in draft between the MBES and the fixed mount SSS, and
imported to the fixed mount SSS dataset via the CARIS Generic Data Parser. The CARIS
SIPS bottom tracking routine was then employed to review the imported bottom tracking
solution and make the relatively few minor corrections/edits that were needed.

The fixed mount SSS vessel file is not a “zero” configuration. During fixed mount SSS
acquisition and subsequent onboard QA/QC data processing, HYPACK SURVEY-derived
SSS positioning data were utilized. However, in order to improve contact selection and
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mosaic quality, the CARIS Generic Data Parser was used to overwrite positioning/heading
recorded in the field with high rate position and heading information extracted from the daily
Applanix POSPac files. The fixed mount SSS vessel file includes forward and starboard
towpoint offsets which allowed the fish position to be recomputed using CARIS SIPS. The
fixed mount configuration did not have a variable “cable out” field; therefore, this value is
always shown as zero.

Navigation time stamp irregularities were edited and navigation data were reviewed in the
CARIS Navigation Editor. Each side scan line was reviewed in CARIS Attitude Editor to
ensure that the towfish attitude was properly represented and that there were no gaps or
problems with this parameter.

The CARIS Side Scan Editor was used to bottom track, slant range correct, and apply image
enhancement correction to the data. Processing was completed as follows:

1. Review the raw side scan data in Side Scan Editor. Use automated bottom detection
algorithms where necessary and then correct any automated or parsed bottom
tracking errors by manually re-digitizing the bottom trace.

2. Calculate and apply an average speed of sound value from sound speed casts
acquired during the corresponding day of side scan acquisition. The slant range
correction sound speed used for each day of side scan acquisition is noted in the
processing log.

3. Lines were Beam Pattern corrected to normalize angular response across the swath.

During pre-survey planning, the CARIS HIPS/SIPS *.hips database files were modified by
OSI to include additional Contact Feature types with which to classify contacts in Side Scan
Editor. The additional contact types are included in Table 7 below, along with their
graphical display in CARIS HIPS and a brief description of the conditions under which the
contact type is selected.
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Table 7
Modified OSI Contact Types Selected in Side Scan Editor

Unknown Contact
UNKCNT D ?

Feature whose nature cannot be determined

Obstruction - ht 0.7m+

SIGCNT

Feature that has a 555 measured height > 0.7 meters

or has significant size or features, i.e. submerged platform ruins, loose fish net, subm piling, etc.

Feature with insig height
INSCNT
Feature that has a SSS measured height between 0.25m and 0.7m

Fish contact

FSHCNT

Fish

Wreck

WRECK

Boat, ship, sailboat, barge, etc. , any feature that might be a wreck.

Platform
OFSPLF
Oil production platform. High water, not submerged.

NAVAID
Navigation Aids that can be verified against raster chart, ENC, or CSF

Exposed pipe and gas leak marker
QAQC

Use as a point feature marker for digitized linear pipes & cables, and possible gas seep locations

Cable
NPCA R i
Linear features that are not pipelines

+HH

n
Navigational Aids (charted) \)

o

Pipeline

NPPL —0—aQ—C—0—C—0—C—0C -

pipeline only

Once image processing was completed contacts were selected in the Side Scan Editor
waterfall. Objects were identified by the presence of sonar shadows. Shadow lengths were
measured and converted to heights. Contacts with significant heights or horizontal
dimensions were positioned and created at the top (closest to nadir) of the shadow, and
attributed with the following information: feature type (obstruction, platform, unknown,
wreck), height, width & length (if significant), and processor remarks. Heights were
measured with the shadow tool and lengths and widths were measured with the distance tool.

SSS lines were reviewed a minimum of two times by more than one data analyst to make
certain that all significant contacts were selected that may require investigation. The contacts
selected in Side Scan Editor were visible in the HIPS and SIPS Display window. Contacts
were reviewed in CARIS Subset Editor using full sounding density while toggling between
rejected soundings being shown or hidden.
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In order to ensure sufficient coverage, individual line mosaics were created with a resolution
of 0.15 meter. The line mosaics were then merged and saved as 0.25-meter resolution sheet
mosaics for the 100 and 200 percent side scan coverages.

During initial home office processing, the 100 and 200 percent coverage sheet mosaics were
reviewed for coverage gaps and poor quality imagery that would necessitate SSS fill-in lines.
Fill-in lines were assigned to the field team as necessary to supplement the existing coverage.
After the completion of survey and processing operations, the final 100 and 200 percent
coverage mosaics were exported from CARIS HIPS and SIPS to individual GeoTiffs.

B.2.2.1  Methods Used to Maintain Data Integrity

See Section B.2.1.1.

B.2.2.2  Methods Used to Achieve SSS Object Detection and Accuracy Requirements
As noted earlier, only one type of SSS system was employed on this project.

For fixed mount SSS operations utilizing the Edge Tech 4125, a traditional “single pulse”
SSS, the system was operated only at the 50-meter range scale. At this range scale the
system’s pulse repetition interval was sufficiently fast for survey speeds achieved.

B.2.2.3  Methods Used to Verify Swath Coverage

During home office data review the 100 percent side scan coverage mosaic was updated
frequently and reviewed for gaps or poor quality data that would require fill-in lines or re-
runs of the mainscheme line. The review process occurred while the field team was still
mobilized onsite.

Line spacing was planned such that there was ample overlap between adjacent lines for the
single 100% coverage. All side scan lines were planned with the intention of achieving outer
beam overlapping coverage of at least 20 meters. MBES near-nadir data provided secondary
SSS nadir coverage which was useful in assessing near-nadir SSS contacts. Gaps in side
scan coverage that occurred when the vessel steered off line to avoid oil platforms were
subsequently filled with side scan development lines and/or Complete Multibeam to the
extent that safety of the vessel and platforms allowed. SSS shadows created by platforms
even if the vessel did not have to steer offline were also filled with either additional SSS or
Complete Multibeam which were acquired from a different perspective. In many cases large
fish balls caused gaps in the 100% SSS coverage mosaic. These gaps were also filled with
either additional SSS or Complete Multibeam.

B2.24 Criteria Used for Contact Selection

The criteria used to select contacts was based on the guidance provided in the HSSD Section
6.1.3.2 Side Scan Sonar Contacts, which defines a contact as significant based on its shadow
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height in different depth ranges. The HSSD significant contact specifications are
summarized in Table 8.
Table 8
Significant Contact Selection Criteria

Surrounding Depth or Area | Significant Contact Height

<20 meters 1 meter

> 20 meters 5% of surrounding depth

No portion of the assigned survey area was found to be over 20 meters deep. Therefore, only
the < 20 meter significant contact height criteria was considered. OSI used a more
conservative approach than required when selecting contacts to make certain that significant
features would not be overlooked for further investigation or correlation in the MBES record.
All contacts with a minimum height, based on shadow length, of 0.7 meters were selected.
Features smaller than 0.7 meters were sometimes chosen if they appeared navigationally
“significant” in relation to the charted depth.

At times there was an abundance of fish encountered within the project area, represented in
the side scan record as individual fish and as schools. Fish contacts were created when the
fish schools, singular swimmers or dolphins created detectable shadows in the side scan
record. Singular fish presented themselves in the record most often as hard returns with long
detached shadows. Sometimes the fish and dolphin reflections were evident in the water
column, which also created shadows in the SSS record.

Individual fish contacts having a well-defined, characteristic detached shadow were not
investigated further. When available, coincidental SSS and/or MBES data were consulted to
bolster the decision not to investigate. Conversely, there were many cases where the
character of an interpreted individual fish shadow was not convincing, i.e. further
investigation was warranted. In these instances additional data were acquired to disprove the
questionable fish feature.

The presence of fish contact symbols in the HIPS display window was also helpful during
editing of bathymetry as an indicator to the hydrographer to anticipate noisy data. Fish
contacts were not assigned heights.

Most side scan contacts were symbolized as point features; however, sections of exposed
pipeline were digitized as linear contacts. At times, contacts without a shadow were selected
if there was a noteworthy shape or size to the item, despite its insubstantial relief.

B.2.3 Sound Speed

B.2.3.1  Sound Speed Profiles

As mentioned earlier an ODIM MVP was used as the primary sound speed profiling device
on the R/V Ocean Explorer and an AML Base-X profiler was used as the primary sound
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speed profiling device on the R/V Osprey. All automated and manual comparison casts were
reviewed in the field as they were acquired.

In the case of the MVP, profiles were plotted on the HYPACK SURVEY screen along with a
recent history of preceding casts. In practice, as MVP casts are performed they are plotted in
profile in HYPACK SURVEY displayed as a red line. As subsequent profiles are performed
the previously acquired profile changes to blue and the newly acquired profile is plotted in
red. This process is repeated each time an MVP cast is acquired with the older profiles
turning a lighter shade of blue each time a new profile is written in red.

In the case of manual casts on the R/V Osprey using the AML Base-X, the profiles were
downloaded with a dedicated laptop computer as they were acquired, plotted for QA/QC in
comparison to prior daily casts (in EXCEL) and incorporated into HYSWEEP SURVEY for
correction of the real-time sounding wedge in HYPACK. As a new AML Base-X cast is
loaded into HYSWEEP SURVEY the “new” cast is shown in relation to the cast it is
replacing which is another opportunity for QA/QC.

Sound speed profile data were continually assessed in the field by the following means:

e their shape in relation to previously acquired profiles

o their effect on the real time sounding wedge as displayed in HY SWEEP SURVEY

e the profile surface speed in comparison to the real time surface speed output by the
MBES-mounted, vessel-specific, AML Micro-X or Sea-Bird SBE-37 sound speed
Sensors.

As these data were received at OSI’s home office, the delivery disk’s file listing was
compared to the acquisition log to verify file names and size and to remove any aborted casts
from the preprocess folder prior to converting the data to the respective vessel’s SVP file.

For the automated MVP-derived cast data, the ASCII CALC files logged with each cast were
converted using NOAA’s Velocwin software. The BROOKE-OCEAN MVP Automatic
mode was used to convert one or more CALC files and append them to a CARIS HIPS SVP
file, referred to as the “CARIS HIPS Accumulating SVP File” in Velocwin. All individual
MVP casts, attributed with position, date and time of cast, were concatenated to a vessel-
specific survey level SVP file (ex: H13040-Master.svp) for use in sound speed correction of
the R/V Ocean Explorer survey lines in CARIS HIPS.

For the manual AML Base-X derived cast data the .SVP files generated onboard the survey
vessel were concatenated to a vessel-specific survey level SVP file (ex: H13041-Master.svp)
for use in sound speed correction of the R/V Osprey survey lines in CARIS HIPS.

During the Load SVP step in the HIPS Batch Editor, the vessel-specific Master SVP file was
chosen and the Edit option was selected to open the CARIS SVP Editor. All new casts that
had been appended to the SVP file were reviewed and the Extended Depth modified as
needed.
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The CARIS Profile selection method used to apply sound speed correction was the “Nearest
in distance within time” option. Two hours was chosen as the time increment. Prior to the
final application of sound speed correctors, the Master SVP file for each survey was opened
as a Background File in CARIS HIPS to verify that the cast positions all fell within the area
surveyed.

Occasional AML Base-X and MVP comparison casts acquired during the R/V Ocean
Explorer’s “UTC midnight” changeover or AML Base-X to Base-X comparison casts
conducted on the R/V Osprey were converted in Velocwin or an OSI custom EXCEL
worksheet to generate ZZQ files used to compare the sound speed profiles with the “Weekly
DQA” tool. The comparison casts were not appended to the CARIS SVP file used for
sounding correction. A listing of DQA results is included in DR Separate II.

B.2.3.2  Surface Sound Speed

Frequent comparisons were also made between the respective vessel’s profiler-derived
surface sound speed and the surface sound speed device mounted on each vessels multibeam
transducer. The comparison, observed visually by the onboard surveyor and monitored using
the HYSWEEP SURVEY utility mentioned previously was occasionally documented
employing Velocwin’s “Daily DQA” tool. These comparison data are also included in DR
Separate 11.

B.2.4 Horizontal and Vertical Control
B.2.4.1 Horizontal Control

RTK GPS positioning and water level determination were employed during pre-mobilization-
to-site MBES patch testing, side scan sonar positioning verification, and settlement and squat
testing.

This approach was chosen in order to achieve higher accuracy positioning of the discrete
objects used to determine the angular biases of the MBES transducer and to accurately
account for the vessel’s vertical response to changes in speed, i.e. settlement. Once the
calibration values (derived using RTK GPS positioning) were known, the vessels were
repositioned to the Gulf of Mexico survey area and certain processes were repeated using
DGPS real-time positioning. Examples of post site arrival tests include patch and
performance testing and, in the case of the R/V Osprey, the side scan sonar positioning
verification test. For onsite testing only, DGPS positioning was replaced with Inertially
Aided Post Processed Kinematic positioning, i.e. POSPac-derived positioning.

B.2.4.2  Vertical Control
Predicted, Preliminary and Verified tides were downloaded from the CO-OPS SOAP web

services website and were re-formatted as TID files to be used in CARIS HIPS tide
correction.
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The preliminary tidal zoning file (ZDF) that was provided by CO-OPS with the OPR-K354-
KR-17 Tides Statement of Work was employed as provided by CO-OPS (with the single OSI
vertex edit noted earlier). The time and height corrections in the zoning file were used to
extrapolate the water level measured at the tide gauge to each modified discrete tide zone.
The zoned tide correctors were then applied to the soundings.

B.2.5 Feature Verification

During home office processing contacts were exported (daily) from HIPS and SIPS to an
ASCII text file, which was reformatted and imported into a CARIS Notebook edit layer
(.HOB file). Senior processing personnel would identify the contacts that required additional
investigation from the contact HOB file. An item investigation HOB layer was created
which included the positions of all side scan contacts and outstanding soundings to be
developed with additional MBES coverage. The Investigation HOB layer was exported to
an S-57 (.000) file which could be opened as a background layer in HYPACK SURVEY
during acquisition of development lines. Several S-57 feature symbols were chosen and re-
defined for OSI tracking purposes; the in-house descriptions of the tracking objects are
included in Table 9.

-55- Data Acquisition and Processing Report



OPR-K354-KR-17 OCEAN SURVEYS, INC.

Table 9
Description of Investigation Tracking HOB Layer

S-57 Symbol Description Parameters

SSS: Incorrect contact,
Incomplete contact,
Additional contact
description needed

.. BOYISD IndlcateIs Survey Data
SSUes MB: Fish still in data,
Tide Issue, Heave Issue
acqsts = Investigate
Any Ftr that is not
significant should be
Indicates Items as marked examined.
™ BOYSPP :
Examined
Downgrade any
investigation item that is
found to be insignificant.
Item Investigations
. Shoal Areas
Indicates Resolved
A BOYLAT (green) Survey Task Ttems Photos

acqsts = Resolved

Indicates Unresolved
‘ BOYLAT (red) Survey Investigations

Item Investigations
Shoal Areas
Photos

B S

___________ Cartographic Lines and Indicates Lines e.md
o ; Areas that require
Areas

. acqsts = Investigate
r‘ ? ,‘ additional survey data 4 &
! !

Following the field team’s completion of investigation and development tasks, feature
verification, MBES and SSS coverage confirmation were accomplished through intensive
review employing various data sources and software. Prior to the conclusion of survey
operations, the home office project manager reviewed the data to ensure the following:

e Complete Coverage MBES was obtained over significant SSS contacts.

e Charted soundings were verified or disproved with MBES coverage per guidance
included in HSSD Section 5.2.2.1. Bathymetric Splits.

e Complete MBES coverage was obtained over significant shoals.

e (SF “assigned” items were adequately addressed.

e Photos were obtained of high-water features, e.g. platforms.
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The item investigation and development lines were converted and processed in CARIS HIPS
following the bathymetry processing procedures outlined above. CUBE surfaces with a grid
resolution of 1-meter were created over the investigated significant features. The density
layers were reviewed to verify that the Complete Multibeam Coverage requirement of 5
soundings per node was met. Least depths were designated on all verified features and
significant contacts.

Contacts were evaluated with respect to available correlating SSS as well as BASE surfaces,
charted information, and designated soundings. Significant contacts were evaluated in full
density sounding subsets to ensure that there was adequate MBES coverage.

Contacts, contact images, and designated soundings were exported from CARIS HIPS and
SIPS. All contacts were imported into a HOB file which was the foundation of the S-57 SSS
Contact File included with the project deliverables. The designated soundings were imported
into a HOB file, as well, and were utilized in the production of the S-57 Final Feature File
(FFF), wherein the positions and designated least depths were used to update existing chart
features or create new features in the FFF.

Shoal soundings, designated soundings and contacts were compared to the largest scale
charts in the survey area to identify Dangers to Navigation (DtoNs). All DtoNs were
submitted to AHB as attributed S-57 .000 files per the specifications laid out for Contractors
in the HSSD. All features submitted as DtoNs are included in the FFF.

I. SSS Contact File

It was discovered during data processing that, even despite the use of high-performance
computers, the CARIS 10.2.3. Contacts Database file became unstable/unusable when the
number of contacts approached 3,000. The project-wide SSS imagery contains many
thousands of fish contacts. For example, Survey H13040 contains over 14,000 fish contacts.
Given that fish contacts had to be considered during contact feature analysis and correlation,
an alternate method was devised to manage fish and fish-like contacts.

Initially, all SSS imagery was reviewed in the CARIS SSS View window. Due to the
limitations of the CARIS Contact Database the only contacts chosen in the traditional
manner, i.e. within the SSS View waterfall, were those contacts presenting themselves as
“obvious” seafloor-prone features and features with a questionable character. Those items
interpreted to clearly be fish or other nondescript water column targets (due to their
character, e.g. detached shadow) were intentionally not chosen as a traditional contact in the
SSS View waterfall.

Upon choosing all traditional contacts a new feature layer, i.e. a .HOB layer, was created for
each coverage percentage per vessel, e.g. a 100% mainscheme coverage layer from the OE, a
200% investigation coverage layer for the SB. The number of feature layer .HOB files
varied by Survey based on the number of SSS coverage surfaces created and the number of
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vessels that actually contributed to a survey (only the R/V Ocean Explorer worked in Survey
H13043). The .HOB layer names included the sheet name and a color designation. The
color designation was used in a later step during feature correlation.

In practice each 15 cm line mosaic was loaded into CARIS HIPS/SIPS and reviewed as a
stand-alone layer in concert with the SIPS traditional contacts layer, the appropriate ENC
chart background, and a CSF-assigned features layer. All layers were toggled on and off
throughout the process to ensure each mosaic was viewed in the context of all available
supporting information. As a given mosaic was reviewed (at a scale appropriate for target
identification on a 49-inch 4k monitor) individual fish targets were chosen with the mouse
cursor (on the plan view mosaic) and appended the appropriate coverage percentage/vessel
.HOB file. The operator used the SIPS contact layer overlay to help make informed fish
target picking decisions and to help avoid placing fish targets on top of previously chosen
SIPS traditional targets. A column entitled “fish positioned” was added to the data
processing log to ensure each SSS line file was reviewed in the manner described above.

Once all fish targets were chosen the .HOB files were loaded into the CARIS HIPS/SIPS
main operator window and the display properties of each fish feature layer adjusted such that
the displayed fish symbols were colored according to their associated file name color
designation. The end result was a CARIS operator window displaying thousands of fish
targets colored according to their source file, e.g. red, green, blue, cyan. The intent of this
approach was to allow for the opportunity to discern any actual features from the visual
background noise created by thousands of fish contacts.

It follows thus that during contact review and correlation the four-color fish symbols were
viewed in relation to one another and the SIPS contact layer. Fish contacts, regardless of
color, were dismissed if there was not a correlating fish contact (of a different color) in close
proximity. In instances when two or more fish contact symbols (of different colors) were
found in close proximity to one another then further investigation was undertaken.
Individual fish contact .HOB layers were concatenated (per Survey) and are included with
the project deliverables in the Ancillary Data directory.

All SIPS traditional SSS contacts, point and linear features, were exported from HIPS and
SIPS to an ASCII file and imported into a .HOB File. Individual contacts were correlated
manually with respect to available overlapping SSS coverage, fish contact . HOBs, BASE
surfaces, charted information, field photos and observations, and designated soundings.
Correlation was accomplished by selecting all contacts found to represent the same
independent feature in the Display Window and assigning each group a unique correlation
number in the Primary Key ID (prkyid) attribute field. All contacts with the same prkyid are
a correlating contact group. Singular contacts were not assigned a correlation number.

Each feature in the S-57 SSS Contact File includes the required NOAA Extended Attributes
as specified in the table from Section 6.1.3.3 of the HSSD. The contact number is composed
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of the SSS line number and the number assigned in the HDCS line Contact file, for example:
20170E2331204 60840191.

The contact image from SIPS Side Scan Editor is embedded in the S-57 contact file in the
Image (images) attribute field.

II. Final Feature File

A Final Feature File (FFF) in S-57 .000 format was created in CARIS HIPS/SIPS per the
guidance in HSSD 2017 Section 7.3. The feature file included all source features assigned
for investigation in the OCS-provided Composite Source File (CSF) and new navigationally
significant objects discovered during the survey that required additional description beyond
inclusion in the submitted bathymetric surfaces. The FFF includes new survey features, and
updated and disproved charted features. Per Section 2.2. of the HSSD the FFF is submitted
in the WGS84 datum, unlike all other project deliverables which are submitted in the NADS3
datum.

Regarding the OCS-provided CSF, it should be noted that not all “assigned” features
included in the CSF were addressed during the survey. This note is made in light of the
Project Instructions’ directive that, “all features with attribute ‘asgnmnt’ populated with
‘Assigned’ shall be addressed in accordance with Chapter 7 of the HSSD.” The following
timeline and narrative are offered as an explanation thereof. The Draft Project Instructions
are dated May 2, 2017 and the Draft Composite Source File (CSF) and Project Reference File
(PRF) were issued on May 19, 2017. The Final Project Instructions are dated June 21, 2017,
and the Final Data Package (including "final" CSF and PRF) was issued to OSI on July 5,
2017.

The draft directives included seven (7) potential sheets, i.e. HXXXXX Registry Numbers.
The negotiated survey effort, reflected in the Final Project Instructions and PRF include four
(4) of the seven (7) original sheets. The remaining three (3) sheets are depicted as
“unassigned” in the figure included with the Final Project Instructions. However, the Final
CSF (file date 5-19-2017) does not reflect the reduction in sheets mentioned above. As such,
there are a number of Final CSF “assigned” features that fall well outside of the four
surveyed sheets. OSI’s assumption that the CSF “assigned” features falling within the three
“unassigned” sheets was confirmed in correspondence with the COR concluding on
November 17, 2017 (see Descriptive Reports Appendix II, Correspondence).

For clarity the CSF “assigned” features that fall within the three ‘“unassigned” sheets
mentioned above are not included in the FFFs.

OSI followed the feature attribution guidance in Section 7.5, S-57 Feature Attribution, of the
2017 HSSD, while building the FFF. In particular, the determination of a charted feature as
an "Update" or a "New/Delete" item was based on the guidance that an Update is a
modification to "attribution, geometry, and/or feature object class" and that a charted feature
should be given the New/Delete treatment when the distance between the charted position
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and new position is "greater than 2mm at the scale of the survey (20m for 1:10,000)."
Further guidance on this subject was offered by the COR in an e-mail dated November 17,
2017 (see DR Appendix II). The guidance on positioning wellheads and platforms follows,
“Include both the significant wellheads and platform features in the FFF, and reposition any
platform that deviates greater than 10 meter from the center point of the corresponding
charted feature, based on the page 97 of the HSSD. These are all delete/add for the charted
platforms.”

New or Updated point features’ depths (VALSOU — value of sounding) and positions were
imported from Designated soundings selected in CARIS HIPS and SIPS.

High-water features such as platforms were digitized into the FFF with the position
determined from the MBES data or from the 25-centimeter SSS mosaic.

Descriptive information pertinent to each feature was entered in the IHO S-57 attribute fields
and the NOAA extended attribute fields as specified in Section 7.5 and Appendix F: Feature
of the HSSD.

The following attributes were updated for each item in the FFF:

e SORDAT (Source Date) — Final day of survey. New or verified features only.

e SORIND (Source Indicator) — Survey registry number, ex: US,US,graph,H12905.
New, updated or verified features only.

e descrp (Description) — New, Update, Delete, Retain

e remrks (Remarks) — Processing remarks including survey techniques, feature
classification (i.e. obstruction, rock, platform).

e recomd (Recommendations) — Hydrographer’s charting recommendations.

o sftype (Special Feature Type) — Only updated for ATON and/or DTON items.

e images (Images) — Contact images, CARIS screen grabs or shoreline photographs
included in the multimedia folder. Not Applicable for “Delete” features.

The mandatory S-57 attribution for each S-57 object class was updated as specified in
Section 7.5 of the HSSD. The required attributes vary with S-57 object class (i.e. OBSTRN,
OFSPLF, SBDARE).

B.2.6 Bottom Samples

Bottom sample positions were imported into CARIS from the HYPACK target file then
included in the FFF. The bottom samples were classified as SBDARE (Seabed area) objects
and attributed as instructed in Section 7.5 of the HSSD. The full bottom sample description
was entered into the Remarks attribute field. The photo names of each bottom sample were
entered into the Images attribute field.
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B.3 Quality Management

A full crossline sounding data set was acquired at the start of acquisition, prior to collection
of mainscheme coverage. Crosslines were run nominally perpendicular to mainscheme lines.
Soundings from mainscheme lines and crosslines were compared periodically throughout
survey operations using preliminary CUBE surfaces and using CARIS HIPS Subset Editor.
Crossline comparisons provided confirmation that the system offsets and biases were entered
correctly and verified the accuracy of sounding correctors (i.e. tide, sound speed,
TrueHeave).

As required in the HSSD, the planned crossline mileage was > 4% of mainscheme mileage
for Complete Multibeam Coverage areas and > 8% of mainscheme mileage for Set Line
Spacing areas.

Statistical quality control information was generated periodically during data acquisition by
comparing the beams of each crossline to CUBE Surfaces generated from mainscheme data
using the CARIS QC Report Utility. At the completion of MBES data processing, for each
survey, difference surfaces were generated between a surface compiled from
mainscheme/investigation MBES data and a surface compiled only from crossline MBES
data. The results from the difference surface creation and the statistical analyses are
discussed in the descriptive reports for each survey.

As a project wide, data quality assurance measure a surface-to-surface comparison was
performed using coincidental MBES data acquired independently by both vessels while on
the same trackline and as close in time as practical given the differing vessel schedules. The
intention of the comparison was to evaluate vessel-to-vessel depth sounding agreement
independent, to the extent practical, of the influences of using zoned tides. In order to
mitigate the potential for tide related influences, MBES data from one vessel were acquired
within an hour of the other vessel.

In performing the evaluation, mainscheme project data from the R/V Ocean Explorer were
compared to coincidental line data acquired by the R/V Osprey (whose data were used only
for the purposes of the comparison presented herein). The MBES data acquired by the R/V
Osprey for this test are not included with the mainscheme project data. Rather, the R/V
Osprey’s data are included in the MBES Calibration folder along with the Survey H13042
HDCS data. Survey H13042 is the survey area in which the comparison was undertaken.
The R/V Ocean Explorer line used in the comparison is 20170E2581453 7260 and the R/V
Osprey line used in the comparison is 2017SB2581447 7260.

Depths from 1-meter BASE surfaces compiled from the MBES data from each vessel were
compared using the CARIS HIPS Difference Surface function. A histogram of the
differences is shown in Figure 10. Depths from the R/V Ocean Explorer show excellent
agreement with the depths from the R/V Osprey. Depth discrepancies generally equaled 5
centimeters or less with a mean difference of 2 centimeters.
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Vessel to Vessel surface comparision, R/V Ocean Explorer and R/V Osprey
Average : -0.0165 Median :-0.0200 Number of Samples = 11,063
Standard Deviation : 0.0173 Percent within 2 Sigma : 94.76%
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Figure 10. Surface-to-surface difference histogram comparing coincident trackline
depths from the R/V Ocean Explorer with depths from the R/V Osprey.

Detailed line queries were utilized periodically throughout data processing to be certain all
necessary processes were completed and the right corrector files were applied to all the lines.
The line queries were also used to calculate line mileage and were compared to processing
logs to verify line names and be certain that no aborted lines were included in the final data
products.

The standard deviation, depth and uncertainty layers were reviewed to identify possible
systematic errors related to sound speed, tide, and TrueHeave correction or to errors in
system alignment.

Sound speed profiles were plotted by day to visualize the variation over time and space
(Figure 11). Relatively rapid increases or decreases in sound speed in the top few meters of
the water column generally correlated with higher error in the sounding position, as
evidenced by a “smile” or “frown” effect across the MBES swath. Surface sound speed
logged in the raw HYPACK files was extracted and plotted for every line. Relative higher
deviation and more rapid changes in the surface sound speed over a line were also an
indicator of increased sound speed error in sounding correction which was most severe in the
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outer beams (Figure 12). Given the relatively shallow water depths in this project area,
overall, the effect of the sound speed profile shape/severity was less pronounced than it may
have been for a deep water survey. On this project, sound speed was simply not a substantial
negative factor for overall data quality. Even so, lines that exhibited high variability in the
surface sound speed were reviewed in the CUBE surface layers and in Subset Editor for

excessive sound speed error.

Junction comparisons between current and prior hydrographic surveys were accomplished
using the CARIS HIPS difference surface function.

speed in m/s
01504 1508 1512 1516 1520 1524 1528 1532 1536 1540 1544

depth in meters

OE - 2017 - DN 256
02 46 BUTSTZH:&;Nw 18 20 22 24
[ — |
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Figure 11. Plot of sound speed casts from the R/V Ocean Explorer,
September 13, 2017 (DN 256).
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2017-222 UTC 18:00 - 24:00
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Figure 12. R/V Ocean Explorer surface sound speed plot by survey line for August
10,2017 (DN 222) spanning 18:00 to 24:00 UTC.

B.4 Uncertainty and Error Management

Estimates for the uncertainty of all measurements associated with sounding collection, were
gathered from either reported manufacturer system accuracy or from statistics calculated
from multiple measurements of the value in question.

Error is defined as the difference between a measured value and the true, or accepted, value.
Since the true sounding value is not known ahead of time, an accurate error value cannot be
reported with confidence. Uncertainty, not error, is the chosen parameter to quantify
sounding accuracy such that it can be reported in terms of an interval of confidence around
the measured value. The uncertainty associated with a measurement is reported as the
standard deviation (o), or the root mean square deviation, of the value from the mean.

The combined uncertainty value per sounding, or the Total Propagated Uncertainty (TPU),
was calculated using CARIS HIPS. Standard deviation values for vessel offsets, motion,
draft and alignment measurements were entered into the vessel HVF “TPU values” section at
the 1-sigma level. The HVF uncertainty values along with uncertainties associated with tide
and sound speed were used in combination with the sonar model in the DeviceModels.xml
file to assign a total horizontal uncertainty (THU) and total vertical uncertainty (TVU) for
every sounding.
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B4.1 Total Propagated Uncertainty (TPU)

Tables 10 and 11 list the standard deviation and uncertainty estimates used for all
measurements incorporated into the TPU estimates for the Reson 7125 and Reson 8125 echo
soundings.

Table 10
R/V Ocean Explorer Reson 7125 Uncertainty Estimates
Uncertainty Values Included in CARIS HVF Files & Compute TPU Fields
Heading Measurement ¢ (deg) 0.02 XYZ Offset Measurement ¢ (m) 0.015
Heave % Amplitude 5.00 Vessel Speed Measurement ¢ (m/s) 0.530
Heave Measurement ¢ (m) 0.05 Loading Measurement ¢ (m) 0.030
Roll Measurement ¢ (deg) 0.02 Draft Measurement ¢ (m) 0.030
Pitch Measurement ¢ (deg) 0.02 Delta Draft Measurement ¢ (m) 0.030
Navigation Measurement ¢ (m) 1.00 MRU Align StdDev Gyro (deg) 0.10
Transducer Timing o (sec) 0.01 MRU Align StdDev Roll/Pitch (deg) 0.10
Navigation Timing ¢ (sec) 0.01

Gyro Timing o (sec) 0.01 Tide Measurement ¢ (m) 0.01
Heave Timing o (sec) 0.01 Tide Zoning Vertical Uncertainty (m) 0.19
Pitch Timing o (sec) 0.01 Sound Speed Error Measured (m/s) 1.00

Roll Timing & (sec) 0.01 Sound Speed Error Surface (m/s) 2.00

Table 11
R/V Osprey Reson 8125 Uncertainty Estimates
Uncertainty Values Included in CARIS HVF Files & Compute TPU Fields
Heading Measurement ¢ (deg) 0.02 XYZ Offset Measurement ¢ (m) 0.015
Heave % Amplitude 5.00 Vessel Speed Measurement ¢ (m/s) 0.530
Heave Measurement ¢ (m) 0.05 Loading Measurement ¢ (m) 0.030
Roll Measurement ¢ (deg) 0.02 Draft Measurement ¢ (m) 0.030
Pitch Measurement ¢ (deg) 0.02 Delta Draft Measurement ¢ (m) 0.010
Navigation Measurement ¢ (m) 1.00 MRU Align StdDev Gyro (deg) 0.10
Transducer Timing ¢ (sec) 0.01 MRU Align StdDev Roll/Pitch (deg) 0.10
Navigation Timing ¢ (sec) 0.01

Gyro Timing o (sec) 0.01 Tide Measurement ¢ (m) 0.01
Heave Timing o (sec) 0.01 Tide Zoning Vertical Uncertainty (m) 0.19
Pitch Timing o (sec) 0.01 Sound Speed Error Measured (m/s) 4.00

Roll Timing o (sec) 0.01 Sound Speed Error Surface (m/s) 2.00
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The POS MV 320 manufacturer recommended uncertainty values for the heading, heave,
roll, pitch and timing measurements were entered in the HVFs.

The standard deviation values for the XYZ Offset and static draft measurements were
calculated from distances acquired with the coarsest tool used to verify vessel offsets, the
steel tape.

For the R/V Ocean Explorer, standard deviation for the loading measurement was calculated
from the measure down values acquired on the port and starboard sides as well as pressure
gauge-derived static draft values measured during the daily changeover. For the R/V Osprey
the standard deviation for the loading measurement was calculated from the measure down
values acquired on the starboard side.

The uncertainty for the delta draft was established by calculating the standard deviation of
the differences between settlement values of reciprocal runs per each vessel speed tested.
The settlement curve is included in DAPR Appendix 1.

The MRU Alignment standard deviation values were calculated from the bias values
estimated by multiple hydrographers who had individually processed the patch test data.

The combined tide measurement and zoning uncertainty was provided by CO-OPS in the
Tides SOW.

Sound speed TPU values were estimated from manufacturer accuracy of the ODIM MVP30
and AML Micro-X and from guidance in the OCS Field Procedures Manual (FPM)
Appendix 4 under CARIS HVF Uncertainty Values. The R/V Ocean Explorer’s MVP was
deployed for a cast at a frequency of <15 minutes and the R/V Osprey’s AML Base-X was
deployed at a frequency of < 2 hours. As such a sound speed profile uncertainty value of 1
m/s and 4 m/s was chosen for the measured sound speed of the R/V Ocean Explorer and the
R/V Osprey respectively. A conservative value of 2 m/s was chosen for the sound speed
surface uncertainty despite the fact that the surface and near surface sound speed profile
gradient was relatively uniform throughout the period of the survey.

C. CORRECTIONS TO ECHO SOUNDINGS
C.1 Vessel Configuration and Offsets
C.1.1 Description of Correctors

Vessel configuration parameters and offsets are measures of the location of the integrated
survey systems in respect to an established vessel Reference Point (RP) that serves as XYZ
point 0, 0, 0 within each vessel’s reference frame. The RP on the R/V Ocean Explorer was
the phase center or “bullseye” of the POS MV IMU. The RP on the R/V Osprey was located
at the X, Y position of the POS MV bullseye, but, at the base of the POS MV IMU rather
than the top of the IMU where the bullseye is located. The measured offsets included the
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distance between the MBES transducer phase center to the RP, the distances between the
GPS antenna phase centers and the RP, and the distance from the fixed mount SSS to the RP.

C.1.2 Methods and Procedures

As mentioned earlier an optical total station was used to complete a full survey of the R/V
Ocean Explorer on May 6, 2015 prior to mobilizing Project OPR-J377-KR-15. Since the
2015 total station survey only one change was made to the physical configuration of the
vessel. Near the location of the POS MV antennas the boat was fitted with new spot lights.
As a result the POS MV antennas were raised 2.0 feet (0.610 meters) in order to escape the
GPS signal shadowing effects of the new hardware. This year-to-year change is reflected in
the table below. However, since the antenna offsets are entered directly into the POS MV
controller software the change is not reflected in any HVF. The offsets on the R/V Osprey
were also established with an optical total station survey. The R/V Osprey’s total station
survey was completed on July 27, 2017.

Onboard the R/V Ocean Explorer and the R/V Osprey the respective POS MV IMU was
mounted on a permanent plate close to the vessel’s center of rotation (Figure 13 and Figure
14). The total station was used to measure the offsets from the IMU bullseye or RP to the
POS MV GPS port and starboard antenna mounts, the Trimble DGPS antenna mount, and
multiple port/starboard reference points including the draft measurement point(s). When the
multibeam/fixed mount SSS pole(s) mount were fully deployed, the offsets between the
MBES and fixed mount SSS transducers were related to the respective vessel’s RPs via
repeated measurement between the transducers and the starboard side reference points
mentioned above. These measurements were made using a steel tape measure. The MBES
and fixed mount SSS transducers are located directly below conveniently situated starboard
side reference points allowing for an unobstructed measurement paths.

On both vessels the IMU and transducer mounting hardware were co-aligned employing a
gyrocompass.

C.13 Vessel Offset Correctors

Instrument offsets input to the respective CARIS vessel configuration files are included in
Table 12 and Table 13 below. Systems layout schematics for both vessels are presented in
Figure 13 and Figure 14 respectively.
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Table 12
R/V Ocean Explorer Sensor Offsets

R/V Ocean Explorer Offsets via Topcon

Total Station Survey or Measured Relative Forward | Starboard UP UP
to Permanent Shipboard Benchmarks. Positive | Positive Positive Positive
Offsets are relative to Reference Point (RP) (m) (m) w.r.tRP W.r.t.
or Waterline (m) waterline (m)
RP =IMU Bullseye 0,0,0 0.000 0.000 0.000 -0.480
POS MV GPS Antenna Phase Center Port 4.900 -1.200 6.339 5.859
POS MV GPS Antenna Phase Center Starboard 4.883 1.239 6.333 5.853
Positioning Integrity Comparison GPS Antenna 2713 0.948 7972 7492
Phase Center
7125 Transducer Phase Center 0.629 2.870 -1.423 -1.903
Fixed Mount SSS (EdgeTech 4125) 1.139 2.870 -1.016 -1.496
Starboard Side Draft Measurement Point -0.325 2.542 1.975 1.495
Port Side Draft Measurement Point -0.329 -2.494 1.979 1.499
Table 13
R/V Osprey Sensor Offsets
R/V Osprey Offsets via Topcon Total Station U U
i Forward | Starboard P P
Survey or Measured Relative to Permanent We v0 Positive Positive
Shipboard Benchmarks. Offsets are relative | Positive Positive w.r.t RP W.rt.
to Reference Point (RP) or Waterline (m) (m) (m) waterline (m)
RP = Base of IMU at bullseye X,Y 0,0,0 0.000 0.000 0.000 0.034
POS MV GPS Antenna Phase Center Port 0.991 -0.748 2.150 2.184
POS MV GPS Antenna Phase Center Starboard 1.015 0.750 2.160 2.194

Positioning Integrity Comparison GPS Antenna

Phase Center -0.311 0.170 3.459 3.493
8125 Transducer Phase Center -0.830 1.516 -0.884 -0.850
Fixed Mount SSS (EdgeTech 4125) -2.979 1.516 -0.948 -0.914
Starboard Side Draft Measurement Point -0.782 1.324 0.927 0.961
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R/V Ocean Explorer Systems Layout

o Reference Point
IMU Center
POS-MV Antenna
GPS Antenna
e 7125 Transducer Phase Ctr.
e Fixed Mount SSS
e Draft Observation Pt.
® MVP Sheave

Figure 13. R/V Ocean Explorer systems layout.
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R/V Osprey Systems Layout

o Reference Point
IMU Center
» POS-MV Antenna
| GPS Antenna
| e 8125 Transducer Phase Ctr.

e e Fixed Mount SSS
®

e Draft Observation Pt.

Figure 14. R/V Osprey systems layout.
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C.l4 SSS Positioning
C.1.4.1  Fixed Mount Configuration

The respective vessel’s SSS were operated exclusively in a rigid, fixed-mount configuration,
i.e. no towed SSS imagery was collected on this project. Positioning was accomplished in
real-time using HYPACK SURVEY configured using the generic offset device
(genoffset.dll). HYPACK SURVEY transmitted fish position to the SSS acquisition
software package, Discover, based upon the fixed physical offsets of the EdgeTech 4125 SSS
relative to each vessel’s steering point which is turn was related to each vessel’s RP. The
Discover software also recorded vessel heading (analogous with fish heading) which was
supplied to the software via a direct serial connection to the POS MV.

As mentioned earlier, a utility developed by OSI was used to extract high rate position and
heading data from the raw POSPac files. This information was used in recalculating fixed-
mount side scan sonar fish position. The practice of recalculating fish position using high
rate position data via the CARIS Generic Data Parser utility results in image mosaics that
have far less pixel stretching artifacts than realized using the relatively slow update rate
positioning/heading recorded with the Discover software in real time. Recalculating fish
position in CARIS SIPS required that a non-zero vessel file was used, i.e. a vessel file
containing the starboard and forward offsets of the fixed mount towfish relative to the vessel
RP.

Positioning accuracy of the fixed mount system was verified prior to commencing survey
operations by comparing the position of a known feature (position determined using MBES
data) to the same feature positions as recorded in multiple SSS passes. The multiple SSS
passes were collected at varying distances from the feature to confirm overall system
accuracy. As mentioned previously, each vessel’s SSS was operated only at the 50 meter
range scale. Test results are presented in DAPR Appendix II.

C2 Static and Dynamic Draft
C.2.1 Static Draft
C.2.1.1  Description of Correctors

Static draft is the vertical distance of the echosounder transducer below the water line and is
added to the observed soundings during data processing in CARIS HIPS. The vertical offset
between the transducer phase center and the RP was entered into the HVF Swath 1, Z-value
field. For the R/V Ocean Explorer the vertical offset to account for the distance from the RP
to the water surface was updated once a day into the Waterline Height field in the HVF. On
the R/V Osprey this value was often updated twice per day, dockside before and after daily
operations. The Z-value and the waterline corrector added together equaled the static draft of
the echosounder transducer phase center.

-71 - Data Acquisition and Processing Report



OPR-K354-KR-17 OCEAN SURVEYS, INC.

C21.2 Methods and Procedures

Onboard the R/V Ocean Explorer static draft measurements were taken during mobilization,
prior to the start of the survey (July 14, 2017, DN 195), and periodically throughout the term
of the survey. Direct measurements or “measure downs” from the water surface to both the
starboard and port draft observation point “benchmarks” were made employing a steel tape
measure. The waterline height above the RP was determined by averaging the differences
obtained from subtracting the measured distances from the water surface to the benchmarks
from the known vertical offsets between the RP and the benchmarks. Minor variations in
vessel attitude were negated as the final measured waterline height value is an average of the
port and starboard measured values.

For the R/V Ocean Explorer a GE/Druck pressure sensor (water level gauge) was installed
within the transducer pole providing an alternate method to monitor the change in static draft
due to changes in vessel loading. The pressure sensor was installed at a fixed elevation
within the transducer pole. The transducer mounting flange at the bottom of the transducer
pole was fitted with a small diameter copper orifice making the transducer pole, in effect, a
stilling well. The pressure sensor depth below the water surface was calibrated prior to the
start of survey to determine its vertical offset constant in reference to the RP. When the
vessel was at a full stop for the daily “UTC midnight” changeover, the pressure sensor water
level data were logged for 5-10 minutes using HYPACK SURVEY. The water level values
were extracted from the raw HYPACK file and averaged to obtain the depth of the pressure
sensor below the water line. The waterline height was calculated by subtracting the vertical
offset between the pressure sensor and the RP from the pressure sensor average depth. Once
the measure down-to-pressure sensor corrector constant was established (and subsequently
confirmed with later measurements) the pressure sensor gauge water level determination
method was used almost exclusively for static draft measurements offshore as the sea state
made measure downs impractical when the vessel was offshore.

When offshore on the R/V Ocean Explorer the waterline height measurement was calculated
daily using the pressure sensor water level gauge method and measure down values were
acquired only when the vessel was offshore during calm conditions. Given that the vessel’s
operations dock was located well into the Intracoastal Waterway (in fresh water) the
dockside measure down values were not included in the HVF for fear that these values would
be biased due to the difference in water density between the fresh water dockside location
and the salt water environment of both the survey area and the pressure sensor constant
determination location. The min/max range of waterline height measurements for the R/V
Ocean Explorer was less than 7 cm for the period of the survey.

Onboard the R/V Osprey waterline height measurements were completed each day before and
after operations and/or before and after daily fueling. In practice the vessel trim was adjusted
before each measurement such that the roll value, as displayed on the MV POS View
software, read nominally zero. At this point, using a steel tape measure, the physical
measurement from the starboard side reference point to the water surface was recorded. The
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min/max range of waterline height measurements for the R/V Osprey was less than 3 cm for
the period of the survey.

The waterline height measurement was corrected to the vessel reference point and recorded
in the respective acquisition logs. Waterline height values calculated from physical
measurement, “measure downs,” or the pressure sensor gauge data, were time stamped and
entered into the CARIS vessel configuration file. In CARIS HIPS, the time stamped
waterline height correctors were added to the Z-value vertical offset between the RP and the
transducer phase center to obtain each vessel’s echosounder static draft.

C22 Dynamic Draft
C.2.2.1  Description of Correctors

Dynamic draft correctors account for the vertical displacement of the transducer when a
vessel is underway in relation to its position at rest.

C222 Methods and Procedures

Dynamic draft on the R/V Ocean Explorer was measured on July 19, 2017 (DN 200) with the
vessel configured for data acquisition with an average loading weight and vessel trim.
Calibration test lines were acquired in water with a nominal depth of 6-20 meters; the sea-
state was calm during collection. Data were acquired along tracklines nominally 1,000 to
4,000 meters long at regular intervals of speed, beginning with the engines at various “troll”
settings and increasing by 100 RPMs until the maximum practical survey speed was
surpassed. During testing reciprocal line pairs were acquired at each RPM setting to average
out the effect of any current present. Tidal variations were accounted for by recording a
“drift line” with the vessel at rest at the beginning and end of each test line run at speed.
Lines, at speed or at rest, were only logged after the vessel speed leveled out or stabilized to a
steady state. The data were collected with the POS MV in RTK mode using a base station
approximately three miles away. However, the real time RTK solution was abandoned in
favor of a seemingly more stable single base IAPPK solution. The test was conducted in the
vicinity of the vessel’s home port in Noank, CT which is the location the vessel was
mobilized and from where initial calibrations were staged.

Dynamic draft on the R/V Osprey was measured on August 18, 2017 (DN 230) with the
vessel configured for data acquisition with an average loading weight and vessel trim.
Calibration test lines were acquired in water with a nominal depth of 3-9 meters; the sea-state
was calm during collection. Data were acquired along tracklines nominally 200 to 1,200
meters long at regular intervals of speed, beginning with the engines at various “clutch
ahead” and increasing RPMs to various thresholds until the maximum practical survey speed
was surpassed. During testing reciprocal line pairs were acquired at each RPM setting to
average out the effect of current. Tidal variations were accounted for by recording a “drift
line” with the vessel at rest at the beginning and end of each test line run at speed. Lines, at
speed or at rest, were only logged after the vessel speed leveled out or stabilized to a steady
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state. The data were collected with the POS MV in DGPS mode. Vertical values were
derived employing a single base IAPPK solution. The test was conducted in the vicinity of
the vessel’s home port in Old Saybrook, CT which is the location the vessel was mobilized
and from where initial calibrations were staged.

Table 14 and Table 16 summarize the as-measured settlement test results for the R/V Ocean
Explorer and R/V Osprey respectively. In populating the CARIS HVF draft table, the
settlement curves generated using the values shown in Tables 14&16 were smoothed and
densified using a 4™ Order polynomial curve fit in EXCEL. Settlement values entered into
the CARIS HVFs were taken from the smooth curve at regular speed intervals. These values
are shown in Table 15 and Table 17.

Between Survey OPR-J377-KR-15 and Survey OPR-K354-KR-16 the propellers were
changed on the R/V Ocean Explorer. The “new” propellers had a different diameter and
pitch. There was a minor but noticeable difference in the settlement curve at higher speeds
between the 2015 and 2016 field seasons. Prior to mobilizing the vessel for the 2017 field
season the “original” propellers were reinstalled on the R/V Ocean Explorer. It follows then
that the contemporary settlement test results differ slightly from the 2016 test results and are
more in keeping with the 2015 results.

C223 Dynamic Draft Correctors R/V Ocean Explorer

Table 14
R/V Ocean Explorer As-Measured Dynamic Draft Correctors
RPM Speed Dynamic Draft
Both Engines M/S Knots Meters
Static 0 0 0
Troll Setting 1 1.47 2.86 -0.003*
Troll Setting 2 1.60 3.10 -0.007
Troll Setting 3 1.91 3.72 -0.009
Troll Setting 4 2.38 4.63 -0.011
600 3.61 7.02 -0.045
700 4.12 8.01 -0.062
800 4.54 8.84 -0.091
900 5.18 10.07 -0.149

*Negative value indicates the boat is settling. CARIS correctors are the opposite sign.
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Table 15

R/V Ocean Explorer - Polynomial Curve Fit Dynamic Draft Correctors
As entered into CARIS HVFs

Speed Dynamic
Draft Meters

M/S Knots

1.03 2.00 0.001
1.29 2.50 0.003
1.54 3.00 0.006
1.80 3.50 0.009
2.06 4.00 0.013
2.31 4.50 0.016
2.57 5.00 0.020
2.83 5.50 0.025
3.08 6.00 0.030
3.34 6.50 0.036
3.60 7.00 0.044
3.86 7.50 0.053
4.11 8.00 0.065
4.37 8.50 0.079
4.63 9.00 0.097
4.88 9.50 0.119
5.14 10.00 0.146

C.2.24  Dynamic Draft Correctors R/V Osprey

Table 16

R/V Osprey As-Measured Dynamic Draft Correctors

RPM Speed Dynamic Draft
Both Engines M/S Knots Meters
600 0.93 1.82 -0.001*
1,000 1.64 3.19 -0.010
1,500 2.67 5.19 -0.035
2,000 341 6.64 -0.050
2,500 3.99 7.76 -0.040
3,000 4.30 8.37 -0.030
3,400 4.69 9.12 -0.010

*Negative value indicates the boat is settling. CARIS correctors are the opposite sign.
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Table 17

R/V Osprey - Polynomial Curve Fit Dynamic Draft Correctors
As entered into CARIS HVFs

Speed Dynamic
Draft Meters

M/S Knots

1.03 2.00 0.000
1.29 2.50 0.004
1.54 3.00 0.009
1.80 3.50 0.015
2.06 4.00 0.021
2.31 4.50 0.027
2.57 5.00 0.033
2.83 5.50 0.039
3.08 6.00 0.043
3.34 6.50 0.046
3.60 7.00 0.046
3.86 7.50 0.044
3.98 7.75 0.042
4.11 8.00 0.038
4.24 8.25 0.034
4.37 8.50 0.028
4.50 8.75 0.021
4.63 9.00 0.013
4.75 9.25 0.004

C3 System Alignment
C3.1 Description of Correctors

A multibeam sonar calibration was completed to determine residual navigation timing error
and angular biases in roll, pitch, and heading in the echosounder transducer alignment.

C32 Methods and Procedures

Prior to commencement of survey operations, a sensor alignment or patch test was performed
for each vessel. The initial patch test of record for the R/V Ocean Explorer was performed in
Fishers Island Sound off Noank, CT on July 17, 2017 (DN 198). The Noank, CT area patch
test area was chosen given the anticipated paucity of suitable patch test areas within the
project area. As mentioned earlier, none of the survey systems were removed from the R/V
Ocean Explorer between mobilization in Connecticut and the end of data acquisition. The
initial patch test of record for the R/V Osprey was performed in southern Vermillion Bay, LA
(Southwest Pass) on August 24, 2017 (DN 236). Data were acquired in accordance with
HSSD April 2017 Section 5.2.4.1.
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On the R/V Ocean Explorer, throughout the course of the survey the multibeam pole was
occasionally recovered (pivoted out of the water for transit and docking). On the R/V Osprey
the multibeam pole was deployed and recovered each day for transit. For both vessels, if the
pole was moved, an abbreviated patch test was performed. On the R/V Ocean Explorer,
despite the unlikely possibility that the multibeam pole would move during 24-hour
operations, as a conservative measure, an abbreviated patch test was performed daily whether
or not the pole was recovered and redeployed.

For the “interim” or abbreviated daily patch tests reciprocal multibeam data were collected
on a short set of lines at a convenient time each day and processed onboard to confirm
system stability. In all cases results of interim roll testing indicated that the respective
multibeam poles were stable.

For both vessels the full suite of patch testing, i.e. verification patch testing, was performed
at the completion of the project on October 12, 2017 (DN 285). As mentioned above, close
out test results were in keeping with the pre-survey results. Patch test results of record are
presented in DAPR Appendix II.

For the R/V Ocean Explorer pre-survey patch test calibrations were accomplished employing
RTK GPS positioning. For the R/V Osprey pre-survey patch test calibrations were
accomplished employing real-time DGPS positioning but processing of this vessel’s patch
test was accomplished employing IAPPK SBET positions. All interim roll check lines were
acquired with the POS MV in DGPS mode.

For each full suite patch test, test lines were run multiple times to ensure system
repeatability. Patch test biases were determined in the following order: navigation timing
error (latency), pitch, roll, and heading. The CARIS HIPS Calibration Tool (Figure 15) was
primarily used to determine offset values. All patch test values were verified with the
HYPACK HYSWEEP patch test routine (Figure 16).

Subset Contrel of

Catn

Figure 15. CARIS HIPS Calibration Tool.
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Figure 16. HYPACK HYSWEEP Patch Test Utility.

For each parameter, multiple processing iterations were performed by multiple
hydrographers. The final offset values for each vessel file (HVF) are an average of the
CARIS-derived values. The final applied values, entered into the respective CARIS vessel
files, are shown in Table 18 and Table 19 respectively. The patch test results were of high
quality and repeatability.

The initial performance test of record on the R/V Ocean Explorer was performed south of the
Freshwater Bayou Canal Lock on August 3, 2017 (DN 215). The initial performance test of
record for the R/V Osprey was performed in southern Vermillion Bay, LA (Southwest Pass)
on August 24, 2017 (DN 236).

Verification performance testing was performed by both vessels at the completion of the
project on October 12, 2017 (DN 285). As mentioned above, close out test results were in
keeping with the pre-survey results.

In practice a performance surface was created from a high density, near nadir sounding set
collected with the Reson 7125 or Reson 8125. For each vessel’s surface ten MBES lines
were acquired over a relatively flat section of seafloor and processed in CARIS HIPS with
the patch test bias values for timing, pitch, roll and yaw entered into the HVF. A port and
starboard beam filter of 45 degrees was applied to the performance surface lines and a 1 m x
I m Uncertainty Surface was generated from the processed soundings. Two performance
check lines that were run perpendicular across the center of the surface were processed in
CARIS HIPS as well; however, no beam filter was applied. The CARIS HIPS QC Report
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Utility was used to compare the beams of each performance check line to the performance
surface to verify system accuracy. Performance test results of record are presented in DAPR
Appendix IL

C33 System Alignment Correctors
Table 18
R/V Ocean Explorer MBES Patch Test Alignment Correctors
CARIS Patch Test Results
Latency 0.00 sec
Pitch 0.00°
Roll -0.29°
Yaw (heading) 0.32°
Table 19
R/V Osprey MBES Patch Test Alignment Correctors
CARIS Patch Test Results
Latency 0.00 sec
Pitch -1.30°
Roll 0.91°
Yaw (heading) -0.38°
C4 Positioning and Attitude
C4.1 Description of Correctors

DGPS correctors received from the USCG are used to improve positioning accuracy as
compared to operation in stand-alone GPS mode. Attitude corrections measured at the vessel
RP are applied to soundings to correct for vessel motion.

C.4.2 Methods and Procedures
An Applanix POS MV 320 V.4 or V.5 was employed for motion, heading, and position

determination on the R/V Ocean Explorer and R/V Osprey respectively. Manufacturer’s
stated accuracy values, for DGPS mode operation, are tabulated below.
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Table 20
POS MYV Specifications
POS MV 320 V.4 and V.5 Manufacturer’s
Specifications
Parameter Accuracy
Roll 0.02°
Pitch 0.02°
Heave 5 cm or 5% of wave height
Heading 0.02°

For each vessel prior to calibration of the POS MV, lever arm distances, mounting angles and
the separation distance between the port and starboard GPS antennas were entered in the
controller software. The heading accuracy threshold was set to 0.5 degrees. A GAMS
calibration was run after the heading accuracy had dropped below the 0.5 degrees threshold,
keeping a straight course until the calibration was completed. See DAPR Appendix III,
Positioning and Attitude System Reports for additional information on the POS MV
configuration and calibration.

C.S5 Tides and Water Levels
C5.1 Description of Correctors

Tide correctors are applied to reduce the soundings to the Mean Lower Low Water (MLLW)
datum.

C52 Methods and Procedures

The water level station LAWMA, LA (876-4227), is the reference station for predicted,
preliminary observed, and verified tides for all hydrography for this project. The time and
range ratio correctors for applicable zones were applied to all tide correctors in CARIS HIPS
during the preliminary and final processing phases of this project. Predicted and preliminary
observed zoned tides were applied to sounding data for preliminary processing. Verified tide
data were downloaded from NOAA CO-OPS and applied with final zoning for all final
soundings and BASE surfaces.

As mentioned previously, preliminary zoning provided by CO-OPS (with the OSI vertex
edit) was retained and used as final zoning.

C.6 Sound Speed

Observed depth is a function of the speed of sound in the water column, such that depth is
equivalent to the sound speed multiplied by the travel time of the sound pulse from transmit
to receive divided by 2. Sound speed is not a constant and varies temporally and spatially,
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affected by changes in temperature, salinity and depth. Sound speed profiles are acquired to
model the speed of sound versus depth within a survey site. Improper sound speed correction
can result in inaccurate depth values and sounding positions. The sound speed correctors
from the profiles are applied to soundings to override the assumed sound speed value used
during acquisition and to calculate the depth using the actual sound speed measured in the
survey site for a defined space and time.

C.6.1 Sound Speed Profiles

Aboard the R/V Ocean Explorer the sound speed profiles used to correct the echo soundings
were exclusively acquired with an ODIM MVP30 equipped with two sensors: a sensor that
measured sound speed directly at a frequency of 10Hz during its descent through the water
column and a pressure sensor for profile depth measurement. Due to a mid-project depth
sensor failure in the primary MVP sensor package, two sensor packages were employed
during the course of the project. The MVP sensors (sound speed and depth) used during
mobilization testing, during the initial alignment and settlement testing of record, and during
the beginning of the project were manufacturer calibrated July 13, 2017 (DN 194) and July
17, 2017 (DN 198). The MVP sensors that were used toward the end of the project were
calibrated on July 26, 2017 (DN 207), July 31, 2017 (DN 212), and August 2, 2017 (DN
214).

On the R/V Osprey the sound speed profiles used to correct the echo soundings were
exclusively acquired with an AML Oceanographic Base-X profiler. The sound speed and
pressure sensors on the Base-X profiler were manufacturer calibrated on July 13, 2017 (DN
194) and July 17, 2017 (DN 198).

Calibration reports are included in DAPR Appendix IV.

Sound speed profile correctors were applied in CARIS HIPS using the Sound Velocity
Correction process, which employs a ray tracing algorithm to simulate refraction. The
Nearest in Distance Within Time (2-hour) profile selection method was used to determine
which cast was applied to the soundings. This method was selected to limit the effects of
spatial and temporal variation in sound speed.

C.6.2 Surface Sound Speed

On the R/V Ocean Explorer, surface sound speed correctors were sent directly from the AML
Micro-X sensor to the Reson 7125 TPU. On the R/V Osprey, a Sea-Bird Electronics SBE-37
supplied the Reson 8125 with surface sound speed correctors. The R/V Ocean Explorer’s
AML Micro-X sound speed sensor was calibrated by the manufacturer on July 13, 2017 (DN
194). The R/V Osprey’s SBE-37 sensor was manufacturer calibrated on May 31, 2017 (DN
151).
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D. APPROVAL SHEET

LETTER OF APPROVAL

REGISTRY NOS.
H13040, H13041, H13042, AND H13043

This report and the accompanying data are respectfully submitted.

Field operations contributing to the accomplishment of Surveys H13040, H13041, H13042,
and H13043 were conducted under my direct supervision with frequent personal checks of
progress and adequacy. This report and associated data have been closely reviewed and are
considered complete and adequate as per the Statement of Work.

Digitally signed by George G.
Reynolds
Date: 2018.01.19 10:49:35 -05'00'

George G. Reynolds
Ocean Surveys, Inc.
Chief of Party
January 19, 2018
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R/V Ocean Explorer Systems Layout

o Reference Point
IMU Center
POS-MV Antenna
GPS Antenna
e 7125 Transducer Phase Citr.
e Fixed Mount SSS
e Draft Observation Pt.
MVP Sheave

R/V Ocean Explorer Offsets via Topcon

Total Station Survey or Measured Relative Forward | Starboard l'l{ Up

to Permanent Shipboard Benchmarks. Positive | Positive Positive Positive
Offsets are relative to Reference Point (RP) (m) (m) w.r.tRP w.F.t.

or Waterline (m) waterline (m)
RP = IMU Bullseye 0.0.0 0.000 0.000 0.000 -0.480
POS MV GPS Antenna Phase Center Port 4.900 -1.200 6.339 5.859
POS MV GPS Antenna Phase Center Starboard 4.883 1.239 6.333 5.853

Positioning Integrity Comparison GPS Antenna

. Pl Ceaitos 2.713 0.948 7.972 7.492
7125 Transducer Phase Center 0.629 2.870 -1.423 -1.903
Fixed Mount SSS (EdgeTech 4125) 1.139 2.870 -1.016 -1.496
Starboard Side Draft Measurement Point -0.325 2.542 1.975 1.495
Port Side Draft Measurement Point -0.329 -2.494 1.979 1.499

Figure 1: R/V Ocean Explorer vessel offsets.
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R/V Osprey Systems Layout

o Reference Point
IMU Center
POS-MV Antenna
GPS Antenna
! e 8125 Transducer Phase Ctr.

@ e Fixed Mount SSS

e Draft Observation Pt.

N |

R/V Osprey Offsets via Topcon Total Station Up Up
| Survey or Measured Relative to Permanent F“n_";“d Slart.m.ard Positire Positive
Shipboard Benchmarks. Offsets are relative | Positive | Positive WrtRP ik
to Reference Point (RP) or Waterline (m) (m) m) waterline (m)
Py RP =Base of IMU at bullseye XY 0,00 0.000 0.000 0.000 0.034
I POS MV GPS Antenna Phase Center Port 0991 -0.748 2150 2184
| J POS MV GPS Antenna Phase Center Starboard | 1.013 0.750 2160 2194
Postttomng Integrity Commparison GPS Antenna 0311 0170 1459 1493
| Phase Center
8125 Transducer Phase Center -0.830 1.516 -0.884 -0.850
Fixed Mount $88 (EdgeTech 4125) -2879 1.516 -0.848 0.914
Starboard Side Draft Measurement Potnt 0782 1324 0927 0.961

Figure 2: R/V Osprey vessel offsets.
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Figure 3. Plot of as-measured dynamic draft values and polynomial curve fit derived from July
19, 2017 (DN 200) Settlement Test.
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Table 1

Negative value indicates the boat is settling.
CARIS correctors are opposite sign.

RPM Speed Dynamic Draft
Both Engines M/S Knots Meters
Static 0 0 0
Troll Setting 1 1.47 2.86 -0.003*
Troll Setting 2 1.60 3.10 -0.007
Troll Setting 3 1.91 3.72 -0.009
Troll Setting 4 2.38 4.63 -0.011
600 3.61 7.02 -0.045
700 4.12 8.01 -0.062
800 4.54 8.84 -0.091
900 5.18 10.07 -0.149

Table 2

As entered into CARIS HVFs

Speed Dynamic Draft
M/S Knots Meters
1.03 2.00 0.001
1.29 2.50 0.003
1.54 3.00 0.006
1.80 3.50 0.009
2.06 4.00 0.013
2.31 4.50 0.016
2.57 5.00 0.020
2.83 5.50 0.025
3.08 6.00 0.030
3.34 6.50 0.036
3.60 7.00 0.044
3.86 7.50 0.053
4.11 8.00 0.065
4.37 8.50 0.079
4.63 9.00 0.097
4.88 9.50 0.119
5.14 10.00 0.146

R/V Ocean Explorer As-Measured Dynamic Draft Correctors

R/V Ocean Explorer - Polynomial Curve Fit Dynamic Draft Correctors
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Figure 4. Plot of as-measured dynamic draft values and polynomial curve fit derived from August
18, 2017 (DN 230) Settlement Test.
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Table 3

R/V Osprey As-Measured Dynamic Draft Correctors
Negative value indicates the boat is settling.
CARIS correctors are opposite sign.

RPM Speed Dynamic Draft
Both Engines M/S Knots Meters
600 0.93 1.82 -0.001
1,000 1.64 3.19 -0.010
1,500 2.67 5.19 -0.035
2,000 341 6.64 -0.050
2,500 3.99 7.76 -0.040
3,000 4.30 8.37 -0.030
3,400 4.69 9.12 -0.010

Table 4

R/V Osprey - Polynomial Curve Fit Dynamic Draft Correctors
As entered into CARIS HVFs

Speed Dynamic
IS Kots Draft Meters
1.03 2.00 0.000
1.29 2.50 0.004
1.54 3.00 0.009
1.80 3.50 0.015
2.06 4.00 0.021
2.31 4.50 0.027
2.57 5.00 0.033
2.83 5.50 0.039
3.08 6.00 0.043
3.34 6.50 0.046
3.60 7.00 0.046
3.86 7.50 0.044
3.98 7.75 0.042
4.11 8.00 0.038
4.24 8.25 0.034
4.37 8.50 0.028
450 8.75 0.021
4.63 9.00 0.013
4.75 9.25 0.004
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Table 1

R/V Ocean Explorer
Reson SeaBat 7125 System Accuracy Tests
(Bar Checks - Spot Sounding Checks)
Conducted using Lead Line/Bar Check SN 2010B

Sounding Bar MBES Spot MBES
Date Lat, Long Depth Depth Depth Depth Comments
Systems
(m) (m) (m) (m)
3.00 3.00
4.00 4.00 Vessel Acceptance
July 17, 41180289 N. | Lead Line, 5.00 5.00 9.69 9.74 Bar Check. Fishers
2017 07159 51.39 W | Reson 7125 6.00 6.00 8.95 8.20 Island Sound, Noank,
(DN 198) ' 7.00 7.01 ' ' CT,
8.00 8.00 Calm
9.00 9.00
Freshwater Bayou
Aug 3, 293346.49 N, | Lead Line, 3.00 3.00 Channel Safety
2017 091 1352.91 W | Reson 7125 4.00 4.00 6.00 6.05 Fairway, LA
(DN 215) ' 5.00 5.00 ! '
3 foot swell
3.00 3.00 .
A;glz%l’ 292001.87 N, | LeadLine, | 4.00 4.00 N/A N/A ngg?gf't‘oi:dcig;py
(DN 233) 092 02 01.31 W | Reson 7125 5.00 5.00 for reliable spot check.
6.00 5.99
3.00 3.00 .
SZ%tlz%l’ 200906.67N | LeadLine, | 4.00 200 | wa | o ngg?gf't‘oi:dciggpy
(DN 264) 091 50 34.90 W | Reson 7125 5.00 5.00 for reliable spot check.
6.00 6.00
3.00 3.00
Oct 12 _ 4.00 4.00
2017 ’ 292340.26 N Lead Line, 5.00 5.00 8.47 850 West of H13040.
(DN 285) 092 1919.95W | Reson 7125 6.00 6.00 Calm.
7.00 7.00
8.00 8.00
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Table 2

R/V Ocean Explorer

Lead Line Accuracy Confirmation

Lead Line Bar Check Calibration Report - SN 2010B

Field unit: R/V Ocean Explorer

Date of Calibration: July 15, 2017

steel tape.

Method of Calibration: Plastic Beads were adjusted to account for any
discrepancies between the graduated marking and the steel tape
measurement such that the final lead line graduated marks matched the

Location: OSI

Lead Hydrographer: RMW

Lead Line Bar Check Unit of Measure: Meters

Measured by: RMW Recorded by: GLS Checked by: JRB
Graduated Marking Calibration Measurement Lead Line Corrector
(a) (b) (c=b-a)
1 1.00 0.00
2 2.00 0.00
3 3.00 0.00
4 4.00 0.00
5 5.00 0.00
6 6.00 0.00
7 7.00 0.00
8 8.00 0.00
9 9.00 0.00
10 10.00 0.00
12 12.00 0.00
14 14.00 0.00
16 16.00 0.00
18 17.99 -0.01
20 20.00 0.00
22 22.00 0.00
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Table 3

R/V Osprey
Reson SeaBat 8125 System Accuracy Tests
(Bar Checks - Spot Sounding Checks)
Conducted using Lead Line/Bar Check SN OSI 50-2

Soundin Bar MBES Spot MBES
Date Lat, Long 9 Depth Depth Depth Depth Comments
Systems
(m) (m) (m) (m)
A;gl%?” 29433864 N, | LeadLine, | 1.50 1.50 249 249 Cygﬁ'é?ﬁgﬂap%?ﬁta'L A
(DN 235) | 0915044.02W | Reson8125 | 2,00 2.00 ol
Vermillion Bay,
SePL6, | 29424464N, | LeadLine, | 10 1.50 Cypremort Point, LA,
2017 1 091524772 W | Reson812s | 290 2.00 2.01 2.01 Calm at check
(DN 249) ' 3.00 3.00 e
ocation
Vermillion Bay,
SePL29, | 99424336 N, | LeadLine, | 20 1.50 Cypremort Point, LA,
2017 1 091525744 W | Resong1zs | 290 2.00 3.33 3.32 Calm at check
(DN 272) : 3.00 3.00 e
ocation
1.50 1.50
2.00 2.00
3.00 3.00
4.00 4.00 .
Oct 12 . Vermillion Bay
' | 29370696N | LeadLine, | 5.00 5.00 '
(Df\?gs) 0915946.23W | Reson 8125 |  6.00 600 | 160 | 1159 Soum""‘és;';ass' LA,
7.00 7.00
8.00 8.00
9.00 9.00
10.00 | 10.00
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Table 4
R/V Osprey

Lead Line Accuracy Confirmation

Lead Line Bar Check Calibration Report - SN OSI| 50-2

Field unit: R/V Osprey

Date of Calibration: July 20, 2017

Method of Calibration: This bar check was built and calibrated
immediately prior to mobilization of the survey. Depth bead placement
was accomplished using a steel tape measure.

Location: OSI

Lead Hydrographer: RMW

Lead Line Bar Check Unit of Measure: Meters

Measured by: RMW Recorded by: GLS Checked by: JRB
Graduated Marking Calibration Measurement Lead Line Corrector
(@) (b) (c=b-a)
1 1.00 0.00
15 1.50 0.00
2 2.00 0.00
3 3.00 0.00
4 4.00 0.00
5 5.00 0.00
6 6.00 0.00
7 7.00 0.00
8 8.00 0.00
9 9.00 0.00
10 10.00 0.00
11 11.00 0.00
12 12.00 0.00
13 13.00 0.00
14 14.99 0.00
15 15.00 0.00
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Table 5

R/V Ocean Explorer
Reson Seabat 7125 Pre-Survey Patch Test Results

TEST INFORMATION

Test Date(s) / DN(s): July 17, 20176 (DN 198)

Wind / Seas: S ~10 knots; seas calm

Locality: Noank, CT
Sub-Locality: Fishers Island Sound
Bottom Type: mud (assumed based on chart notation)

Approximate Water Depth: ~21 meters average

TEST RESULTS

Navigation Timing Error: 0.0 seconds

Pitch Timing Error: 0.0 seconds

Roll Timing Error: 0.0 seconds

Pitch Bias: 0.00 degrees

Roll Bias: -0.29 degrees

Heading Bias: 0.32 degrees

Resulting CARIS HIPS HVF File Names: OE_MB_7125 Main.hvf,
OE_MB_7125_Inv.hvf, OE_MB_7125_XL.hvf,

OE_MB_7125_Cal.hvf
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Table 6
R/V Ocean Explorer
EdgeTech 4125 Target Positioning Accuracy Confirmation (Fixed Mount Configuration)

TEST INFORMATION

Test Date(s) / DN(s): July 17, 2017 (DN 198)

Wind / Seas: S ~10 knots; seas calm

Locality: Noank, CT

Sub-Locality: Fishers Island Sound

Description of Bathymetry: generally flat, clean bottom with discrete boulders

Bottom Type: soft with boulders

Approximate Water Depth: 11 meters

Description of Target: discrete feature (boulder)

Target Position: 4,576,786.8 N, 750,662.0 E (UTM 18N, NAD83, Meters)

Description of Positioning Method: RTK-GPS and HYPACK Genoffset.DLL

Approximate Survey Speed: 7 knots

Approximate Towfish Altitude: 10 meters

TEST RESULTS

Number of Passes on Target: six (6)
Successful Target Detections: six (6)
Mean Detected Position: 4,576,787.2 N, 750,661.4 E

Distance from Mean Position to True Position: 0.7 meters

Estimated Target Position Error: 0.48 meter*

Approximate 95% Confidence Radius: 1.9 meters**

*Calculated from the standard deviation of differences between individual SSS detected positions
(using the 50-meter range scale) and the MBES defined position of the discrete feature.

**Per guidance in the FPM, results were obtained by measuring the error for each detection (the
distance from the absolute target position to the detected position) and computing the sample mean
and standard deviation of the errors. The approximate 95% Confidence Radius is then the sample
mean plus 1.96 times the standard deviation.
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Table 7

R/V Osprey
Reson Seabat 8125 Pre-Survey Patch Test Results

TEST INFORMATION

Test Date(s) / DN(s): August 24, 2017 (DN 236)

Wind / Seas: ENE ~20 knots; seas relatively calm in lee of Marsh Island

Locality: Vermillion Bay, LA
Sub-Locality: Southwest Pass
Bottom Type: sandy mud (assumed)

Approximate Water Depth: ~8 meters average

TEST RESULTS

Navigation Timing Error: 0.0 seconds

Pitch Timing Error: 0.0 seconds

Roll Timing Error: 0.0 seconds

Pitch Bias: -1.30 degrees

Roll Bias: 0.91 degrees

Heading Bias: -0.38 degrees

Resulting CARIS HIPS HVF File Names: SB_MB_8125 Main.hvf,
SB_MB_8125_Inv.hvf, SB_MB_8125 XL.hvf,

SB_MB_8125_Cal.hvf
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Table 8
R/V Osprey
EdgeTech 4125 Target Positioning Accuracy Confirmation (Fixed Mount Configuration)

TEST INFORMATION

Test Date(s) / DN(s): August 24, 2017 (DN 236)

Wind / Seas: ENE ~20 knots; seas calm in lee of Marsh Island

Locality: Vermillion Bay, LA

Sub-Locality: Southwest Pass

Description of Bathymetry: shallow side of steep channel edge

Bottom Type: sandy mud (assumed)

Approximate Water Depth: 5 meters

Description of Target: discrete feature (navigation day shape piling)

Target Position: 3,275,631.1 N, 595,966.7 E (UTM 15N, NAD83, Meters)

Description of Positioning Method: DGPS and HYPACK Genoffset.DLL

Approximate Survey Speed: 5 knots

Approximate Towfish Altitude: 8-10 meters (boat is in deeper water than target

TEST RESULTS

Number of Passes on Target: six (6)
Successful Target Detections: six (6)
Mean Detected Position: 3,275,630.6 N, 595,966.9 E

Distance from Mean Position to True Position: 0.5 meters

Estimated Target Position Error: 0.31 meter*

Approximate 95% Confidence Radius: 1.4 meters**

*Calculated from the standard deviation of differences between individual SSS detected positions
(using the 50-meter range scale) and the MBES defined position of the discrete feature.

**Per guidance in the FPM, results were obtained by measuring the error for each detection (the
distance from the absolute target position to the detected position) and computing the sample mean
and standard deviation of the errors. The approximate 95% Confidence Radius is then the sample
mean plus 1.96 times the standard deviation.
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Table 9
R/V Ocean Explorer
Performance Surface Test Results

Performance Reson 7125
Test August 4, 2017
DN 216
* -0.008 to 0.048 meters
** 0.008 to 0.025 meters
IHO Special 0
Order 100 %
IHO Order la 100 %
Table 10
R/V Osprey
Performance Surface Test Results
Performance Reson 8125
Test August 24, 2016
DN 236
* -0.056 to -0.003 meters
** 0.022 to 0.047 meters
IHO Special 0
Order 100 %
IHO Order la 100 %

(*) min/max of the mean differences between each individual beam from the performance check
line v. the 1-meter performance surface.

(**) min/max of the standard deviation of the mean differences between each individual beam
from the performance check line v. the 1-meter performance surface.

9- DAPR - Appendix Il



OPR-K354-KR-17 OCEAN SURVEYS, INC.

DAPR Appendix I

Positioning and Attitude System
Reports

DAPR - Appendix 111



OPR-K354-KR-17

OCEAN SURVEYS, INC.

Table 1

R/V Ocean Explorer Tabulation of Navigation System Performance Checks

Coordinates are referenced to UTM 15N - NAD 83, meters. Navigation checks are made relative
to a temporary control point established at the vessel’s base of operation in Intracoastal City, LA.
The coordinates of the temporary points were established via NGS-OPUS processing. The precise
OPUS solution follows.

SMIC-01 Dock Piling Nail — E 581,615.52, N 3,295,068.34

Observed Observed Calculated Tape Difference
Time Nav. DGPS Easting Northing Distance Measure Calculated
Date UTC Check- Beacon UTM 15N, UTM 15N, RP to Nav. | RP to Nav. vs. Tape
point NADS83 NAD83 Checkpoint | Checkpoint | Measured
(meters) (meters) (meters) (meters) (meters)
08/03/17 . SMIC English
(DN 215) 13:54 Nail | Turn, LA 581,622.2 3,295,069.0 6.7 7.2 0.5
08/03/17 . SMIC | Angleton
(DN 215) 14:00 Nail T 581,623.3 3,295,070.1 7.9 7.2 0.7
08/04/17 . SMIC | English
(DN 216) 5:45 Nail | Turn, LA 581,624.9 3,295,069.9 9.5 8.9 0.6
08/10/17 . SMIC | English
(DN 222) 5:22 Nail | Turn, LA 581,623.1 3,295,068.1 7.6 8.5 0.9
08/16/17 . SMIC | English
(DN 228) 8:12 Nail | Turn, LA 581,625.0 3,295,067.1 9.5 9.1 0.5
08/22/17 . SMIC English
(DN 232) 10:22 Nail | Turn, LA 581,624.1 3,295,066.6 8.7 8.8 0.1
09/01/17 . SMIC English
(DN 242) 0:44 Nail | Turn, LA 581,622.4 3,295,068.2 6.9 7.8 0.9
09/11/17 . SMIC English
(DN 254) 21:11 Nail | Turn, LA 581,623.9 3,295,066.9 8.4 8.9 0.5
09/25/17 . SMIC English
(DN 268) 2:56 Nail | Turn, LA 581,624.3 3,295,065.5 9.3 9.7 0.4
10/10/17 . SMIC English
(DN 283) 9:46 Nail | Turn, LA 581,624.0 3,295,066.5 8.7 9.3 0.7
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Table 2
R/V Osprey Tabulation of Navigation System Performance Checks

Coordinates are referenced to UTM 15N - NAD 83, meters. Navigation checks are made relative
to a temporary control point established at the vessel’s base of operation in Cypremort Point, LA.
The coordinates of the temporary points were established via NGS-OPUS processing. The precise
OPUS solution follows.

CP-01 Dock Piling Nail - E 611,648.92, N 3,289,143.20

Observed Observed Calculated Tape Difference
Time Nav. DGPS Easting Northing Distance Measure Calculated
Date UTC Chgck— Beacon UTM 15N, UTM 15N, RP to Ne}v. RP to Na}v. vs. Tape
point NADS83 NAD83 Checkpoint | Checkpoint | Measured
(meters) (meters) (meters) (meters) (meters)
(0[‘)3,/\12‘;/2167) 7:42 | CP Nail T'i?ﬁ"ihA 611647.3 | 32891354 8.0 6.8 1.2
(0[‘)3,/\12‘;/3167) 23:16 | CP Nail TEUTE"& 6116510 | 3289135.9 7.6 6.8 0.8
(03,/\?2/4147) 12:16 | CP Nail TEUTE"& 611647.6 | 328913538 75 6.8 0.7
(03,/\?2/4157) 11:57 | CP Nail TEUTE"& 611649.9 | 3289137.0 6.3 6.8 05
(03,/\?2/4167) 11:58 | CP Nail TEUTE"& 6116494 | 32891363 6.9 6.8 0.1
(03,/\?‘;/4177) 12:03 | CP Nail TEUTE"& 611648.3 | 3289136.6 6.6 6.8 0.2
(03,/\?52’%) 12:03 | CP Nail T'i?ﬁ"i& 6116485 | 32891359 73 6.8 05
(Og,/\?g%) 12:08 | CP Nail T'i?ﬁ"ihA 6116476 | 32891358 75 6.8 0.7
(0[?,/\?2/5117) 12:03 | CP Nail T'i?ﬁ"ihA 6116463 | 3289137.4 6.4 6.8 0.4
(0[?,/\?3/5127) 12:05 | cP Nail | 19 | 6116491 | 32801357 75 68 07
(0[?,/\112’5147) 16:56 | CP Nail T'i?ﬁ"ihA 6116505 | 3289136.0 7.4 6.8 06
(On o3y | 1203 | opail | F1OW | 61i6a7e | 32801358 75 6.8 07
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Observed Observed Calculated Tape Difference

Time Nav. DGPS Easting Northing Distance Measure Calculated

Date UTC Che_ck- Beacon UTM 15N, UTM 15N, RP to Na}v. RP to Na_lv. vs. Tape

point NAD83 NAD83 Checkpoint | Checkpoint | Measured

(meters) (meters) (meters) (meters) (meters)

(DN ooy | 10:14 | cPnail | L9 | 6116482 | 32801366 6.6 6.8 0.2
(03,/\11‘;/5177) 12:08 | cP Nail | 19 | 6116464 | 32801372 6.6 68 02
(03,/\1152’/51;) 12:07 | CP Nail T'i?ﬁ"ihA 611647.7 | 3289136.1 73 6.8 0.5
(Onsgy | 1212 | opail | THOR | e1i6asa | 32801369 6.3 6.8 05
("gﬁé’ég) 12:08 | CP Nail T'i?ﬁ"ihA 611648.9 | 3289137.0 6.2 6.8 0.6
("gﬁi’éf) 12:09 | CP Nail T'i?ﬁ"ihA 611650.2 | 32891366 6.7 6.8 0.1
{’3{,13’;27) 12:12 | cpNail | 09 | 6116482 | 32801364 6.9 68 0.1
(03,/\122/6137) 12:06 | CP Nail TEUTE"& 6116483 | 3289136.9 6.4 6.8 0.4
(03,/\122/6147) 12:03 | CP Nail TEUTE"& 6116489 | 3289136.9 6.3 6.8 05
?gﬁg@; 12:32 | CP Nail TEUTE"& 611647.3 | 3289136.9 6.6 6.8 0.2
(03,/\122/6167) 12:22 | CP Nail TEUTE"& 6116485 | 32891363 6.9 6.8 0.1
(03,/\122% 12:00 | CP Nail TEUTE"& 6116490 | 32891363 6.9 6.8 0.1
(03,/\122/7107) 12:05 | CP Nail Ti?ﬁ"il 611649.6 | 3289136.6 6.6 6.8 0.2
(ogl/\lz%ll?) 12:17 | CP Nail T'i?ﬁ"ihA 6116488 | 3289136.8 6.4 6.8 0.4
(03,/\123/7127) 12:12 | CP Nail T'i?ﬁ"ihA 611647.4 | 3289136.7 6.7 6.8 0.1
(15()),/\,1%37) 12:00 | CP Nail T'i?ﬁ"ihA 611649.0 | 32891363 6.9 6.8 0.1
g@% 12:05 | CP Nail T'i?ﬁ"ihA 611649.6 | 32891366 6.6 6.8 0.2
-3- DAPR - Appendix 111




OPR-K354-KR-17

OCEAN SURVEYS, INC.

Observed Observed Calculated Tape Difference
Time Nav. DGPS Easting Northing Distance Measure Calculated
Date UTC Check- Beacon UTM 15N, UTM 15N, RP to Nav. | RP to Nav. vs. Tape
point NAD83 NAD83 Checkpoint | Checkpoint | Measured
(meters) (meters) (meters) (meters) (meters)
10/12/17 . . English
(DN 285) 12:17 | CP Nail Turn, LA 611648.8 3289136.8 6.4 6.8 0.4
10/12/17 . . English
(DN 285) 12:12 | CP Nail Turn, LA 611647.4 3289136.7 6.7 6.8 0.1
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R/V Ocean Explorer
POS/MV GAMS Calibration Report
7-17-2017 (DN 198)

POS/MV Calibration Report

Field Unit: Ocean Explorer

SYSTEM INFORMATION
Vessel: Ocean Explorer

Date: 7M17/12017 Dn: 198

Personnel: RMW, JRB

PCS Serial # 3352

IP Address: 11.69.105

POS controller Version (Use Menu Help > About) 7.92

POS Version (Use Menu View > Statistics) MV 320 ver 4
GPS Receivers

Primary Receiver SN: 4834K32758
Secondary Receiver SN: 4384K32790

CALIBRATION AREA

Location: Noank, CT D M S

Approximate Position: Lat 41 19 17
Lon 71 59 31

DGPS Beacon Station: (Used RTK)

Frequency: 293

Satellite Constellation (Use View> GPS Data)

Primary GPS (Port Antenna)

HDOP: 0.752
VDOP: 1.343

Sattelites in Use: 15
2,5,6,912,19,2529,4,5,6,19,20,21

PDOP 2120 (Use View> GAMS Solution)

Note: Secondary GPS satellite constellation and number of satellites were exactly the same as the Primary GPS
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POS/MV CONFIGURATION

Settings
Gams Parameter Setup
User Entries,

(Use Settings > Installation > GAMS Intallation)

Pre-Calibration Baseline Vector

2.421 Two Antenna Separation (m) 0.014 X Component (m)
0.50 Heading Calibration Threshold -2.421 YComponent (m)
0 Heading Correction -0.019 Z Component (m)

Configuration Notes:

POS/MV CALIBRATION

Calibration Procedure:

Start time: 11:08
End time: 11:28
Heading accuracy achieved for calibration:

Calibration Results:
Gams Parameter Setup

POS/MV Post-Calibration Values

(Refer to POS MV V3 Installation and Operation Guide, 4-25)

0.017

(Use Settings > Installation > GAMS Intallation)
Baseline Vector

2.421 Two Antenna Separation (m) 0.009 X Component (m)
0.500 Heading Calibration Threshold -2.421 YComponent (m)
0.000 Heading Correction -0.027 Z Component (m)
GAMS Status Online? X
Save Settings? X

Calibration Notes:

Save POS Settings on PC
File Name: QE_07172017_postcal.

(Use File > Store POS Settings on PC)
nvm
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R/V Osprey
POS/MV GAMS Calibration Report
8-23-2017 (DN 235)

POS/MV Calibration Report

Field Unit: Ocean Surveys

SYSTEM INFORMATION

Vessel: osprey
Date: 8/23/2017 Dn: 235

Personnel: RMW, DJL

PCS Serial # 6415

IP Address: 11.69.10.6

POS controller Version (Use Menu Help > About) 7.92

POS Version (Use Menu View > Statistics) MV 320 ver 5
GPS Receivers
Primary Receiver BD982, SN: 5403C86282
Secondary Receiver BD 982, SN unknown

CALIBRATION AREA

Location: Cypremort Point, LA D M S

Approximate Position: Lat 29 43 38
Lon 91 50 44

DGPS Beacon Station: English Turn, LA

Frequency: 293

Satellite Constellation (Use View> GPS Data)
Primary GPS (Port Antenna)

HDOP: 0.549
VDOP: 0.785

3-DCiA l::; . arsie
GLONASSS
0783 T

1963
18.000
0.213

Sattelites in Use: 17
25,10,13,15,18,20,21,24,29 3 45,17,18,19,14

A
0.000

22:63:41,000000 UTC o, Baiout
8319 saas

PDOP 1.479 (Use View> GAMS Solution)

Note: Secondary GPS satellite constellation and number of satellites were exactly the same as the Primary GPS
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POS/MV CONFIGURATION

Settings
Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)
User Entries, Pre-Calibration Baseline Vector
1.499 Two Antenna Separation (m) 0.01 X Component (m)
0.50 Heading Calibration Threshold -1.499 YComponent (m)
0 Heading Correction -0.028 Z Component (m)

Configuration Notes:

POS/MV CALIBRATION

Calibration Procedure: (Refer to POS MV V3 Installation and Operation Guide, 4-25)

Start time: 22:55

End time: 22:58
Heading accuracy achieved for calibration: 0.023

Calibration Results:

Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)
POS/MV Post-Calibration Values Baseline Vector
1.504 Two Antenna Separation (m) 0.006 X Component (m)
0.50 Heading Calibration Threshold -1.504 YComponent (m)
0 Heading Correction -0.021 Z Component (m)
GAMS Status Online? X
Save Settings? X

Calibration Notes:

Save POS Settings on PC (Use File > Store POS Settings on PC)
File Name: Osprey_Post-GAMS-cal_08232017.nvm
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R/V Ocean Explorer

POS/MV Settings and Configuration

None =

NMEA Outpu
Output Select [ Roll Positive Sense
VEA < ~ Ulﬁ:‘: Rate # Port Up " Starboard Up
c Pitch Positive Sense
& BowUp ¢ StemUp
Talker ID
) - Heave Positive Sense
@ Heave Up " Heave Down
Input Select

Close Apply

Input/Output Ports Set-up X | |Input/Qutput Ports Set-up
(Gl | comz | coms | coms | coms | coms | coms | cows |
Baud Rate Parity Data Bits Stop Bits Flow Control Baud Rate Parity—— Data Bits Stop Bits Flow Control
T @ None ||~ 7gis || @ 1By || None PTG @ None || c7Bits ||& 1B || Nome
 Even © Hardware  Even " Hardware
© 0dd @ 8Bits || C2Bits | | ¢~ ONXOFF © 0dd @ 8Bits | | 2Bits | | ~ XONXOFF
NMEA O NMEA O
Output Select o Roll Positive Sense Output Select i Roll Positive Sense
NMEA S B “% © PotUp  © Starboard Up VER = ~ U% @ PortUp ¢ Starboard Up
1Hz = Pitch Positive Sense 10Hz | Pitch Positive Sense
* Bow Up " Stem Up * Bow Up " Stem Up
Talker ID H Positive S Talker ID H P s
GP - eave Fositive sense - eave Positive Sense
* Heave Up " Heave Down . o j # Heave Up " Heave Down
Input Select Input Select
None hd None -
Close Apply Close Apply
Input/Output Ports Set-up X Input/Qutput Ports Set-up
com1 | comz [COMI3 Jcomus | coms | com1 | comz | com3 €O |coms |
Baud Rate Interface ?‘_amy; Data Bits Stop Bits E\ow Control Baud Rate Interface Parity Data Bits Stop Bits Flow Control
S50 = & RS232 F None | [ o 76its | | @1Bit ® None e @Rspzz || ®Mome |l e || & 18R 2 oz
€ Even . € Hardware € Even 0 Hardware
CRSA2 ||~ gy @88z || € 2Bits || ¢ uoNmOFF OEA | 6 o G 8Bits || C28is || ¢ oumorF
Output Select Output Select | Hinany Outat it
p utput Selec U N T Roll Positive Sense
te Rat v
None e By = r’% & Sensor 1 © PotUp  © Starboard Up
100 Hz i € Sensar 2 Pitch Positive Sense
@ Bow Up " Stem Up
Formula Select
Tss1 - Heave Positive Sense
@ Heave Up ¢ Heave Down
Input Select Base GPS Input: Input Select
Base 1GPS  ~ Input Type CMR or CMR+ - Hone -
Line
(r- Serial ¢ Modem |  [Modam Settings
Close Apply Close Apply
Input/Qutput Ports Set-up 'Y
com1 | com2 | com3 | coms COM |
Baud Rate Parity Data Bits Stop Bits Flow Cantrol
S50 = S MNore || ¢ 7Bt || & 18t  None
€ Even _ © Hardware
£ Odd F8Bis || C280 || xoNKOFF
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Ewvents X

Event 1 | Event 2| Event 3 | Eventtll Event 5 | Event El

Heawve Filter X SLE s Guard Time (msec)
& Positive -
o B
i~ Negative
Heave Bandwidth (sec) |1U_UUU
Damping Ratio |U_TUT ~PPS Out
Polarity ————
* Positive Pulse Pulse Width (msec)
" Megative Pulse 63 =
Close | Apply (" Pass through
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Lever Arms & Mounting Angles

Lever Arms & Mounting Angles l Sensar Mounting I Tags. AutDStﬁH]

Ref. to IMU Target IMU Frame w.rt. Ref. Frame

X(m) |0.000 X(deg)  [1.530 X (m)
Y(m) oooo Yideg) [p100
Z (m) Z (deg) Z(m)

0.000

Ref. to Primary GNSS Lever Arm

0.000

Ref. to Vessel Lever Arm

X (m) 4.833 X (m) 0.000

Yi(m) [1239 Y (m) |o000

Z(m) 6333 Z(m)  Jo.000
Motes: 1. Ref = Reference

2. wrt. = With Respect To
3. Reference Frame and Vessel Frame are co-aligned

Target to Sensing Centre

Y{m) 0031

Resulting Lever Arm

xm) [oo08
Y(m [g035
0130 Z(m) 529

Ref. to Centre of Rotation Lever Arm

-0.008

X (m) 0.000
Y (m) 0.000
Z (m) 0.000

Compute (MU w.rt
Ref. Misalignment

I~ Enable Bare Il

| Close |

Wiew ‘

In Navigation Mode . to change parameters go to Standby Mode |

Lewer Arms & Mounting Angles | Sensorbounting  Tags. AutoStart

Time Tag 1 Time Tag 2
' POS Time ® [F05
" GPS Time
= GPS Time
& UTC Time
& UTC Time " User Time
AutoStart
" Disabled
 Enabled

Lever Arms & Mounting Angles X
Lever Arms & Mounting Angles  Sensor Mounting \Tags, AutDStart}
Ref to Aux. 1 GNSS Lever Arm | | Ref to Aux. 2 GNSS Lever Arm
X(m) o000 X (m) 0.000
Y(m) o.000 Y (m) 0.000
Z{m) o000 Z(m) 0.000
Ref. to Sensor 1 Lever Arm Sensor 1 Frame w.rt. Ref. Frame
X(m) |0.000 X (deg) 0.000
Y(m) Jo.000 Y (deg) 0.000
Z(m  [o.000 Z(deq) 0.000
Ref. to Sensor 2 Lever Arm Sensor 2 Frame w.rt. Ref. Frame
X(m) [0.000 X (deg) 0.000
Y(m) o.000 Y (deg) 0.000
Z{m) o000 Z (deg) 0.000
= | Close | View |
In Mavigation Mode . to change parameters go to Standby Mode |
Lever Arms & Mounting Angles X

Cloze

Wiew

I Mavigation Mode | to change parameters go to Standby Mode |

A1-
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User Parameter Accuracy ﬂ

—RMS Accuracy
Attitude (deg)  [0.050

Heading (deg) |n_uan
Pasition (1) |2.IIIIIIIII
Welocity (m/s) |n_5m

Close Apply
x
Primary GMSS Receiver |Secnndary GNSS Receiverl
Primary GNSS———— GMN3S 1 Port
GMNSS Output Rate Baud Rate
1 Hz R R R |
Parity Data Bits Stop Bits
@ MNone C 7Bits | | & 1Bt
Auto Configuration  Even
% Enabled  odd & 8 Bits 2 Bits
" Disabled
5I

Primary GMSS Receiver Secandary GMSS Receiver |

—secondary GNSS rGNES 2 Port
GNSS Output Rate Baud Rate
1 Hz x| || fesoo |
Farity Data Bits Stop Bits
& Mone £ 7Bits | | 1Bt
rAuta Configuration  Evan
' Enabled  Odd ~ B Bits " 2 Bits
i Disabled

Ok

Apply
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R/V Osprey

POS/MV Settings and Configuration

Input/Output Ports Set-up

com1 |comz | com3 | coma | cows |

Input/Output Ports Set-up

CoM1 |coms | coms | coms |
Baud Rate Parity—— Data Bits Stop Bits Flow Control Baud Rate Parity—— Data Bits Stop Bits Flow Control
9500 =  None ©7Bits || & 1Bit  None P = & None © 7Bits | | & 18it & None
 Even € Hardware © Even " Hardware
© Odd «8Bits || C2Bis ||~ xONXOFF © Odd ©8Bits | 2Bits | | xONXOFF
Output Select Output Select | MEA Output Roll Positive Sense
TSPRDID - T55 Update Rate || [ @ portUp " Starbord Up
lm NVEA - D?INGGK » P‘:HI—LI @ Port Up " Starboard Up
¥ SUTC = Pitch Pasitive Sense
 Bow Up  Stern Up
] $INPPS
Talker ID =
] SINRMC m Heave Positive Sense
CISINGLL v # Heave Up  © Heave Down
Input Select Base GPS Input Input Select
Base 1GPS »| | InputType  [RTCM1or@ ~| Datum [nADE3 | [None -]
Line
« Serial  Modem Maderm Settings
Close Apply Close Apply

nput/Output Ports Set-up

COM1 | com2 om4 | coms | com1 | comz | com3 O coms |
Baud Rate Interfa Parity Data Bits Stop Bits Flow Control Baud Rate Interface Parit Data Bits Stop Bits Flow Control
TiE0 B @Rsz32 || Wone ) egpre || @i £ None 500 = cRsz2 || FMNome | e 7Eis || @ 1B & Mone
© Even € Hardware € Even £ Hardware
CRS42Z2 || ¢ o & BBts | |C2Bis || ¢ wowxorF CRs42 || ooy ®6Bs || C 2Bt || e yonmorr
Binary O NMEA Ou
Output Select Lsuds T Roll Positive Sense Output Select i Roll Positive Sense
[y =] li.% & Sensor 1 @ PortUp (" Starboard Up VEA = A Ui@’ & PortUp ¢ Starboard Up
50 Hz he  Sensor 2 Pitch Positive Sense 1Hz |2 Pitch Positive Sense
#BowlUp € StemUp @ BowlUp (" StemUp
Formula Select H Positive S Talker ID 3 E—
eave Fositive sense eave Cositive sense
881 = * Heave Up Heave Down . P& @ Heave Up ¢ Heave Down
Input Select Input Select
None 2 MNone hd
Close | Apply Close Apply

com1 | comz | com3 | coma §

None i

Baud Rate Parity—— [ Data Bits Stop Bits Flow Control
o & @itone | | o7pis || @Bt || @ None
€ Even € Hardware
© B @8Bts || €28t || ¢ yonmorr
NMEA O
Output Select e Roll Positive Sense
A - ~ UFﬂte Rate & Port Up ' Starboard Up
1W0Hz = Pitch Positive Sense
* Bow U, " Stern U
H $GPZDA Talker ID . e
[13GPVTG m Heave Positive Sense
CISPASHR * Heave Up " Heave Down
Input Select

Close Apply
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Events x

Heave Filter e Event 1 | E\rentZI Event 3 I Event 4| Event 5 I Event El

“Edge Trigge Guard Time (msec)

& Paositive
[0 =
Heave Bandwidth (sec) I‘IU.EIEIEI " Negative
Damping Ratio IU.?U?
PPS Out
~Polarity
& Positive Pulse Pulse Width (msec)

= Megative Pulse 63 =
Close | Apply 9 E

£ Pass through

Close | Apply |
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Lever Arms & Mounting Angles

Lewver Arms & Mounting Angles I Sensor Mounting | Tags. AutDStartl

~Ref. to IMU Target: IMU Frame w.rt. Ref. Frame— Target to Sensing Centre Resulting Lever Arm———
X(m) [0.000 X(deg) [1800 | X(m) [0008 X(m) [0.005
Y o000 Yided) 4o Ym) 9031 Y(m) 9034
Z(M o168 Z(deg) oo | 2™ [os0 Zm [hoss

 Ref. to Primary GPS Lever Arn Ref to Vessel LeverArm Ref. to Centre of Rotation Lever Arm——|
X(m) |1-015 X (m) 0.000 X (m) 0.000
Y (m) |0.750 Y (m) |0.000 Y (m) 0.000
Z(m)  |-2.160 Z(m) o000 Z(m) 0.000

Notes: 1. Ref = Reference
2. wrt. =With Respect To
3. Reference Frame and Vessel Frame are co-aligned

Compute IMU w.rt
Ref. Misalignment

™ Enable Bare IMU

Apoply View

In Mavigation Mode |, to change parameters go to Standby Mode |

Lever Arms & Mounting Angles X

Lewver Arms & Mounting Angles  Sensor Mounting |Tags, AutoStart

Ref. to Aux. 1 GNSS Lever Arm) [ Ref. to Aux. 2 GNSS Lever Arm——
X(m) [p.000 X (m) 0.000
Ym foooo Y (m) 0.000
Zm  foooo Z(m) 0.000

Ref. to Sensor 1 Lever Arm Sensor 1 Frame w.rt. Ref. Frame
x@) [oooo X (deg) 0.000
Ym foooo Y (deg) 0.000
Zm  foooo Z (deg) 0.000

~Ref to Sensor 2 Lever Arm——— Sensor 2 Frame wrt. Ref Frame
x@m [oooo X (deg) o000
Y(m) [oooo Y(deg)  [0.000
Zm oo Z (deg) 0.000

=] Ok | Cloze I Lpply View

I Mavigation Mode . to change parameters go to Standby Mode |

Lever Arms & Mounting Angles X

Lever Arms & Maounting Angles | Sensor Mounting  Tags, AutoStart

Time Tag 1 Time Tag 2
 POS Time £ POS Time
© GPS Time
 GPS Time
& UTC Time
& UTC Time ° User Time
~AutoStart
" Disabled
@ Enabled
=] Ok Apply Wiew

I M avigation Mode | to change parameters go to Standby Mode |
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User Paramekter Accuracy ﬂ

~RMZ Accuracy
Attitude (deg)  |0.050

Heading (deg) |II|.EI5EI
Pasition (m) |2.EIEIEI
Yelocity (m/s) |II|.5EIEI

Close | Apply |

x
Primary GNSS Receiver |Secondary GNS5 Recei\terl
—Frimary GNS5———— ~GMN53 1 Part
GMN3S Qutput Rate Baud Rate
1 Hz =l Jes0o |
Parity—— Data Bits Stop Bits
® MNome ||~ 7gits | | & 1B
mAuto Configuration " Even
& Enabled ~ Odd &+ B Bits " 2 Bits
" Disabled
Ok | Apply
x
Primary GNSS Receiver Secondary GMNSS Receiver |
—Secondary GN3S rGNSS 2 Port
GMNSS Output Rate Baud Rate
1 Hz ||| fee0o =l
Parity——— Data Bits Stop Bits
& Mone © 7Bits | | & 1B
—Auto Configuration  Evan
' Enabled  Odd + 8 Bits 2 Bits
" Disahled
Ok [ Close Apply
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DAPR Appendix IV

Sound Speed Sensor Reports
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Coefficient G: 8.250593E-7 Coefficient N:

Calibration Date (dd/mm/yyyy):
Certified By:

13/7/2017

AM@W&% ahhic

Robert Haydock
President, AML Oceanographic

AML Oceanographic certifies that the asset described above has been calibrated or recalibrated with equipment referenced to
traceable standards. Please note that )(chan_geTM sensor-heads may be installed on assets other than the one listed above; this
calibration certificate will still be valid when used on other such assets. If this instrument or sensor has been recalibrated,
please be sure to update your records. Please also ensure that you update the instrument’s coefficient values in any post-
processing software that you use, if necessary. Older generation instruments may require configuration files, which are

available for download at our Customer Centre at www.AMLoceanographic.com/support

AML Oceanographic

2071 Malaview Avenue, Sidney B.C. V8L5X8 CANADA
T:+1-250-656-0771 F: +1-250-655-3655 Emall: service@AMLoceanographic.com

OPR-K354-KR-17 OCEAN SURVEYS, INC.
o s
f Xchange yourold ideas
Certificate of Calibration
Customer: Electronic Sales of New England
Asset Serial Number: 201525
Asset Product Type:  sveXchange™ Calibrated Sensor
Calibration Type: Sound Velocity
Calibration Range: 1375 to 1625 m/s
Calibration RMS Error; 008
Calibration ID: 201525 599999 201525 130717 105604
Installed On:
Coefficient A: 5.0000008+0 Coefficient H: 1.946885E-7
Coefficient B: 5 900000£+0 Coefficientl:  0.000000E+0
Coefficient C: g g280736.7 CoefficientJ):  0.000000E+0
Coefficient D: 1,847096€-7 Coefficient K: 0.000000E+0
Coefficient E: .1 72171765 Coefficient L: 0.000000E+0
Coefficient F:  1.951610E-7 Coefficient M: 0.000000E+0

0.000C00E+0

Figure 1. Sensor Calibration Certificate — R/V Ocean Explorer - AML SV.Xchange Sensor SN
201525 installed on the AML Micro-X SN 10315 mounted on the Reson 7125.
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OPR-K354-KR-17

OCEAN SURVEYS, INC.

Installed On:

Asset Serial Number: 203108

Customer: Electronic Sales of New England

Asset Product Type:  sveXchange™ Callbrated Sensor
Calibration Type: Sound Velocity

Calibration Range: 1375 t0 1625 m/s

Calibration RMS Error; .005

Calibration ID: 203108 999992 203108 130717 105502

Certificate of Calibration

Coefficient A: ,000000E+0
Coefficient B: ( go0000E+0
Coefficient C: 1 gag799£-5
Coefficient D: 1, 945449£-7
Coefficient E: _1.704328E-5
Coefficient F: 1.950628E-7
Coefficient G; 1.332700E-6

Certified By:

Calibration Date (dd/mm/yyyy):

Coefficient H:
Coefficient I:
Coefficient J:
Coefficient K:
Coefficient L:
Coefficient M:
Coefficient N:

AM %&ﬁ@éﬁ&;&ﬁzc

Robert Haydock

President, AML Oceanographic
AML Oceanographic certifies that the asset described above has been calibrated or recalibrated with equipment referenced to
traceable standards. Please note that XchangeTM sensor-heads may be installed on assets other than the one listed ahove; this
calibration certificate will still be valid when used on other such assets. If this instrument or sensor has been recalibrated,
please be sure to update your records. Please also ensure that you update the instrument’s coefficient values in any post-
processing software that you use, if necessary. Older generation instruments may require configuration files, which are

available for download at our Customier Centre at www.AMLoceanographic.com/support

AML Oceanographic
2071 Malaview Avenue, Sidney B.C. V8L5X6 CANADA
T: +1-250-656-0771 F: +1-250-655-3655 Email: service@AMLoceanographic.com

1.944896E-7
0.000000E+0
0.000000E+0
0.000000E+Q
0.000000E+0
0.000000E+0

0.000000E+0

Figure 2. Sensor Calibration Certificate — R/V Ocean Explorer - AML SV.Xchange Sensor SN

203108 installed on the AML Micro SVPT 7786 used on the ODIM MVP.
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OPR-K354-KR-1

7 OCEAN SURVEYS, INC.

Customer:

Calibration ID:
Installed On:

Asset Serial Number:  gg7786

Asset Product Type: ZZZMicro SVTP, Fixed Sensars, for Brooke MVP -
Calibration Type: Pressure

Calibration Range: 200 dBar

Calibration RMS Error: 0109

Certificate of Calibration

Electronic Sales of New England

007786 001051 D00026 170717 092201

Coefficient A:
Coefficient B:
Coefficient C:
Coefficient D:
Coefficient E:
Coefficient F:
Coefficient G:

Certified By:

Calibration Date {dd/mm/yyyy): 17/7/2017

AML Qceanographic certifies that the asset described above has been calibrated or recalibrated with equipment referenced to
trageable standards. Please note that Xchange™ sensor-heads may be installed on assets other than the one listed above; this
calibration certificate will still be valid when used on other such assets. If this instrument or sensor has been recalibrated,
please be sure to update your records. Please alse ensure thatyou update the instrument’s coefficient values in any post-
processing software that you use, if necessary. Older generation instruments may require configuration files, which are

available for download at our Customer Centre at www.AMLoceanographic.com/support

-2.543544E+1 Coefficient H:  0,000000E+0
0.000000E+0 Coefficient | -3,183394E-10
0.00G000E+0 Coefficient J:  0.000000E+0
0.000000E+0 Coefficient K:  0,000000E+0
.51 EOTES Coefficient L:  0.000000E+0
0.000000E+0 Coefficient M: 7.231540E-16
0.000000E+0 Coefficient N: 0.000000E+0

AMQ&M&&;@@% ie

Robert Haydock
President, AML Oceanographic

AML Oceanographic
2071 Malaview Avenue, Sidney B.C. V8L 5X6 CANABA
T: +1-250-656-0771 F: +1-250-655-3655 Email: service@AMLoceanographic.com

Figure 3. Sensor Calibration Certificate — R/V Ocean Explorer - MVP Micro SVTP Pressure
Sensor on SN 7786 used on the ODIM MVP.
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OPR-K354-KR-17 OCEAN SURVEYS, INC.

Certificate of Calibration

Customer: Electronic Sales of New England
Asset Serial Number:  go7786
Asset Product Type:  zzzMicro SVTP, Fixed Sensors, for Brooke MVP -

Calibration Type: Temperature

Calibration Range: -2to+32 Dec C

Calibration RMS Error; 0016

Calibration ID: 007786 001051 125479 130717 222411

Installed On:

Coefficient A: _g,718361E40 Coefficient H:  0.000000E+0
Coefficient B: g ggs5a7e.4 Coefficient1:  0.000000£+0
Coefficient C: 3 go4250E-8 CoefficientJ:  0.000000E+0
Coefficient D: 2 35952713 Coefficient K:  0,000000E+0
Coefficient E: _3.487201E-18 Coefficient L:  0.000000E-+0
Coefficient F: 3.288514E-23 Coefficient M: 0.000000E+0

Coefficient G: -1.172707E-28 Coefficient N:  0.000000E+0

Calibration Date {dd/mm/yyyy): 13/7/2017

Certified By:
AM &a?ﬁ%@ﬁ&hk

Robert Haydock
President, AML Oceanographic
AML Oceanographic certifies that the asset described above has been calibrated or recalibrated with equipment referenced to
traceable standards. Please note that Xchangem sensor-heads may be installed on assets other than the one listed above; this
calibration certificate will still be valid when used on other such assets. [f this instrument or sensor has been recalibrated,
please be sure to update your records. Please also ensure thatyou update the instrument’s coefficient values in any post-
processing software that you use, if necessary. Older generation instruments may require configuration files, which are

available for download at our Customer Centre at www AMLoceanographic.com/support

AML Oceanographic
2071 Malaview Avenue, Sidney B.C. VBL5X6 CANADA
T: +1-250-656-0771 F: +1-250-655-3655 Email: service@AMLoceanographic.com

Figure 4. Sensor Calibration Certificate — R/V Ocean Explorer - MVP Micro SVTP Temperature
Sensor on SN 7786 used on the ODIM MVP.,
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OPR-K354-KR-17 OCEAN SURVEYS, INC.

 OCEANOGRAPHIC
J - Xchange your old ideas

Certificate of Calibration
Customer: Electronic Sales of New England

Asset Serial Number: 201527
Asset Product Type:  sveXchange™ Calibrated Sensor

Calibraticn Type: Sound Velacity

Calibration Range: 1375 to 1625 m/s

Calibration RMS Error: 004

Calibration ID: 201527 999999 201527 310717 104737

Installed On:

Coefficient A: 5.000000E+0 Coefficlent H:  1.946520€-7
Coefficient B: 5 gonoooE0 Coefficient I:  0,000000€+0
Coefficient C: 1 goge35E-6 Coefficient J:  0.000000E+0
Coefficient D: 1 945742F-7 Coefficient K:  0.000000E+0
Coefficient E: 47334425 Coefficient L:  0.000000E+0
Coefficient F: 1.951085E-7 Coefficient M: C.000000E+0
Coefficient G: 7.847014E-7 Coefficient N:  0.000000E+0

Calibration Date (dd/mm/yyyy): 31/7/2017

Certified By:
AM waaﬁ@é@%}ﬁc

Robert Haydock
President, AML Oceanographic
AML Oceanographic certifies that the asset described above has been calibrated or recalibrated with equipment referenced to
traceahle standards. Please note that )(r:hange"—M sensor-heads may be installed on assets other than the one listed above; this
calibration certificate will still be valid when used on other such assets. If this instrument or sensor has been recalibrated,
please be sure to update your records. Please also ensure that you update the instrument’s coefficient values in any post-
processing software that you use, if necessary. Older generation instruments may require configuration files, which are

available for download at our Customer Centre at www.AMLoceanographic.com/support

AML Oceanographic
2071 Malaview Avenue, Sidney B.C. V8L5X6 CANADA
T: +1-250-656-0771 F:+1-250-655-3655 Email: service@AMLoceanographic.com

Figure 5. Sensor Calibration Certificate — R/V Ocean Explorer - AML SV.Xchange Sensor SN

201527 installed on the AML Micro SVVPT 7777 used on the ODIM MVP.
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4 V” ' QGEANOGRAPHIG
Xchange your.old ideas

Certificate of Calibration

Customer: Electronic Sales of New England

Asset Serial Number:  op7777

Asset Product Type:  zzzMicro SVTP, Fixed Sensors, for Brooke MVP -
Calibration Type: Pressure

Calibration Range: 200 dBar

Calibration RMS Error: 0155

Calibration ID: 007777 142686 0AX984 020817 105940

Installed On:

Coefficient A: 7.330288E+3 Coefficient H:  4,160638E-16
Coefficient B: _4 g33919¢-1 Coefficient I: -1 901924E-6
Coefficient C: 1 psge04E.5 Coefficient J:  1.260468E-10
Coefficient D: .7,818396E-11 Coefficient K:  -2.784536E-15
Coefficient E: .4.808766E-2 . Coefficient L:  2.050525E-20
Coefficient F: 3.180522E-6 Coefficient M: 0.00000CE+0
Coefficient G: -6.331035E-11 Coefficient N:  0.000000E+0

Calibration Date (dd/mm/yyyy): 2/8/2017

Certified By:
AN ‘@aﬁg&&% shic

Robert Haydock
President, AML Oceanographic

available for download at our Customer Centre at www.AM{oceanographic.com/support

AML Oceanographic
2071 Malaview Avenue, Sidney B.C, VBL5X6 CANADA
T: +1-250-656-0771 F: +1-250-655-3655 Email: service@AMLoceanographic.com

AML Oceanographic certifies that the asset described above has been calibrated or recalibrated with equipment referenced to
traceable standards. Please note that )(changeTM sensor-heads may be installed on assets other than the one listed above; this
calibration certificate will still be valid when used on other such assets. If this instrument or sensor has been recalibrated,
please be sure to update your records. Please also ensure that you update the instrument’s coefficient values in any post-
processing software that you use, if necessary. Older generation instruments may require configuration files, which are

Figure 6. Sensor Calibration Certificate — R/V Ocean Explorer - MVP Micro SVTP Pressure

Sensor on SN 7777 used on the ODIM MVP.
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: 'V" ! OCEANOGRAPHIC
Y F Xchange your oid Ideas

Certificate of Calibration
Customer: Electronic Sales of New England

Asset Serial Number:  po7777
Asset Product Type:  zzzMicro SVTP, Fixed Sensors, for Brooke MVP -

Calibration Type: Temperature
Calibration Ra nge: _2to+32 DecC

Calibration RMS Errar: 0015

Calibration ID: 007777 999999 007777 260717 221851

Installed On:

Coefficient A _g a9215278+0 ) Coefficient H: p,000000E+0
Coefficient B: g ga02568-4 ) Coefficient I:  ,000000E+0
Coefficient C: g 393953Eg Coefficient J:  0.000000E+0
Coefficient D: 1 868434F-13 Coefficient K:  0.000000E+0
Coefficient E: 3 715849E-18 Coefficient L:  0.000000E+0
Coefficlent F: 1.697135E-23 Coefficient M: 0.000000E+0
Coefficient G: -4.024335E-29 Coefficient N: 0.000000E+0
Calibration Date (dd/mm/yyyy): 26/7/2017

Certified By:

AM @azﬁf : zg&é’%%c

Rabert Haydock

President, AML Oceanographic
AML Oceanographic certifies that the asset described above has been calibrated or recalibrated with equipment referenced to
traceable standards. Please note that Xv:harlgeTM sensor-heads may be Installed on assets other than the one listed above; this
calibration certificate will still be valid when used on other such assets. If this instrument or sensor has been recalibrated,
please be sure to update your records. Please also ensure that you update the instrument’s coefficient values in any post-
processing software that you use, if necessary. Older generation instruments may require configuration files, which are
available for download at our Customer Centre at www.AMLoceanographic.com/support

AML Oceanographic
2071 Malaview Avenue, Sidney B.C. V8L5X6 CANADA
T: +1-250-656-0771 F: +1-250-655-3655 Email: service@AMLoceanographic.com

Figure 7. Sensor Calibration Certificate — R/V Ocean Explorer - MVVP Micro SVTP Temperature
Sensor on SN 7777 used on the ODIM MVP.,
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OPR-K354-KR-17 OCEAN SURVEYS, INC.

Certificate of Calibration

Customer: Electrenic Sales of New England
Asset Serial Number: 201521
Asset Product Type:  sveXchange™ Calibrated Sensor

Calibration Type: Sound Velocity

Calibration Range: 1375 to 1625 m/s

Calibration RMS Error: .025

Calibration ID: 201521 999999 201521 130717 105546

Installed On: 007786

Coefficient A 0.000000E+0 Coefficient H:  1.944808E-7
Coefficient B: g noooooe+n CoefficientI:  0.000000E+0
Coefficient C: 1 gg2403e-6 CoefficientJ:  0.000000E+0
Coefficient D: 1 944551F.7 Coefficient K: 0.000000E+0
Coefficient Er _1,561926E-5 Coefficient L:  0.000000E+0
Coefficient F:  1.950674E-7 : Coefficient M: 0.000000E+0
Coefficient G: 1.821086E-6 Coefficient N:  0,000000E+0

Calibration Date (dd/mm/yyyy): 13/7/2017
Certified By:

Akl 'ézea@-g g&)ﬁh?g

Robert Haydock
President, AML Oceanographic
AML Oceanographic certifies that the asset described above has been calibrated or recalibrated with eguipment referenced to
traceable standards. Please note that Xchange™ sensor-heads may be installed on assets other than the one listed above; this
calibration certificate will still be valid when used on other such assets. If this instrument or sensor has been recalibrated,
please be sure to update your records. Please also ensure that you update the instrument's coefficient values in any post-
processing software that you use, if necessary. Older generation instruments may require configuration files, which are

available for download at our Customer Centre at www.AMLoceanographic.com/support

AML Oceanographic
2071 Malaview Avenueg, Sidney B.C. V8L5X6 CANADA
T: +1-250-656-0771 F:+1-250-655-3655 Emall: service @AMLoceanographic.com

Figure 8. Sensor Calibration Certificate — R/V Ocean Explorer and R/V Osprey - AML
SV.Xchange Sensor SN 201521 installed on the AMLBase-X profiler SN 25016 (shared between
both vessels for comparison casting).
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OCEAN SURVEYS, INC.

Asset Serial Number: 303077

Customer: Electronic Sales of New England

Certificate of Calibration

Asset Product Type:  paxchange™ Calibrated Sensor, 100 dBar

Calibration Type: Pressure

Calibration Range: 100 dBar

Calibration RMS Error: .0125

Calibration ID: 303077 999999 303077 170717 132416
Installed On: 025016 .

Coefficient A: _12410005+1
Coefficient B: 4 00000840
Coefficient C: g popoooe+o
Coefficient D: 0.000000E+0
Coefficient E: 1.920703E-3
Coefficient F:  0.000000E+0
Coefficient G: 0.000000E+0

Certified By:

Calibration Date {dd/mm/yyyy):

Coefficient H:
Coefficient I:
Coefficient J:
Coefficient K:
Coefficient L:
Coefficient M:
Coefficient N:

ﬁmma;@a%gﬁmzn

Robert Haydock

President, AML Oceanographic
AML Oceanographic certifies that the asset described above has been calibrated or recalibrated with eguipment referenced to
traceable standards. Please note that Xchange™ sensor-heads may be installed on assets other than the one listed above; this
calibration certificate will still be valid when used on other such assets. If this instrument or sensor has been recalibrated,
please be sure to update your records. Please also ensure that you update the instrument’s coefficient values in any post-
processing software that you use, if necessary. Older generation instruments may require configuration files, which are

available for download at aur Customer Centre at www.AMLoceanographic.com/support

AML Oceanographic
2071 Malaview Avenue, Sidney B.C. VBL5X6 CANADA
T: +1-250-656-0771 F:+1-250-655-3655 Email: service@AMLoceanographic.com

0.000000E+0
-4.128781E-10
0.000000E+0
0.000000E+0
0.000000E+0
3.511229E-15

0.000000E+0

Figure 9. Sensor Calibration Certificate - R/V Ocean Explorer and R/V Osprey - AML P.Xchange
Sensor SN 303077 installed on the AMLBase-X profiler SN 25016 (shared between both vessels

for comparison casting).
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OCEAN SURVEYS, INC.

Sea-Bird Scientific
RD 13431 NE 20" Street

SEA-BI

SENSOR SERIAL NUMBER: 6372
CALIBRATION DATE: 31-May-17

COEFFICIENTS:

g = -9.518198e-001
h = 1.341216e-001
i = -4.784230e-004
j = §5.297682e-005

BATH TEMP BATH SAL BATH COND INSTRUMENT INSTRUMENT RESIDUAL

(03] (PSU) (Sm) OUTPUT (Hz} COND (S/m) (Sfm)
22,0000 0.0000 0.00000 267295 0.00000 0.00000
1.0000 34,7952 2.97433 5431.50 2.97436 0.00003
4.5000 34,7757 3,28127 5639,32 3.28124  -0.00003
15.0000 34.7340 4.26258 6256.84 4.26258  -0.00001
18,5000 34,7252 4,60759 6459.60 4.60760 0.00002
24 .0000 34,7157 5.,16531 6774 .14 S ple5ad -0.00001
29,0000 34,7109 5.68700 7055.25 5.68700 0.00001
32.5000 34,7084 6.05930 7248.94 6.05929  -0.00000

£ = Instrument Output(Hz) * sqrt(1.0 + WBOTC * ) / 1000.0

t = temperature (°C);  p = pressure (decibars); 8= CTcor, &= CPcor;
Conductivity (S/m)= (g +h* F+i*F+j* ) /10 (1 +8* 1+ *p)
Residual (Siemens/meter) = instrument conductivity - bath conductivity

0.002--------f------- R e mmmmmmm g m e R | @ 28-Feb-14 1.0001973

= ] ; : ; | ; ' A 31-May-17 1.0000000
- : l | l l l |
| | | I | | I
- | | | I | | |
QI s e R R s b
- | | | | | | |
| | | | | | |
g - I I [ I I | 1
E = : 1 | l l l l
25 - I I | I I I I
R e e e S
g = l\_“lw_g_‘__‘ | I I I I
i - : 1 1 1 1 |
s _ I | I | | 1
| | | | I
- | | | | | |
L fermsmomme o o R
= | | | | | | |
| | I I | | I
- | | I I | | I
e | | | I | | |
| | I I | $ I
B | | | | | | |
| | | | | | |
'0-002*'7’\’r’\’i’TTTTTTTTTTFTTTTTTTTTFTTWTTFTF’i
0 1 2 3 4 5 6 7

Conductivity (S/m)
1

SBE 37 V2 CONDUCTIVITY CALIBRATION DATA
PSS 1978: C(35,15,0) = 4.2914 Siemens/meter

CPcor = -9.5700e-008
CTcor 3.2500e-006
WBOTC = -0.0000e+000

Date, Slope Correction

Figure 10. Sensor Calibration Certificate — R/V Osprey — Conductivity Calibration for SBE-37
Sound Speed Sensor mounted on the Reson 8125.
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OPR-K354-KR-17 OCEAN SURVEYS, INC.

B Sea-Bird Sclentiiic +1 425-8423-0608
% SEA-BIRD 13431 NE 20" Sireet soabird@seabird.com
oo SCIENTITIC Delilevae, WA 98008 www.seabird.com
. vsA
SENSOR SERIAL NUMBER: 6372 SBE 37 V2 TEMPERATURE CALIBRATION DATA
CALIBRATION DATE: 31-May-17 ITS-90 TEMPERATURE SCALE

COEFFICIENTS:

a0 = 6.092434e-005
al = 2.686011e-004
a2z = -2.020565e-006
a3 = 1.3963552-007
BATH TEMP INSTRUMENT INST TEMP RESIDUAL
(03] OUTPUT (counts) €C) o)
1.0000 693367.9 1.0000 0.0000
4.5000 591528 .8 4.4999 -0.0001
15,0000 374610.5 15,0000 0.0000
18.5000 323720.6 18.5001 0.0001
24,0000 258901.5 24,0000 -0.0000
29.0000 212607 .6 28.9999 -0.0001
32,5000 185839.8 32,5001 0.0001

n = Instrument OQutput (counts)
Temperature ITS-90 (°C) = 1/{a0 + al|/n(n)] + ul[ln'z(n)j +a3 [[n}(n)J} -273.15
Residual (°C) = instrument temperature - bath temperature

Date, Offset (mdeg C)

] ey @ 28-Feb-14 0.00
A 31-May-17 0.0

L St Attty Rttt il
sy - | | | I | | |
O | | | | | | |
= | | I
8 : | | . | | |
%, = : 1 1 I 1 1 1
8 0y e
T : : 1 I 1 1 :
3 | : : : : | |
T e T
L B SRR ST e S SR I
e | | | I | | |
| 1 | | | | |
= | | | I | | |
_ | I | | | | |
i I R N N .
0.02- 4 FW’FTT’FW’FTW’FT’FW’FTT’F] (. FW’FTT’FW’FTT’FW’FTW’T]
-5 0 5 10 15 20 25 30 35
Temperature (Degrees C)

1

Figure 11. Sensor Calibration Certificate — R/V Osprey — Temperature Calibration for SBE-37
Sound Speed Sensor mounted on the Reson 8125.

-11- DAPR - Appendix IV



OPR-K354-KR-17

OCEAN SURVEYS, INC.

Customer:

Asset Serial Number:
Asset Product Type:
Calibration Type:
Calibration Range:

Calibration RMS Error:

Certificate of Calibration

Electronic Sales of New England

203524

Sound Velocity
1375 to 1625 m/s
.014

SVsXchange™ Calibrated Sensor

Certified By:

Calibration Date {[dd/mm/yyyy):

anitla .&a%&gﬂ)&ia

Robert Haydock

President, AML Oceanographic
AML Oceanographic certifies that the asset described ahove has been calibrated or recalibrated with equipment referenced to
traceable standards. Please note that XchamgeTM sensor-heads may be installed on assets other than the one listed above; this
calibration certificate will still be valid when used on other such assets. If this instrument or sensor has been recalibrated,
please be sure to update your records. Please also ensure that you update the instrument’s coefficient values in any post-
processing software that you use, if necessary. Older generation instruments may require configuration files, which are

available for download at our Customer Centre at www.AMLoceanographic.com/support

AML Oceanographic
2071 Malaview Avenue, Sidney B.C. V8L5X6 CANADA
T: +1-250-656-0771 F: +1-250-655-3655 Email: service@AMLoceanographic.com

Calibration ID: 203524 999599 203524 130717 105522
Installed Cn: 010315

Coefficient A: .000000E+0 Coefficient H: _1.9477376-7
Coefficient B: 5.000000E+0 Coefficient!:  0.000000E+0
Coefficient C: 4 g23g40F.7 Cueﬁicient J: 0.000000E+0
Coefficient D: 19482797 Coefficient K:  0.000000E+0
Coefficient B _1.821299E-5 Coefficient L:  0.000000E+0
Coefficient F: 1.954723E-7 Coefficient M: 0.000000E+0
Coefficient G: 6.351400E-7 Coefficient N: 0.000000E+0

Figure 12. Sensor Calibration Certificate — R/V Osprey - AML SV.Xchange Sensor SN 203524
installed on the AMLBase-X profiler SN 25028.
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OPR-K354-KR-17 OCEAN SURVEYS, INC.

Customer:

Calibration 1D:
Installed On:

Asset Serial Number: 304351

Asset Product Type:  peXchange™ Calibrated Sensor, 100 dBar
Calibration Type: Prassure

Calibration Range: 100 dBar

Calibration RMS Error: 0159

Certificate of Calibration

Electronic Sales of New England

304351 999999 304351 170717 132402

Coefficient A:
Coefficient B:
Coefficient C:
Coefficient D:
Coefficient E:
Coefficient F:
Coefficient G:

Certified By:

Calibration Date {dd/mm/yyyy): 17/7/2017

AML Oceanographic certifies that the asset described above has been calibrated or recalibrated with eguipment referenced to
traceable standards. Please note that Xchange™ sensor-heads may be installed on assets other than the one listed above; this
calibration certificate will still be valid when used on other such assets. If this instrument or sensor has been recalibrated,
please be sure to update your records. Please alsc ensure that you update the instrument’s coefficient values in any post-
processing software that you use, if necessary. Older generation instruments may require configuration files, which are

available for download at our Customer Centre at www.AMLoceanographic.com/support

-1250735E41 , Coefficient H:  0.000000E+0
0.000000E+0 Coefficient I:  .9.318120E-11
0.000000E+0 Coefficient J:  0.000000E+0
0.000000E+0 Coefficient K:  0.000000E+0
1.911900E-3 Coefficient L: 0.000000E+0
0.000000E+0 Coefficient M: 1.331188E-15
0.000000E+0 Coefficient N: 0.000000E+0

AMM&&@%@&}\%&

Robert Haydock
President, AML Oceanographic

AML Qceanographic
2071 Malaview Avenue, Sidney B.C. V8L 5X6 CANADA
T:+1-250-656-0771 F: +1-250-655-3655 Email: service@AMLoceanographic.com

Figure 13. Sensor Calibration Certificate — R/V Osprey - AML P.Xchange Sensor SN 304351
installed on the AMLBase-X profiler SN 25028.
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